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Note for Users to Upgrade GV-ASManager

If for any reason the system is not responding correctly after the software upgrade, you can
restore your current database. Follow the steps below to back up the current database before

upgrading to the latest version.

1. Run ASDBManager.exe from the GV-ASManager program folder at C:\Access
Control\ASManager (by default, the folder is created in drive C).

2. Select ASManager Database and Path Setting > Backup Database to back up your
current database.

3. Download the latest version from GeoVision website and upgrade GV-ASManager.

Note: After upgrading GV-ASManager, it is recommended to also upgrade the GV-AS /
GV-EV Controller firmware. To upgrade the controller firmware, see the Firmware Upgrade

Instructions.

Vi


https://www.geovision.com.tw/download/product/GV-ASManager%20(Access%20Control)
https://s3.amazonaws.com/geovision_downloads/TechNotice/AccessControl/Firmware_Upgrade_Instructions.pdf
https://s3.amazonaws.com/geovision_downloads/TechNotice/AccessControl/Firmware_Upgrade_Instructions.pdf
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Firmware and Software Compatibility

The software versions compatible with GV-ASManager are listed below.
® GV-DVR/NVR:V8.5.9.0 or later

® GV-VMS: V15.10 or later

® GV-Recording Server: V1.4.2 or later

® GV-Control Center: V4.0.0 or later

® GV-Al Guard: V2.0 or later

Vii



The GV-AS / GV-EV Controller firmware versions compatible with GV-ASManager are listed

below.

viii
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Naming and Definition

GeoVision Analog and Digital Video Recording Software. GV-DVR /

GV-DVR/ NVR NVR also refers to Multicam System, GV-NVR System, GV-Hybrid
DVR System and GV-DVR System at the same time.

GV-VMS GeoVision Video Management System for IP cameras.
The PC LPR refers to GV-NVR LPR and GV-VMS LPR. A GV-NVR
or GV-VMS can be turned into a GV-NVR LPR and GV-VMS LPR

PC LPR simply by installing the LPR Plugin and an LPR Dongle. The PC LPR

is capable of comparing captured license plates with the database
from GV-ASManager.

Standalone LPR

The standalone LPR refers to GV-DSP LPR, GV-LPR1200,
GV-LPR2800-DL and GV-LPR2811-DL. These devices have built-in
LPR processor, capable of comparing captured license plates with
the database from GV-ASManager.

Xi




n Introduction

Chapter 1 Introduction

The integration of GV-ASManager, GV-AS Controller (door controller) and GV-EV Controller
(elevator controller) offers full control of entrances of your premise. Up to 1,000 units of
controllers can be monitored and controlled by one GV-ASManager.

The following diagram is an example of how GV-ASManager and controllers are set up.

RS-485/ TCP/IP

L ./-V\{ie-g?n-d. _. Door 1 | Door 2 || Door 3 L Door 4
Reader Reader Reader Reader

m ~ Rs485/TCPIP
| 4 / Wiegand Door 1 Door 2 Door 3 Door 4

Mﬂ “ - T Reader ["| Reader [ | Reader ["| Reader
i o TCP/IP
e

GV-ASManager

Up to 1000 Controllers

P E .

RS-485/ TCP/IP
__ /Wiegand _ | Door 1 | | Door2 | | Door 3 | | Door 4
Reader Reader Reader Reader

AS410 Controller

Figure 1-1
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Main Features

Access Control

Up to 1,000 GV-AS / GV-EV Controllers supported

Four access modes: Card only, Card and PIN Code, Card or Common mode, Release
mode

Alarm conditions: door held open, door forced entry, tamper, access denied, duress, fire
alarms

SMS or E-Mail notification with user-defined content, video snapshot and user photo
Up to 100,000 cards supported for GV-AS Controllers

Up to 1,000 system users and 10,000 access groups

Up to 256 time zones, weekly schedules and holiday planning for 14 months
Multiple cards per user

Enroll cards in batch mode

Anti-Duress operation

Anti-Passback capabilities

Door interlock

Man trap in double-door configuration

Import/export of card and user data in Access or Excel file format
User-defined screen layout and dual monitor display support

Support Microsoft Access or SQL database

Patrol Tour requiring security personnel to check in at the specified locations

Integration of face recognition into security management with support for GV-Face
Recognition Cameras / GV-Al FR (software) / GV-FR Panel (reader)

User interface supported in Czech, English, French, Hebrew, Italian, Japanese,
Portuguese, Russian, Serbian, Spanish, Traditional Chinese, Turkish, and Ukrainian

Video Integration

Video integration with GeoVision software, IP devices and third-party IP cameras for live
viewing

Support for third-party IP devices using ONVIF, PSIA and RTSP protocols

User-defined matrix of 16-channel multi-views

Instant event playback



GV-ASRemote
e  Monitor unlimited GV-ASManager over Internet

¢ Remote door monitoring, video playback, door operation

GV-TAWeb
e Flexible workforce schedule arrangement
e Payroll calculation

e Attendance and payroll report search

GV-ASWeb

e Remotely watch live view from connected devices

Remotely control doors and LPR lanes

o Log export in Excel, Text, HTML, Zip and PDF file formats

GV-VMWeb

e Web interface for creating visitor database and granting access

e Visitor record search

e Visitor self-registration

GV-LPR

View access data on Google Maps in the order of access time

n Introduction

Remotely add or delete cards, users, controllers, access groups, cameras
Remotely set up operator accounts, patrol tours, parking lots, and notification settings

Web interface for historical log search with corresponding video and snapshot

e Upto 255 GV-DSP LPR, Edge GV-IP LPR Camera, and PC-based LPR
e Up to 8 recognition channels per PC LPR (GV-DVR / NVR / VMS / Al Guard LPR)

e Up to 100,000 vehicles supported
e Up to 100 Web browser connections supported

e Multiple vehicles assigned to a single user

e Import / export of vehicle data in Access or Excel file format

e Vehicle hotlist to identify stolen vehicles or vehicles of interest

¢ Parking lot management to regulate vehicle access, parking space availability, parking

duration allowed, anti-passback, and shared parking
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Various notifications upon LPR events: e-mail, alarm, trigger recording, push notification,
popup message

GV-ASWeb to remotely access LPR settings and logs

GV-Access mobile app to remotely monitor the alert status of each lane, open parking
gates, and access live view

GV-Access Mobile App

Support up to 5 GV-ASManager systems

Provide the connection and alert status of each controller, door, LPR device and lane
Access live views of cameras mapped to a door or lane

Lock or unlock a door

Open an LPR gate

Clear an alert event

Push notifications upon any access control, LPR, I/O box, system and user activity
events from GV-ASManager

Push notifications and live view call when the touchpad is activated in GV-CR1320
(reader) / GV-CS1320 (controller)

GV-Patrol Mobile App

Access patrol tours created from GV-ASManager
Check in at patrol points

View patrol status and historical tours



1.2 Concepts

n Introduction

Understanding the following concepts may help you read through the manual.

Weekly Schedule

A weekly schedule is certain days of the week when a user is granted
access to a secure site.

For details, see 4.4 Adding Weekly Schedules.

Access Group

An access group is a group of users with identical location restrictions
during the same time restraints.

For details, see 4.5 Adding Access Groups.

Alarm Condition

An alarm condition is a condition monitored through sensors, and
alarms will be activated when the condition is detected by sensors.
For example, GV-AS210 controller can monitor up to 8 sensors, such
as door status sensor, smoke detector and tamper detector.
GV-AS210 controller also provides output relays for activating and
deactivating electric lock, siren and emergency door release when the
alarm condition occurs.

GV-AS100/1010/ 110/ 1110/ 120 have built-in sensors to detect
whether the controller is being physically tampered with (i.e. opening
of the controller or sustaining strong impact). For GV-AS210/ 2110/
2120/410/4110/810/ 8110/ 1620, the tampering alarm sensor
needs to be installed separately and triggering conditions depend on
the type of sensor installed.

For settings of alarm conditions, see 4.2.2 Configuring Doors and
Elevator Floors. For configuring inputs and outputs see GV-AS /
GV-EV Controller User’'s Manual.

Anti-Duress

If a person is forced to open the door under threat, he or she can enter
a PIN plus 1 to activate an alarm and inform the ASManager to
dispatch the police. For example, the PIN is 5555 and you enter 5556.
The door will open normally (access granted) and the alarm will be
activated. The function is enabled by default.

Anti-Passback

The feature is designed to prevent card sharing and to enforce use of
entrance and exit readers. If a card is used at an entrance reader, it
must be used at an exit reader before it will be valid at the entrance
reader again. For settings, see 4.2.2 Configuring Doors and Elevator
Floors.



https://dlcdn.geovision.com.tw/Manual/Access-Control/Controller/EN/GV-ASEV_Controller_User_Manual.pdf
https://dlcdn.geovision.com.tw/Manual/Access-Control/Controller/EN/GV-ASEV_Controller_User_Manual.pdf
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Interlock

The feature is also called “mantrap” or interlocking”. The feature
interlocks a door with one or multiple doors connected to the same
controller. For example, if door A is set to interlock with Door B and C,
neither of Door B or C will unlock when Door A is open/unlocked.
When either of Door B or C is open/unlocked, Door A will not unlock.

For settings, see 4.2.1 Configuring a Controller.

Two-person A/B
rule

The door unlocks only when two assigned cards are presented in
order.

For settings, see 4.3.1 Adding a Single Card.

IP device

The video device connects to GV-ASManager through network.
GV-ASManager displays live video from not only GeoVision IP
devices (GV-DVR / NVR / VMS, GV-AIl Guard, GV-Recording Server,
GV-Video Server, GV-Compact DVR and GV-IP Camera) but also
third-party IP cameras through ONVIF, PSIA and RTSP protocols.

For details, see Chapter 5 Video Integration.

Device Group

The feature allows the system administrator to restrict a user account
to only be able to read, write or execute the controllers, cards, users,
access groups, time zones and weekly schedules assigned under a
device group. For example, the administrator can create a device
group for the sales department and assign related cards and
controllers under the device group. Employees in the sales
department will only have access to the cards and controllers of their
own department.

For details, see 8.7 Adding System Users.

Door Group

When a large number of controllers are connected to GV-ASManager,
the doors of different controllers can be organized into door groups.
The door group allows you to quickly upload fingerprints and user data
to the doors installed with fingerprint or face recognition readers.

For details, see Uploading Fingerprints to Controllers Using Door
Groups section in Chapter 3 of GV-GF Fingerprint Reader User’s
Manual.



https://dlcdn.geovision.com.tw/Manual/Access-Control/Fingerprint-Reader/GeoFinger_UserManual.pdf
https://dlcdn.geovision.com.tw/Manual/Access-Control/Fingerprint-Reader/GeoFinger_UserManual.pdf
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1.3 Optional Devices

Optional devices can expand the capabilities and versatilities of your GV-ASManager.
Consult your sales representative for more information.

GV-FWC integrates GeoVision face-recognition-based cameras,
software and readers into an access control system by sending access
card data, paired to Face IDs, to controllers either through TCP/IP or
Wiegand.

GV-FWC

GV-I0 Box series provides 4 / 8 / 16 inputs and relay outputs, and
GV-IO Box Series supports both DC and AC output voltages, with optional support for
Ethernet module and 4E additionally supporting PoE connection.

GV-PCR1251 / 1352 is a USB card reader, supporting 125 kHz / 13.56

e MHz, designed to assist with GV-AS ID Card / Key Fob enroliment to
Enrollment Reader GV-ASManager.



http://www.geovision.com.tw/product/GV-FWC
http://www.geovision.com.tw/products.php?c1=72
http://www.geovision.com.tw/product/GV-PCR1251%20Enrollment%20Reader
http://www.geovision.com.tw/product/GV-PCR1251%20Enrollment%20Reader
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Chapter 2 Installation

2.1 System Requirements

For GV-ASManager V4.2.1 or later, the following is the minimum system requirements.

Number of
ol 0-50 51-100 101-1000
0S 64-bit Windows 10 / Windows 11 / Server 2016 / Server 2019 / Server 2022
CPU Intel Core i3, 3.4 GHz | Intel Core i5, 3.4 GHz | Intel Core i7, 3.0 GHz
(2 Cores, 2 Threads) | (2 Cores, 2 Threads) | (4 Cores, 8 Threads)
Memory 8 GB RAM 16 GB RAM
Hard Disk 500 GB 1TB
Database MDB or Microsoft SQL database Microsoft SQL database
Program .NET Framework 4.5
Microsoft SQL Server 2005 Express (optional)
Browser Internet Explorer 9.0 or later, Edge, Chrome, Firefox

Note: The program .NET Framework 4.5 is required to run GV-ASManager.

2.2 Licensing
Free License 4 controllers
Maximum License 1000 controllers
Increment for Each License 1 controller
Optional Combination GV-AS Controllers + GV-Patrol
GV-USB Dongle External or Internal
Type
Software License GV-ASManager V5.3.0 or later only
Note:

1. The Maximum License is a paid service.

2. Starting from GV-ASManager 5.3.0, Software Licenses can be purchased and registered in
place of USB dongles, see Software Licensing for GV-ASManager.

3. Software licensing is not compatible with GV-USB dongle, and ONLY supports the following
controllers.
*  GV-AS210 series / 410 series / 810 series firmware V2.30 or later
e GV-AS1520 firmware version V2.03 or later
¢ GV-AS1620 firmware version V1.01 or later
e GV-CS1320 firmware V3.01 or later
e GV-EV48 firmware V2.30 or later



http://www.geovision.com.tw/product/GV-Patrol%20for%20Android
https://s3.amazonaws.com/geovision_downloads/Manual/Access-Control/ASManager/EN/Licensing_GV-ASManager.pdf
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2.3 Installing GV-ASManager

Starting from version 4.2.1, the GV-ASManager software supplied with GV-AS / GV-EV
Controllers can connect with up to 4 controllers for free. If you need to manage more than 4

controllers, a USB dongle or Software License is required. GV-ASManager supports
connections with up to 1,000 GV-AS / GV-EV Controllers.

Note: Starting from GV-ASManager 4.2.1, no USB dongle is needed to connect to IP

cameras.

You can install the driver and GV-ASManager from the GeoVision website.

4.

5.

Go to the Download page of GV-ASManager.

If the USB dongle of licensing is used:

5.1 Insert the USB Dongle to your computer.

5.2 Toinstall USB driver, select Driver & F/W from the dropdown list and click the
Download icon < of GV-Series Card Driver / USB Devices Driver.

To install GV-ASManager, select Primary Applications from the dropdown list and click

the Download icon < of GV-ASManager.

To download and install Microsoft DirectX End-User Runtimes (November 2008), visit

here.

To download and install .Net Framework 4.5, visit here.


http://www.geovision.com.tw/download/product/GV-ASManager%20(Access%20Control)
http://www.microsoft.com/en-us/download/details.aspx?id=15805
https://www.microsoft.com/en-us/download/details.aspx?id=30653
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24 Login

Before using GV-ASManager, you need to set the login ID and password, and create a

database.

1. In the Start menu, select Access Control and click ASManager. When starting the
system for the first time, the system will prompt you for a Supervisor ID and Password.

The system executes at first time

Flease enter supervizor |0 and password.

ID: Ellldmin.
Password: T}

Password Confirmation: F—

Email: admin@geovision com tw|

| |

Figure 2-1

2. Type an Email address so that your password can be sent to the email address when
forgotten. Remember to set up the email server after you log in. See 8.2.2 Setting up

E-Mail Server for details.

3. Type a desired ID name and password for the Supervisor account. This dialog box

appears.

Forgot Password?

[7] Auto Login

Figure 2-2
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4. Re-type the ID and Password. If you want to skip the login process in the future, select
Auto Login.

5. Click OK. The message “Can’t open database. Would you like to set up database?”
appears.

6. Select Yes to create a database. The ID and password you have configured in Step 1 are
required to access the feature. This dialog box appears.

[y Database Tools x

Flease Select Database Tools :

Which tool do you use for database? @I
- — ASManager Database and Path Setting :
w Setup, upgrade, deletion, backup, recovery and file path.

Settings from Source to ASManager Database :

Set the connection of Source Database, the mapping relations of the tables
betweem Source and ASManager database, the auto-update request, and the
manual update request.

Redogin Exit

Figure 2-3
7. Select ASManager Database Setting and Path Setting. The ASManager Database
Setting dialog box appears.
8. You can create either a Microsoft Access database or a Microsoft SQL database.
« To create a Microsoft SQL database, see Chapter 17 Database Settings.

« To create a Microsoft Access database for first-time users of GV-ASManager, Select
Setup MDB / MSSQL Database for ASManager. The Setup Database Connection
dialog box appears. Select Microsoft Office Access Database, and click OK. The
program starts creating a database. When it is complete, the message “Setup
database connection successfully” will appear.

9. Restart ASManager. You can see the main screen of GV-ASManager.

Note: By default, the Access database is created at C:\Access ControNASManager\ASRes.

11
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Chapter 3 The Main Screen of GV-ASManager

After you run GV-ASManager, the following main screen appears. Get yourself familiar with

the main screen as it will help you when you read further into the following sections.

Note: After closing the main screen, GV-ASManager will continue to run in Windows Task

Manager.

3.1

& Asmanager

(1
e_

Monizering

tnnt.-u:lerr
1816 i
Controller

- [ DESKTOP-BVCVMES
- & Gy-AS210

Bl 1 Door 1
e—— B 2 Doar2
B} 3:Door3
B 4 Door4
<
LPRs
168216 o
LPR
- G DESKTOP-PYCUME3
- & PRI
e__ 2y TiLaned
M 2 Lenez
Cameras

v [ DESKTOR-PVCVMZ3

v @ camera

- [ e
M 1: Camera 1
o 2% Comera 2

v 1B camera?

- @ s
7 1: Camnera |
o 2 Comera 2 (1)

Ready

Status

Card Mode
Cand Made
Card Maode
Card Mode

Status

Main Screen

View Setup Personnel
A A REEE ODM Q@
X

2 X

= m] x
Languzge Teols Window Help
DadglegE @ @
E=! LFR Monitor (5] Access Monltor |& Alarm Manitor |E] Event Monitor 1 b ¥ | LiveVideo o XI
.
] Access Monitor l [ 2] | & e Monitor l feEiEE] "' aF P B oa B .k-J
YIRS TI&& |
Message Doc Message [l
¥ fccess Denied: Invalid Card Dec | | 4 Plate Recognized: Registered Vehicle |
WP Plste Recognized: Registered Vehicle |
i o | | €¥Piete Recognized: Uniegistered Veh,. |
ﬂizcceiz Granted Dee Q Plste Recognized: Unregistered Veh... |
&% Access Denied: Invalid Card Doc | | 6¥Plote Recognized: Unregistered Veh... |
£3 fccess Denied: I Card Doc | | #Piate Recognized: Registered Viehiele || |
& ccess Denied: Invalid Card Dec | | 4 Plate Recognized: Registered Vehicle | s
€3 Access Denied: Invalid Card Do | | §#Plste Recogrized: Registered Vehicle | Lo 4
¥ fccess Denied: inv Dee | | @PEte Recognized: Registered Vehicle |
ei.cc:.. Cenied Dce | | 4 Plete Recognized: Registered Vehicle |
E¥ access Denied: Im Doc | | 83 Plate Recognized: Unregistered Veh.. |
Q Plate Recogrized: Unregistered Veh.. |
P iate Recognized: Uniegistered Veh,,, |
Qpﬁte Recognized: Unregistered Veh... |
W8 Dinte Recranized: Recistered Vekicle 1Y
< ¥ < ¥
|_T Tiles | Thumbnails Ts! Tiles | Thumbnails
[E] et Moo o B[] | A Ak Moniter FET=E | | Morvien
Y/ @S Y84 I
Message F Meszage Do
GReset |
&Donr_-'Gute Unlock |
WhRecet |
W Reet |
W Feset |
0-[}0 or/Gats Lock |
¥ Door/Gate Unlock | | .
0 Do/ Gats Unlock I | 2| 3a|2a | W
¥ Door/Gate Unlock | | Info
&BUUr-’Gﬂte Unlock |
0Doar.-’GaDe Lok [ ~
O Door/Gate Lock I Access Granted
¥ Door/Gats Lock [
¥ Door/Gata Lock | Door: Door 1
fl-r:n.—".fnm Unlnck " ¥ . . Direchi n
e = Local Time: 11/25/2015 1:39:26 ¥
I Lists | Tiles = Thumbnails Lists | Tiles | Thumbnails e b e ane E7Tan >
ﬂ Operator: 1 Q TG B 11/25/2015 2:20:31 FM
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H The Main Screen of ASManager

No. | Name Function
The Menu Bar includes the options of File (log in / out
GV-ASManager), Monitoring (display monitoring windows), View
(display the function windows), Setup (set up connected devices
1 Menu Bar and schedules), Personnel (set up the users’ accounts),
Language (select language of user interface), Tools (set up
notification and log) and Window (arrange the display of different
windows).
The Toolbar includes the options of Login, Logout, Devices,
5 Toolbar Cameras, Areas, Door Groups, Time Zones, Weekly Schedules,
Holidays, Access Groups, Feature Access, Patrol Tours, Parking
Lots, Cards, Vehicles, Users, Hotlist, and About.
Controller / LPR Displays a list of connected controllers / LP.R devices and their
3 View Window current status. You can change the size of icons to 16 x 16, 24 x
24 or 32 x 32 from the dropdown list.
Camera
4 Displays a list of connected cameras.
View Window
5 | Access Monitor Displays access activities of doors.
6 LPR Monitor Displays LPR activities and status.
7 | Event Monitor Displays monitored events of doors.
8 | Alarm Monitor Displays alarm events of doors.
. : Displays the live view of one connected camera. For details, see
9 Live View ) ) .
5.2 Accessing a Live View.
10 | Playback Pla)./s back recorded events frorr.1 alcompatlble Ge9V|3|on IP
device. For details, see 5.5 Retrieving Recorded Video.
11 | Multiview Displays live VIeV\'IS .of mul'tlple IP devices connected. For details,
see 5.4 The MultiView Window.
12 Information Displays the information of doors, card readers and monitored
Window events.
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3.1.1 Toolbar

¢

0 900
¥ Bl

PP 9 @
E=l e

Jdd@ABESREB B @ &l | &Rl
Figure 3-2

No. | Name Function

1 Login Logs in GV-ASManager.

2 Logout Logs out GV-ASManager.

3 Monitoring Windows Open a desired Monitoring window. See 3.3 Monitoring

Windows.

Defines controllers, doors, LPR devices, 1/0 boxes and

4 Devices cameras. See 4.2 Adding Controllers.
Configures Global Anti-Passback. See 6.3 Global

6 Areas .
Anti-Passback.
Uploads the enrolled fingerprints and user data to the
controllers and face recognition readers respectively. See

12 Feature Access Chapter 3 Fingerprint Only Mode in GV-GF Fingerprint Reader
User’s Manual or Uploading to the Face Recognition Reader in
Chapter 5 of GV-FR Face Recognition Reader User’'s Manual.
Creates patrol tours to require security staff to check in at the

1 Patrol T

3 atrol Tours specified locations. See Chapter 7 Patrol Tour.

Creates and edits a database of card information. See 4.3

15 Cards .
Adding Cards.

16 Vehicles Creates and edits a database of vehicle information. See
Chapter 13 License Plate Recognition.
Creates and edits a database of user information. See 4.6

17 Users )
Adding Users.

18 Hotlist Sets up vehicle hotlist to identify stolen vehicles or other
vehicles of interest. See 13.7 Setting up Vehicle Hotlist.

19 About Displays the version of GV-ASManager.

14



https://dlcdn.geovision.com.tw/Manual/Access-Control/Fingerprint-Reader/GeoFinger_UserManual.pdf
https://dlcdn.geovision.com.tw/Manual/Access-Control/Fingerprint-Reader/GeoFinger_UserManual.pdf
https://s3.amazonaws.com/geovision_downloads/Manual/Access-Control/FR2020/GV-FR2020_User_Manual.pdf

3.2 View Windows

H The Main Screen of ASManager

To see the status of a list of connected controllers, LPRs, cameras, and I/O Boxes, click View
on the menu bar and select Controllers, LPRs, Cameras or /0 Boxes.

Controllers o ¥
1616 -
Contraller Status Alarm Forced Open  Duress  Tamper Fire flarm
» [ TEST198-PC
b [ Controlier1 7
» [ Contoller 2
B 1:Front Doer Card Mode
B 2:Back Deor Card or Common Mode
B 3:Emergency Door  Releese Mode
[B 4: Office Door Card and FIM Code Mode

Figure 3-3

3.2.1 Controls on the Window

You can control the connected controller or door by right-clicking it in the Controller List
window. The following control options are available when right-clicking the GV-ASManager’'s

PC, Door and/or Controller:

[Contrallers

1616 e

SAAADESR PR "HE|§a

Controller Status A -

o X | LiveVided

B @ SB:II:I;_DEDI__I = Unlock Door
2 Door 2 Lock Down
3: Door3 Force Unlock
4 Doord Force Lock
< i Release Door Operation
LPRs Clear All Events
16c16 e
Reset Anti-passback L4
LR . Reconnect
¥ I.J?fault Sync Contreller
» L LPRI
~ &3 GV-LPR2812-DL-Alvin Settings...
Figure 3-4
Name Function Available
Unlock Door, Control the selected door or all doors associated | PC
Lock Down, with the selected controller. Controller
Force Unlock,
Force Unlock with Timer The Force Unlock and Force Lock keep the Door

Force Lock,
Release Door Operation

door stay open or locked until you select Release
Door Operation.

The Force Unlock with Timer allows you to set a
time in minutes, after which the door will be
locked.

15
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The Unlock Door unlocks the door temporarily
for the time interval specified. See “Lock Reset
Time” at Step 2 in 4.2.2 Step 2: Configuring the
Doors.

The Lock Down is only supported by GV-AS1010
/1110/210/2110/2120/410/ 4110/ 810/
8110/ 1620. It locks down the selected door or all
doors associated with the selected controller.
This function overrides the Authentication
Schedule and the door(s) can only be opened by
presenting the assigned access card.

Clear All Events Clear all alarm events of the selected PC / door/ | PC
controller. Controller
When clearing any events, users are prompted to Door
add a note for this action, which is recorded within
User Action Monitor (Monitoring > New User
Action Monitor).
Reset Anti-Passback Enable a user to re-access the entrance or exit PC
reader. See Chapter 6 Anti-Passback. Controller
Sync Controller Sync the settings between the controller and PC
GV-ASManager immediately. Controller
Reconnect Reconnect to the controller. Controller
Settings Access the Controller setup dialog box. Controller
Door
ASWeb Link to GV-ASWeb. PC
Stop Alarm, Clear the alarm conditions. For alarm settings, Door
Clear Forced Open, see 4.2.2 Configuring Doors or Elevator Floors.
Clear Duress,
Clear Tamper,
Clear Fire Alarm, Clear
Held Open, Clear Access
Denied
Sync GV-GeoFinger / Add the selected user data to and replace the Door

GV-FR2020/
GV-vD8700 /
GV-FD8700-FR / GV-Al
FR / GV-FR Panel

current databased on the device or program.

16




H The Main Screen of ASManager

3.3 Monitoring Windows

The Monitor windows allow you to monitor various activities.

e To open the Monitor window, click Monitoring on the menu bar, and select the desired
one.
LET ASManager - [Locate People] !
File PlOGLUEles View  Setup  Personnel

! | ¥

']| a: @ Mew Access Monitor Iﬁ.
E??t..r?.l.l..e_r.:vi & MNew Alarm Monitor |
- 1 MNew Event Monitor [

1616 |
| Mew Patrol Tour Monrtor
Controller|

vﬂTEJ 2 New LPR Monitor

o O B

Mew Parking Monitor

New System Monitor
Mew User Action Monitor
Mew IOBox Monitor d

Mew Locate People

EE% 2

Mew Area Monitor

Figure 3-5
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3.3.1 Controls on the Monitor Window

The controls available on the Monitor windows vary. Here we use the Access Monitor window
as example to explain the controls.

Hi Access (Wonitor

b 4

Message Door Direction Local Time Card Numbe |
) Access Granted: Card Entry Doorl  In 7/11/2017 4:51:48 PM  245-08670

0 Access Granted Doorl  In T/17/2017 5:52:00 PM - 245-09166

0 Access Granted Doorl  In T/17/2017 5:52:05 PM - 245-09166

) Access Granted: Card Entry Doorl  In 7/17/2017 8:00:00 PM  245-09166

0 Access Granted Doorl  In T/18/2017 10:18:26 AM - 245-15502

€3 Access Denied: Invalid Card Doorl In T/18/2017 10:19:55 AM ~ 20290-29073
0 Access Granted Doorl  In T/18/2017 10:20:28 AM  20290-29073
0 Access Granted Doorl  In T/18/2017 10:24:38 AM  245-15502

i Access Granted Doorl  In T/18/201710:25:08 AM - 245-15502 [
Tiles | Thumbnails

o

Figure 3-6
No. | Name Function
1 | Filter Sets filter criteria to only display the desired activity
information. See 3.3.2 Customizing a Monitor Window.
Auto Select Focuses on the latest data display.
Lock Suspends the current data display.

Decides how events are displayed on the window. In
4 | Lists / Tiles / Thumbnails Tiles and Thumbnails views, user profile photos and
snapshots captured will be displayed if available.

In some Monitor windows, you can right-click a message to have more options or detailed
information. Below is an example of the options available when right-clicking a message in
the Access Monitor window.

| a Access Monitor a Access Monitor |
Y &EE
Message Door I
01 ] d N
@ Access Gran New/Edit Card...
P Access Gran Assign Image to a User...
0 Access Gran Assign Image to a New User..,
@ Access Gran Reset Anti-passback (242-51118)
ﬂ Access Gran
P Access Gran Browse Card Information
& Access Gran Browse User Information
2 Access Gran Show Image

Figure 3-7

18



H The Main Screen of ASManager

3.3.2 Customizing a Monitor Window

You can customize the messages displayed on a Monitor window by defining filter criteria.
Multiple custom Monitor windows can be added for your specific requirements.

1. To add one Monitor window, click Monitoring on the menu bar, and select one.

2.  Click the Filter button on the Monitor window. This dialog box appears.

Door:

[Vi=T] TEST198+C
2 [WIE] Controler 1
[¥][E] Deor1

Ivl'ﬁ Tamper = '.:{.B Controler 1
V4] Fire Alam B Daor 1
[V4# Held Open ngf_!. Daoor 2
I?ﬂ Access Denied I_?_‘ Daoor 3
[4# Talgating [¥I[E Door4
r{ﬂ- Urgert Code [¥1[E] Door5
& Diaor &
E! Door 7
[¥|[E] Door8

oK | [ Canesl

Figure 3-8

3. Select the desired messages and devices for monitoring, and click OK. The Monitor
window will only display the messages based on the defined criteria.

4. Right-click the Monitor tab on the main screen, and select Rename to name the

window.
&l Access =%t Monitor | B8 Event Monitar
= _I Renarne i —
: Close
i [
Figure 3-9

Note: The added windows are only for one-time use, and they cannot be saved after the
Monitor window is closed.
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3.3.3 Arranging Monitor Windows

The Monitor windows can be arranged on screen in several ways. On the menu bar, click

Window, and select one of the following options to arrange them:
m  Cascade: Overlaps the open windows and shows their title bars.
m  Tile Horizontally: Arranges the open windows horizontally.
m  Tile Vertically: Arranges the open windows vertically.

m  Arrange Icons: Arranges the minimized windows on the bottom.

You can also place the Monitor windows on a different computer monitor. On the menu bar,
click Window > New Window and drag the Window to another computer monitor.

20



Chapter 4 Settings

This section describes the following settings:

Adding Controllers
Adding Cards

Adding Weekly Schedules

Adding Access Groups

Adding Users

4.1 Setup Flowchart

n Settings

To get started quickly with GV-ASManager settings, follow the process illustrated below.

Set Controllers

Add One Card

Set Weekly
Schedules

<—

Set Doors

Set Controllers

Present the card to the card reader to see if the
message “Access Granted” is displayed.

Set Set Weekly Set
Holidays Schedules Time Zones

Set Access Groups

=

Add All Cards

-

Assign defined Access
Groups to cards

Create cards one by
one or in batch

Add Users

Assign created cards
to users

&

Create users

21
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4.2 Adding Controllers

To add door or elevator controllers to GV-ASManager, follow these steps:

Step 1 Configuring a Controller
Establish the connection between the controller and GV-ASManager. See section 4.2.1.
Step 2 Configuring Doors or Elevator Floors

Define doors on a door controller or floor buttons on an elevator controller. See section
4.2.2.

4.21 Configuring a Controller

1.

On the menu bar, click Setup > Devices. This window appears.

%4 Devices [Controller: 4 ports (4 free ports included), GV-Patrol: 0 ports, [0Box: 16 ports (16 free ports included]] X
00 = OCAQ T =Rpa
Device Group Default
Defaut Device D Model
&[] Controlles
oy LPR
o 8 108 Eg g
™ Camera ;

Time Zones Weekly Schedules Access Groups

= =

Holidays Door Groups Parking Lots

Figure 4-1

2. Under Device Group, define a group for the controller to be added. Otherwise, use the

Default group.

Note: The devices (Controller, LPR, I/O Box and Camera) under the same Device Group will
be applied with the identical settings of Time Zones, Weekly Schedules, Access Groups,
Holidays, Door Groups and Parking Lots.
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3. Right-click Controller > New Controller.

4 Devices [Controlier 10 ports (4 free ports included), GV-Patrol O ports]

L COQUR| =E p B
Dewvice Group Diefault
Default Device [} Madel
Mew Dewiee Group_1 ] L

; =R Mew Cortroller

&) 10Box
i M Camemna
Figure 4-2

4. Type ID and Name of the controller, select its Model and click OK.

Please Enter ID X
ID: B |
Name: |Controller 3 |
Model: GV-ASZ1XX e Cancel
Figure 4-3

Note: The Controller ID must match the Controller ID set ahead on the Web interface of the
controller. See GV-AS / GV-EV Controller User’s Manual.

5. Under Connection, select TCP / IP or Local DDNS as communication mode between
the controller and GV-ASManager. Type the connection information of the controller,
such as IP address, login credentials and Crypto Key (3DES code). You can also click the

Search button besides the IP to search for controllers detected in the same LAN.

7 Controller Setup ®
Cortrolier Setup
Devise Group - Dl
Coriraler Name Cortrler 1 Corlralber 10,
GMT “ v [ ][ =
[ Reteae Al Doure By Card [C] Enale Dayight Saving
Carnechon
[Tow— TCRAP
P TRIEETAE |
Pat; A000
MEC Addreaa [i3EROATIES |
Lser © admin
Password: | esssssses
Crypta Ky : T
=

23
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Note: The default values of GV-AS / GV-EV Controller are: IP address 192.168.0.100;
username admin; password admin; Crypto Key (3DES code) 12345678.

6. To verify if the connection settings are correct, click OK at this step and back to the main
screen. If the icon (& appears in the Controller view window, it indicates the connection
between the controller and GV-ASManager has been established. If the icon Ed appears,
it indicates the connection failed. Then make sure the above connection setup is correctly
configured.

[SEEs X

TEx18

Controller Status

- @ [?[Sh'l'CF-?4A5KLR

3 kjr—%“c‘;’:vtrollerl
Figure 4-5
7. The following settings are OPTIONAL.:
B GMT: The current time at the host computer.
B Release All Doors by Card: When a card is presented, all doors set to Release by
Card mode will open until the end of Release by Card mode set in the Authentication
Schedule. For Authentication Schedule, see 4.2.2 Step 2: Configuring the Doors.
H  Enable Daylight Saving: Enable the Daylight Saving Time by selecting your time
zone. The system will automatically adjust for daylight saving time.
Note:
The Release All Doors by Card function is not available for GV-EV48.

2. For details on disconnection messages displayed on the Status field (Figure 4-5), see
Appendix D. Controller Status.

3. To quickly create another Device Group, you can use the Apply Settings to Device

Groups option to replicate the settings (Holiday, Time Zone and Weekly Schedule) of
one device group onto other device groups.

& Devices |Controller; 4 ports (4 free ports included), GV-Fatrol: 0 ports, |0Bex: 16 ports

o -D CQUT =, a
Device Group New Devioe Group_2

Defaut
Evds

Device D Model
(] contralter
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4.2.2 Configuring Doors or Elevator Floors

A. GV-AS Controller: Doors

To define doors on the controller, click one Door on the left list of the Controller Setup dialog

box.

To define the general settings of a door under the General tab:

ﬂ Controller Setup
M Ssttings... w Advanced Dther
Controller Setup
= Name: Doar 1 Common Passward : sese 48 digee(0™9)
] Coorz
] Door3
:l Coor 4 Edtended Reader
Input
Entrance None hd Esit More ~
| s IP
Port Pot :
WSS Port WSS Port
MAC Address : MAC Address :
Account : Accourt :
Fassword Fassword :
Camera Mapping
Camera 1 Camera 2 :
None > e None 57
[Celayed snapshot- Sec(60) Delaysd znapshot: Sec(0™60)

Figure 4-6
B Name: Name the door.

B Common Password: Set a password for the door. When under Card or Common
Mode, the user can gain access by entering this password, plus # to enter the setting,
using a keypad. The default password is 1234. See Figure 4-8 for Card or Common
Mode.

[Extended Reader]

B Entrance / Exit: Set up the card readers connected to the entrance and exit of the door
through network. If the card reader is connected through Wiegand, skip the Extender
Reader settings.

®© GeoFinger: Connect to the fingerprint reader. The access granted when presented
fingerprints match those enrolled in GV-ASManager. See Chapter 3 Fingerprint
Only Mode in GV-GF Fingerprint Reader User’s Manual for details.
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® GV-CR1320/ CR420: Connect to the GV-CR1320 / 420 camera reader.

® GV-FR2020: Connect to the face recognition reader. The access granted when

recognized faces match those saved in GV-ASManager. See Chapter 4 Access

Control Configurations in_GV-FR Face Recognition Reader User’s Manual for

details.

® GV-VD8700 / FD8700-FR: Connect to the face recognition cameras, through
GV-FWC. The access granted when recognized faces match those registered in

GV-ASManager. See 14.1 GV-Face Recognition Camera.

® GV-Al FR: Connect to the face-recognition-based Server. The access granted when

recognized faces match those registered in GV-ASManager. See 14.2 GV-Al FR.

® GV-FR Panel: Connect to the face-recognition-based panel. The access granted

when recognized faces match those registered in GV-ASManager. See 3.7 Setting
up GV-ASManager in GV-FR Panel User’'s Manual for details.

[Camera Mapping] The settings are OPTIONAL unless a camera is installed at the door. For

details, see Chapter 5 Video Integration.

To define the advanced settings of a door under the Advanced tab:

26

|j Controller Setup
M Settings... Gererdl Cther
Cortroler Sehup
=] [ Urgere Code - Exe dction Unchange ¥
[0 Doorz
[ Door3 Lock Reset Time : Held Open Time : Lock Card Time:
O I[:‘;f; 3 ’5— Sec(1™500) 1,r;—| Secl0™9399) Entrance: D Sec(0™65535)
5 {Handicap Card} 10 [{Handicap Card) Exit: 0 Seci{l™65535)
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Figure 4-7
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Urgent Code: When the Urgent Code is entered on the reader, the associated door will
unlock. However, the door will not unlock if the door is in Release by Card Mode and has
not been unlocked by a card. The Urgent Code function is only supported by GV-AS1010
/ 1110 and readers connected to GV-AS210/2110/2120/410/4110/810/8110/
1620.

Fire Action: Set the door to be locked or unlocked when fire alarm occurs.

Lock Reset Time: If the door is monitored, type the number of seconds the door can be
held open. After the specified time expired, the door will automatically be locked. Next to
Handicap Card, type the number of seconds the door will be held open when a
Handicap Card is swiped.

Held Open Time: If the door is monitored, type the number of seconds the door can be
held open before a Door Held Open alarm is generated. Next to Handicap Card, type the
number of seconds the door can be held open after a Handicap Card is swiped before a
Door Held Open alarm is generated.

Lock Card Time: The user will be denied access if he or she tries to re-access the door
more than 1 time within the specified Lock Card Time. For example, if the Lock Card
Time of a cafeteria entrance is set to 7200 seconds, someone who entered the cafeteria
at 9 am will be prevented from re-entering the cafeteria until 11 am.

Two Person Rule: Select Entrance and/or Exit to require presenting Two Person A
Card and then Two Person B Card to unlock the entrance and/or exit door. To set a card
to Two Person A/B Card, see 4.3.1 Adding a Single Card section.

Interlock: Select door(s) for interlocking. Doors that are interlocked cannot be open at
the same time. The door only unlocks when the other door is closed. For example, Door
1 ~ Door 3 are interlocked. Door 1 will not unlock if either of Doors 2 and 3 is
open/unlocked, and when Door 1 is open/unlocked, Doors 2 and 3 will not unlock. The
function is not available for GV-EV48.

Anti-Passback: For details, see Chapter 6 Anti-Passback.

Alarm Event: The settings are OPTIONAL unless an alarm device is installed on the
controller. Select the alarm conditions to trigger the alarm device: Held Open, Force
Open, Tamper, Fire Alarm, Access Denied, Tailgating and Urgent Code (entered).

® Alarm Continuous Time: Type the duration of the alarm sounds in seconds for
Access Denied alarm.
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B Authentication Schedule: Optionally set separate access modes for different time

periods.

Authentication Schedule

@8 NN

01,2 3 4 56 7 & 9 1011 12 13 18 15 16 17 18, 19 20 21 22 23 2
Monday e

Tuesday

Wednesday
Thursday
Friday
Saturday
Sunday E

Hol. = =
Special Day 1 - |

Special Day 2

Special Day 3

Special Day £

Special Day 5

Special Day 6 :
Special Day 7 [17:05]
Special Day 8 ;

B Feleaze Mode B Card or Common Mode
[ Release By Card

B Card and PIN Code Mode Card Mode

Cancel

Figure 4-8

Select one access mode on the toolbar and drag the mouse over the timelines. Four (4)

access modes are available:

® Card Mode: Enabled by default. This mode only requires the user to present his or
her card to be granted access. Alternatively, the user can enter a passcode to gain
access if the reader comes with a keypad. To set up a passcode, see 4.3.3 Adding

a Passcode.
® Release Mode: Keep the door in an unlock status.

e Release by Card: The door unlocks only after a card is presented and
remains unlocked during the time specified for Release Mode. This option is
for preventing unattended doors from opening during the Release Mode.

® Card and PIN Code Mode: This mode requires the user to enter the card’s PIN
code on the keypad and then present the card. To set up a PIN code, see 4.3.1
Adding a Single Card.
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Editthe Card
Uzer E]
Card Humber. D0E122654
Cand Siatus Aclive - |
[7] &xchreation Date: 10/ B4 B~
Deactivation Dats: 21272015 O
| Fin Code: LTTH I

Figure 4-9 Pin Code setting on the Edit the Card dialog box

® Card or Common Mode: This mode requires the user to present the card or enter
the door’'s common password (see Figure 4-4), plus # to enter the setting, using the
keypad.

Exit Button Schedule: Optionally set the time periods during which the Exit button is
accessible. By default, access to the Exit button is always granted. To create a schedule,
click the Delete Access Time button &] and drag the mouse over the timelines for
when you want the Exit button to be locked. The function is only supported by
GV-AS1010/1110/210/2110/410/4110/810/ 8110/ 1620.

Button Schedule

&6 s

9 1 2 3 4 K & 7 F 9 1 71 12 13 14 1516 17 18 19 W 1 2 73 A
TN P P VP [P e WPLr D PR PO Yy Pl FAR P Dl Wl 1t BTy T [Erie BTy R S ey |

Monday

Tuesday
Wednesday
Thursday
Facay
Saturday
Sunday

Hol.

Soecal Day 1
Special Day 2
Soecial Day 3
Specal Day 4
Special Day 5
Soecial Day 6
Special Day 7 0 - 1
Specal Day B

B Access Time (Button)

Figure 4-10
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To define the settings of a door under the Other tab:

|j Controller Setup x
M Settngs... General  Advenced
Confroller Setup
T S Readrs Keypad
| Door2
E D:: 3 [+ Entrance [+ Exit
[0 Door4
Input
Auto Check Out
] Ertrance [ Exit
Time and Atterdance Management
[] Time Cleck
Figure 4-11

The settings at the Other tab are OPTIONAL and are only applicable when related settings

are also configured:

m Disable Keypad: This option works together with the Card and PIN Code Mode.
Deselect Entrance or Exit to allow access by swiping card only.

B Auto Check Out: Record the check-out time of visitor card on GV-VMWeb when a
visitor presents the card at the entrance / exit door. To set a card as Visitor Card, see
Adding a Single Card section later in this chapter.

B Time Clock: This option must be selected to enable GV-TAWeb. See Chapter 11
GV-TAWeb for Workforce Schedule for details.

Tip: After completing the settings of a door, you can click the Apply All button on the
Devices dialog box (Figure 4-1) to apply the Authentication Schedule and/or Exit Button
Schedule to other device groups.
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B. GV-EV Controller: Floors

To define the general setting of an elevator and floors under the Floors tab:

O Elevator

S

Ao Ganersl Camera Mapaing

K EE

Carers 1

ITI
1

- Hame:

Hame: Asleaze Scheduie

Floar 1 Cemmen Passwerd eer 4B Agnal—9 Hone

Aoar 2 Relay Reset Time: 5 Sesl17255) Dedayed snapahot
5 (Handicap Card) C Seoll 60
foar 3

Carem 2

&

Foar 4

o o W o o

| Two-Pareon Rule Heng v G*
|1 Time Chich. Disiayed snapahot:
Sacilmel)

FAoor §

&l

Foor &

Autharestian Schaduia

Hoar 7

Floor & i Extended Aeader

g
T
=
E

Aoor 9 - Entrance
Floar 10 P IP:

Figar 11 Port Port :

Fioar 12 VS5 Fert - W55 Pant -
Roar 13 MAC Arkess : ' MAC Addreea
Floar 14 FAeount Acoount

Foar 15 Pagaword ; Paggword .

EEEEERNERERERR &

Foar 16

17 b Aoor17

Figure 4-12
Name: Name the elevator.

Common Password: Set a password to unlock the floor button. When under Card or
Common Mode, the user can gain access by entering this password, plus # to enter the
setting, using a keypad. The default password is 1234.

Relay Reset Time: Type the number of seconds the floor button will remain accessible
after card is presented. After the specified time expired, the floor button will automatically
be locked. Next to Handicap Card, type the number of seconds the floor button will
remain accessible when a Handicap Card is swiped.

Two Person Rule: Require presenting Two Person A Card and Two Person B Card in
order to unlock the floor button. To set cards as Two Person A/B Card, see 4.3.1 Adding
a Single Card.

Time Clock: This option must be selected to enable GV-TAWeb. See Chapter 11
GV-TAWeb for Workforce Schedule for details.

Authentication Schedule, Extended Reader and Camera Mapping: The settings are
the same with those of configuring a controller. See A GV-AS Controller: Doors in section
4.2 for Authentication Schedule and Extended Reader. See Chapter 5 Video Integration
for Camera Mapping.

Release Schedule: Click -~ next to a Floor to specify time periods allowing
access to a floor button.

Note: The Release Schedules have priority over the Authentication Schedule.
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4.3 Adding Cards

Once you have configured a controller, you can start enrolling cards. All new cards must be
enrolled into GV-ASManager before access is granted. Up to 100,000 cards can be stored.

Depending on how many cards you need to program, you can simply add them one at a time
or use the batch function to add a group of cards.

Note: To use Mobile Card credentials, see GV-QR1352 / DES1352 User’s Manual for
details.

4.3.1 Adding a Single Card

1. To add one card, use one of these ways:

e Present a card to the reader. The message Access Denied: Invalid Card is displayed.
Right-click the message and select New / Edit Card. The New a Card dialog box
appears (Figure 4-14). Then follow Step 3 to complete other settings.

e  Onthe menu bar, click Personnel > Cards. This window appears.

= = O -~ | 2 e @] e
B B e T - T A I
MNew Batch Mew Mew Pass.., let Card Rea..  Import Expo Refresh
I Search by [ Card Number - ARo Selaer] Eilter View |
Card Mumber Card Type Card Cede User Card Status  Activation Date  Deactivation [L..  Privilzge Access Group GV-.. | Disaca: | [
En21212 Morrmal VWiegand26 Active No Privilege  Default @
Z9000-00001 Mormal Wiegand2é peter Active Mo Privilege Uzer Define (V]
Z3000-00010 Visitor Wiegand26 petediu Active 3/19/2015 3/19/201511:5... Mo Privilege All @
=3000-00013 Mormal Wiegand26  Neo Active Mo Privilege  Default @
EIp-00000001 Mormal Fasscode jay Active Mo Privilege Default (~] |3
E3P-000000C2 Marmal Passcode peter Active Mo Privilege User Define @ '__
EIp-00000003 MNormal Passcode MNzo Active Mo Privilege Default @ =
Total Cards: 18
Figure 4-13
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2. Click the New button on the toolbar > Add a New Card. This dialog box appears.

Mew a Card >
User: | | '.' /
Card Nu%er: |_ | @ Card Code: Wiegand26 ~
User
Card Status: Active W Card Type: MNaomal w
[ Activation Date: |1‘. 15/2021 |
[] Deactivation Date: |1‘- 15/2021 |
[ Auto Inactive {Days):
By Code> . | [ Disable Lock Card / Disable APB / Allow Access during
Lockdown Mode
Privilege: Mo Privilege hd
Card User Defined Field 01: | Lj Card User Defined Field 04: ] Lj
Card User Defined Field 02 | Lj Card User Defined Field 05: | Lj
Card User Defined Field 0 | Lj Card User Defined Field 06: ] Lj
Assign Access Groups:
Device Group Access Group Copy to User Define
Default Default .Cn-ntroller 1
[ Mew Device Group_1 Default
Figure 4-14

3. These settings are available for a card:

B User: Click the Assign User button @ to assign the card to a user.
B Card Number: Type a card number. You can also use the GV-PCR1251 / 1352

Enroliment Reader to detect and fill in card numbers automatically. See
GV-PCR1251/ 1352 Enroliment Reader’s Installation Guide for details.

B Card Code: Select the code format of the card.

B Card Type: Select one of the following card types.

¢ Normal: The card opens the door when it is under Card Mode, the default mode.

e Patrol: The card is assigned to the person in charge of patrolling a location, e.g. a

guard. When the patrol card is presented to the reader, the access will be

recorded but the door will remain locked. The feature can be set together with

Privilege in the dialog box. The patrol card user can have the privilege to stop

alarms and clear alarm events during patrolling.
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34

Two-person A Card: Two-person A/B rule. The card is defined as Card A. Card
B must be presented after Card A to unlock the two-person-rule enabled door.

Two-person B Card: Two-person A/B rule. The card is defined as Card B. Card
A must be presented before Card B to unlock the two-person-rule enabled door.

Visitor: This card is assigned to a visitor and the visitor's access is managed
using GV-VMWeb. See Chapter 10 GV-ASWeb.

Security: The security card can enable the Security Mode where no cards can be
granted access. Only the security card can disable the Security Mode.

Handicap: When the handicap card is used, the door will remain unlocked for the
time specified in Lock Reset Time and Held Open Time options for handicap
card. For the two options, see 4.2.2 Configuring Doors or Elevator Floors.

Activation / Deactivate Date: Specify the date to activate or deactivate the card.

Auto Inactive (Days): When the card has not been used for access for the specified

days, it will be deactivated.

PIN Code: Enter a four-digit PIN code for the card. When the authentication mode is

set to Card and PIN Code Mode, the user needs to enter the PIN code and then

present the card. The default setting is 1234.

For the controllers listed below, the user can gain access by entering the card

number and the set pin code. For example, if the card number is 12345678 and the
Pin is 0000, the command will be 000012345678 for GV-AS210.

Models Supported Command
Firmware (Example: Card 12345678, Pin 0000)

GV-AS100 V1.04 or later | Card Number + Pin Code
GV-AS1010 V1.0 only Example: 123456780000

GV-AS110 V1.04 or later | *kCard Number + Pin Code #
GV-AS1110 V1.0 only Example: * 123456780000#
GV-AS210/410/810 |V1.0-V1.23 Pin Code + Card Number

GV-EV48 V1.0 -V1.12 Example: 000012345678

Privilege: Assign one of these privileges to the user:

Stop Alarm: The user can stop alarms by presenting the card.

Clear Event: The user can clear alarm events by presenting the card. All alarms
in the Controller view window will be erased, but a record of these alarms is kept
in the Alarm Monitor.
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Disable Lock Card / Disable APB / Allow Access during Lockdown Mode: When
the option is selected, the card will be exempt from Lock Card Time and APB
settings. In addition, the card will be allowed access to doors when Lockdown
Mode is activated.

For details on Lock Card Time, see 4.2.2 Configuring Doors or Elevator Floors. For
details on Lockdown Mode, see the Lock Down button in 3.3.2 Controls on the
Window.

Note: The Allow Access during Lockdown Mode only works with:

® GV-AS210/2110/410/4110/ 810/ 8110 with firmware V1.23 or later
® GV-AS2120 with firmware V1.35 or later
® GV-AS1010/ 1110 with firmware V1.0 or later
® GV-AS1620
B Supported Devices: GV-ASManager supports up to 100,000 cards. The first 40,000

cards created are labeled as and cards 40,001 ~ 100,000 are labeled as

Assign Access Group: Select Device Group and then click its Access Group
dropdown list to assign one predefined access group. For details, see 4.5 Adding
Access Groups.

Controller: The Controller box displays the associated doors with Access Groups.

4. Present the enrolled card to the reader. Once the card is accepted, the message Access

Granted will be displayed.

Tip: For first-time users of GV-ASManager, you can click the Copy to User Define button

and select 24-hour access for each door for test run.

As=mign Access Groups:
Device Group Access Group Copy to User Define

[ Defauit Defaut = Controller 1

[ New Device Group_1 Dsfautt Door 1
Door 2
Door 3 24-h
Dioor 4

Figure 4-15
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4.3.2 Adding a Special Card

You can create up to 100 Special Cards for separately applying Lock Reset Time and Held

Open Time when swiping the card to a door. This function only works with GV-AS210/410/
810 firmware V2.80 or later

1.
2.
3.

Click the New button on the toolbar > Add a New Special Card.

On the menu bar, click Personnel > Cards. The Card List window appears.

Set Lock Reset Time in seconds after which the door will be locked automatically, and

Held Open Time in seconds before a Door Held Open alarm is generated.

Mew Card
Lzar
Card Nurber:
Cand Status:
[ ] Activation Date
] Deactivation Date

1 Auto Inactve (Days):

Actve:

== G

Card Code:

Card Type:

Wiegand 25

["] Disabile Lock Cand / Disable APB / Allow Access duing Lockdown Mode

X

P Coda:
Priviege: Mo Priviecs
ILo:h Resst Tme 600 Sac (165534) Held Open Time [600 Sec (165534) I
Civision Card User Defined Feid 04:
| ] i z]
Cand User Defined Feld 02: Cand User Defined Feld 05:
| x] | ]
Cand User Defined Field 03 Card User Defined Feld 06
| =] ! z
Asmgn Accees Groups
Device Group Access Gowo 2 Cooyio User Defire
£ Defaut Dafauit =!| Controller 1
] Evag Defaut | Doer 1
"] Mew Dewice Group 2 Defaut Dwr &
| Doge 3
:Dw 4
Figure 4-16

4. Other settings in the dialog box are identical to those of adding a single card. See Step 3
in 4.3.1 Adding a Single Card.

Note: The default Lock Reset Time is 5 seconds and Held Open Time is 10 seconds.
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You can create a mass number of cards, with card numbers in sequence, at a time.

1.

On the menu bar, click Personnel > Cards. The Card List window appears.

2. Click the New button on the toolbar > Batch New Cards. This dialog box appears.

[[] Disable Lock Card / Disable APB / Allow Access during Lockdown Mode

Assign Access Groups;

Batch new cards X
Card Number: ||_-_ e —
Card Code: Wiegand26 ~
Card Status: Active ~ | Card Type: Momal hd
[ Activation Date: e S
[ Deactivation Date: S
[] Auto Inactive {Days): &0
Fin Code: |uu Privilege: Mo Priviege ~
[] Division: [ Card User Defined Field 04:
| =l iz
[ Card User Defined Field 02: [JCard User Defined Field 05:
l =l ]
[ Card User Defined Field 03: [ Card User Defined Fisld 06:
| = %]

Device Group Access Group
Defautt Defautt
[] Mew Device Group_1 Default

Figure 4-17

3. Type arange of card numbers.

4. Other settings in the dialog box are identical to those of adding a single card. See Step 3

in 4.3.1 Adding a Single Card.

Note: The cards enrolled using the Batch function have the same PIN. To change the PIN of

a card, click the Edit button on the Card List window.
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4.3.4 Adding a Passcode

When the authentication mode is set to Card Mode, the user can either present a card or

enter a passcode to gain access. Follow the steps below to create a passcode.

Note: The Passcode function is only supported by:

® GV-AS1010/ 1110 firmware V1.1 or later
® GV-AS210/2110/410/4110/810/8110 & GV-EV48 firmware V1.3 or later
® GV-AS2120 firmware V1.35 or later
® GV-CS1320 firmware V1.0 or later
® GV-AS1620
1. On the menu bar, click Personnel > Cards.
2. Click the New button on the toolbar > Add a New Passcode.
3. Type a Passcode consisting of 4 to 8 numbers.
New 3 Card - Assign to [ Alvin | . S
Liser Alvin ;;
| Passcoce | Pazscode
Figure 4-18

4. Other settings in the dialog box are identical to those of adding a single card. See Step 3

in 4.3.1 Adding a Single Card.

After the passcode is created, a card number will be assigned to the passcode.
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4.3.5 Importing/Exporting Card Data

You can import and export card data in mdb, xIs, xlsx, or csv format.

To export card data:
1. On the Card List window, select desired cards using Ctrl + left click.
2. Click the Export button > Export to Access or Export to Excel.

3. Assign the file path, and optionally enter password to export card data.

Note:
1.  The Excel file format does not support the password protection.

2. The Passcode cannot be exported.

To import card data:

1. On the Card List window, click the Import button and select one of import formats:
Access, Excel, CSV, or Others.

2. Locate the file and type the Password if necessary. Click OK. This dialog box appears.

¥ou can define the feld mappngs. Set Mappings fo speciy the comespandence between felcs n the Cead and
fiald I the Sourca

Select Soure Tabke: Cardihoicer | Ao mapoing Claar mepoing

Card Fickds
Cardtla
CodaTyoe

DisablelockCand

Figure 4-19
3. Select the Source Table you want to import.

4. Click the Auto mapping button to automatically map the Source fields to the current card
data fields.

5. You can also manually map the fields by clicking the columns under Source Fields.

6. Click Import to import card data.
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4.3.6 Customizing a Card Data Field

You can customize data fields for cards. Up to six fields can be created for card data entry.

1. On the Card List window, click Card User Define Fields Setting.

2. Select one User Define field, and type the text to be displayed as the field label. In this
example, a Division field was created.

Card User Defined Fields Setting b4
Card User Defined Field 01: Card User Defined Field D4:
|Di\rision| | | |
Card User Defined Feld 02: Card User Defined Feld 05:
Card User Defined Field 03: Card User Defined Feld 06:
Figure 4-20

3. On the Card List window, click the New button on the toolbar or double-click a created

card to edit.

4. Click in the custom data field and enter the appropriate information. In this example,
human resources is entered in the created Division field.

Edit the Card - Assign to [ Adamas Army ]

Lser: |Adamas Amy 2
Card Mumber: 24251118

Card Status: Active ™
[ Activation Date: [11715/2021 |
[] Deactivation Date: |1'| 115/2021 |
Auto Inactive (Days): |Eﬂ- |
Pin Code: |nu |
Privilege: Mo Privilege b
Division: |H|.|man Resources| _:'_]

Figure 4-21
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4.3.7 Adjusting Columns on the Card List

You can adjust column items on the Card List window by enabling or disabling an item, or

move a column by dragging

1. To adjust column items, right-click any items and select Columns.

& CerdList
— o N : 2 & 2 = 2

1= —1| - | - by &l . f—_é - l'/.f;‘

B @ % £ le & 8l a8l o

MNew Batch New MNew Pass... Edit Delete Card Rea...  Import Expot Card User... | Mobile C... Refresh
Search by | User w | | Auto Select | Filter View
Card Murmnber Card Type Card Code User Card Status  Activation Date Deactivation Date I Auto Inacti
Boa-51118 Normal Wiegand26  Adamas Amy Active Sort Ascending
8 062-17232 MNormal WiegandZb Wang Hank Active 11/9/2021 Sort Descending
8 p-00000001 MNormal Passcode Adamas Ay Active

I Columns.., I|

Figure 4-22
2. Enable or disable desired items.

3. To move a column, select a column item, click and hold the left mouse button, and move

the column to the new position.
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4.4 Adding Weekly Schedules

This section helps you define daily and holiday access times. Up to 254 weekly schedules
can be defined with two default schedules for “Deny Access” and “Full Access”.

Before creating weekly schedules, it is helpful to map out all possible usages of weekly
schedules for the site. For example: consider the variety of access hours for employees,
consider requirements for janitorial personal who may need night access, consider
requirements for service or repair personnel who may need all hours’ access, consider
requirements for supervisory staff who may need extended hours access and etc.

e Step1 Adding Time Zones

Define the minutes and hours of the day when a user is granted access to a secure
site. The minimum time duration is 5 minutes.

e Step2 Adding Weekly Schedules
Define the days of the week when a user is granted access to a secure site.
e Step 3 Adding Holidays

Define specific dates as holidays and special days.
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441 Step 1: Adding Time Zones

This section provides examples of adding the following time zones:
e Day shift — 09:00 to 19:00 hours
¢ Night shift — 19:00 to 9:00 hours (cross midnight)

1. On the menu bar, click Setup > Devices, and select a Device Group. The devices under
the Device Group will be applied with identical Time Zones.

2. Select Time Zones on the left of the Devices dialog box. This dialog box appears.

Time Zones - Default
ER- -8 i

| [l 3t B TR P RRELRY BB AT 25 2

) 0 Deny Access

| Q‘

W Accese Time

Figure 4-23
3. Click Add ‘2. This dialog box appears.

Please Enter ID s
ID: E | oK
Name: | Time Zone 1 |
Figure 4-24

4. The ID is the number of the time zone, which is automatically assigned by the system in
ascending order. Name the time zone and click OK.

For example, name Time Zone 1 as Day Shift.

5. Click and drag the mouse on the timeline of the created time zone to mark the access
time.

For example, the time of Day Shift is from 09:00 to 19:00.

6. To create another time zone, click Add &2 and name it, e.g. Night Shift. Then click and
drag the mouse on the timeline to mark the access time, e.g. from 19:00 to 24:00 and
from 00:00 to 09:00.

7. Click OK. The two time zones are created and defined.
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4.4.2 Step 2: Adding Weekly Schedules

This section provides examples of adding the following weekly schedules:
e Schedule-Day Shift — Monday through Friday, 09:00 to 19:00 hours
e  Schedule-Night Shift — Monday through Friday, 19:00 to 9:00 hours

1. On the menu bar, click Setup > Devices, and select a Device Group. The devices under
the Device Group will be applied with identical Weekly Schedules.

2. Select Weekly Schedules on the left of the Devices dialog box. This dialog box appears.

[T] Weekly Schedules - Default *
- ST e —
81 24-+hour restricted Monday P Aoceas
[T 24-+our access
Tueaday Ceny Access

Wednesday  Dery Access

Thursday Ceny Acceas
Friday Ceny Access
Saturday Ceny Accezs
Surday Deny Access
Hol Deny Access

Specid Day 1 Deny Access

Specid Day 2 Deny Access

Specid Day 3 Deny Access

Specid Day 4 | Doy Access

Specidl Day 5 Dery Access

Specid Dav B Deny Access

Specid Day 7 Deny Access

Special Day 8 Deny Access

Figure 4-25
3. Click Add 2. This dialog box appears.

Please Enter ID X
o |
Name: |Schedu|e 1 | Cancel

Figure 4-26

4. The ID is the number of the weekly schedule, which is automatically assigned by the
system in ascending order. Name the weekly schedule and click OK. For example, name
the Schedule 1 as Schedule-Day Shift.
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From the dropdown lists of Monday to Friday, select the Day Shift time zone you have

created. No access is allowed on Saturday, Sunday and Holiday.

7] Weekly Schedules - Default

@ e

FF] 24-hour restricted

i Monday Day Shift ™ T - |
Tuesday Day Shit T T | -
@ Schedule-Night Shift Wednesday Day Shift I:__—'_l b
Thusday | Day Shif ™ T | -

Fiday EEEN s ]

Saturday | Deny Access [ i i i ! I I I |

Sunday Dery Access [ ! | &

Hol. Deny Access [ I | -

Special Day 1 | Deny Access | : | ¥

Special Day 2 | Deny Access | ! | ¥

Special Day 3 | Deny Access [ ! | v

Special Day 4 | Deny Access | I |~

Special Day 5 | Deny Access | I L ¥

Special Day 6 | Deny Access | I | ¥

Special Day 7 | Deny Access [ ! | ~

Special Day 8 | Deny Access [ I ;¥

cors

Figure 4-27

To create a second time schedule, click Add ¥ and name it as Schedule-Night Shift.

From the dropdown lists of Monday to Friday, select the Night Shift time zone you have

created. No access is allowed on Saturday, Sunday and Holiday.

Click OK. The two weekly schedules are created and defined.
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4.4.3 Step 3: Adding Holidays

To designate specific dates as holidays and special days on the system:

1. On the menu bar, click Setup > Devices, and select a Device Group. The devices under
the Device Group will be applied with identical Holidays.

2. Select Holidays on the left of the Devices dialog box. This dialog box appears.

E™ Holidays - Default >
| ] =] B %
[ December 2023 Janu aary 2024 ehnuary 2024 March 2024 il 2024
SMTWTFS SMTWTF S SMTWTEFS SMTWTFS SMTWTFS
12 123456 1T 2 3 12 T 2 3 456
1456789 78 910111213 45573910 34567889 TR 3101112713
101112 13 14 15 16 1415 16 17 18 19 20 112 13 14 15 16 17 101112 13 14 15 16 1415 16 17 18 13 20
1180223 NBBADBKF 181920 21 22 23 M 7181920 212 23 A N34 5B585
24252627282530 2829303 BXXTAH2 2425262722030 252930
k| 3
May 2024 June 2024 Juy 2024 August 2024 Sepiember 2024
SMTWTFS SMTWTFS SMTWTFS SMTWTEFS SMTWTFS
12 3 4 1 12 3 45 6 T 3 12 3 4567
56 7 8 910N 2345857 B 7 B 910111213 45678 910 3910111213 14
12 1314 15 16 17 1B 970111213 415 14 15 16 17 18 1% 20 1112 13 14 15 16 17 1516717 18 13 20 21
1920 21 2223 24 35 1617 1819 20 21 22 21 22 23 24 25 26 27 18 19 20 21 22 23 24 2223 24 25 26 27 28
XTHHIDAN BMABBTRS 282530 N 2526272829 30 31 25 30
0
October 2024 Novemper 2024 December 2024 | January 2025 |
SM TWTFS SMTWTFS SMTWTFS 5MTWTFS
12345 12 123 45 6 7 | R
67 8 93101 12 3456789 8 310711213 14 56 7 8 51011
12 14 15 16 17 18 13 1071 12 12 14 15 16 15 16 17 13 19 20 21 1213 14 15 16 17 18
202 2BMBB TR 2 2 zZaEEsTs 1920 21 22 23 24 25
27 28 29 20 31 2452627222530 2 NE 26 27 28 29 30 31
Il ol | eI
" [Sp=cid Day 3 . Sperial Day 4 | [Specid Day 5
Sy |
Cancel
Figure 4-28

3. Click the Holiday icon and click the dates you want to set as holidays. For example,
e Dec 24, 2024 — Christmas Eve
e Dec 25, 2024 — Christmas Day
e Dec 31, 2024 — New Year's Eve
e Jan 01, 2025 — New Year’'s Day

4. You can designate up to 8 special days for Authentication Schedule and Exit Button
Schedule by clicking the color blocks and selecting the dates.

Note: Holiday dates and special days can cross over to the following year, and certain holiday
dates change from year-to-year. Administrators should review and update the holiday settings
prior to the beginning of a new year to ensure proper holiday coverage.
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4.5 Adding Access Groups

An access group defines which doors or lanes can be accessed at what times. You can
create multiple access groups to suit the schedules of different groups of employees. Instead
of setting the access rights of each card one by one, you can quickly assign a card to an
access group and the access rights of that access group will be applied to the card.

This section describes how to create an access group and assign a card to the access group.

To create an Access Group:

1. On the menu bar, click Setup > Devices, and select a Device Group. The devices under
the Device Group will be applied with identical Access Groups.

2. Select Access Groups on the left of the Devices dialog box. This dialog box appears.

r_F—'_"; Access Groups - Default *
QO By Access Group Name: Default
| Highlight
F‘E Default General
Search Gate:
[=] controller 1
| Door 1 24-hour restricted
| Door 2 24-hour restricted
Door 3 24-hour restricted
| Doar 4 24-hour restricted
Figure 4-29

3. Click New _J and name the access group, e.g. Daytime Staff and Nighttime Staff.

4. To define door access for the access group, click the dropdown list next to each door and
select one of the predefined Weekly Schedules. For example, select Schedule-Day Shift
or Schedule-Night Shift created in 4.4.2 Step 2: Adding Weekly Schedule.

5. Optionally, users can click Merge '£1 to create an access group containing all the
access schedules of multiple access groups selected.

For example, merging Daytime Staff and Nighttime Staff to create an access group of

Supervisors.

6. Optionally, enable Highlight to highlight all the access messages of the access group in
the Access Monitor window.
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To assign a card to an Access Group:

7. Click Personnel on the menu bar > Cards. The Card List dialog box appears.

8. Double-click one listed card. The Edit Card dialog box appears.

9. Select Device Group, and from its Access Group dropdown list, select one predefined
access group, e.g. Daytime Staff. The Weekly Schedules assigned to the access group
are displayed on the fields of associated doors.

Assign Access Groups:
Device Group Access Group -_ Copy to User Define
Defait [paytime Staff = Controller 1 )
] New Device Group_1 DE*E'UH :Door 1 Schedule-Day Shift
Daytime Staff = T -
Nighttime Staff ElDaor 2 | 2—1-hcur res?ri_ct_ecln
User Define EDoor 3 24-hour restricted
Door 4 | 24-hour restricted
Figure 4-30
Tip: To search for an access group or a door, you can type its keyword in the respective

search boxes.

r_f_'_"E Access Groups - Default

8 e m '-_L.",‘ Access Group Name: |NEW Access Group_2 |
ﬁl= Defaukt General
r_r':“; Daytime Staff ISearch Gate: | I
. Mew Access Group_2 p=
rjl- | =!| Controller 1
| Door 1 24-hour restricted
Figure 4-31
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4.6 Adding Users

This section describes how to create a database of user accounts and assign cards to users.

4.6.1 Adding a User

1. On the menu bar, click Personnel > Users. The User List window appears.

2. Click the New button on the toolbar. This dialog box appears.

User Sebup et
Gared  Home Buisness  LserDefire Fefures [a
First Name= Wickdle Narne Lagt Narme
[ [ | |
Dimplay: Employes 10
| - | (Verfication Key for Moble Accesa)
D: Erthday: Gender
[ | [ 1/ 1/1300 B-] Owae (®) Famale
Core 08 8
hicle: - B
g
|
[[] Serd Emal
Signaturs
s
Figure 4-32

3. Type a name under Display, which is a required setting. Other user information are of
optional entries.

4. To assign a card or vehicle to the user, click Add 2 to create a new card or vehicle, or

assign an existing one.

Add existing cards
#Add a new card
Add & new passcode

Vehicles I L+ ] b o

Cards:

Figure 4-33
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5. To send e-mail alerts whenever any of the cards / vehicles assigned to the user is

presented to the reader, select Send Email.

Note: To send e-mail alerts, see 8.2.2 Setting up E-Mail Server to configure the e-mail

server first.

The Home and Business tabs allow you to enter personal information for the user account.
Under the Business tab, if you enable Separation Date, the cards for this user will be

deactivated on the day after the specified date.

Tip: To edit the Business and User Define tabs of multiple users at a time, use Shift + left
click to select multiple users from the User List, right-click the selected users, and click Edit.

B3l lint o (i ]
] & = =
& ] B 5 F-3 a g‘ @]
= Edt Dlete Tpor: Eaport User Difine Fisld Setfing
Seevch by [User Z [ Autn Sekrt| Fiftar Vine:
Ernplyee Departrent Jab THe st Mokl brthiay Hee [ate Photn
EETH ] T sz
L1z43671 Engrant 1AL
WANHL

ERELTH Engeseit
L1456 Engiaens
LIS Ergnerit  ompare
JRELH Cansukar E
13345671 Admin

dulen WAL
1142013
1
i

[ W Ler 418 3 itepnfs) sebected

Figure 4-34

You can enroll fingerprints under the Features tab using GV-GF1911 / 1921 / 1922. For
details, see Chapter 3 Fingerprint Only Mode in GV-GF Fingerprint Reader User’s Manual.

50


https://dlcdn.geovision.com.tw/Manual/Access-Control/Fingerprint-Reader/GeoFinger_UserManual.pdf

n Settings

4.6.2 Customizing a User Data Field

You can customize data fields for users. Up to ten data fields can be created for user data
entry.

1. On the menu bar, click Personnel > User. The User List window appears.

2. Click the User Define Fields Setting button on the toolbar. The User Define Fields
Setting dialog box appears.

3. Select one User Define field, and type the text to be displayed as the field label. In this
example, a Parking Space Number field was created.

User Define Fields Setting lﬁ

Uger Define 01: User Define 06:
Parking Space Number

Uger Define 02: Uzer Define 07:
User Define 03: User Define 08:
User Define 04 User Define 09:
IUzer Define 05: User Define 10:

| ok | | Cancs
Figure 4-35

4. On the Card List window, click the New button on the toolbar or double-click a created
user to edit.

5. Click the User Define tab. The custom data field created now is displayed.

User Setup >

General Home Business User Define | Features

I F‘arking Sgace humber: l User Defined Field 06:

Figure 4-36
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4.6.3 Importing/Exporting User Data

From the User List window, you can import and export user data in mdb, xlIs or xlsx format.
For details, see 4.3.4 Importing / Exporting Card Data.

4.3.4 Adjusting Columns on the User List

You can adjust column items on the User List window by enabling or disabling an item, or
move a column by dragging. For details, see 4.3.6 Adjusting Columns on the Card List.
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4.7 Adding I/O Boxes

To add one GV-I/O Box to GV-ASManager over network for I/O management, follow these
steps:

e Step1 Connecting GV-I/O Box

Establish the communication between GV-1/0O Box and GV-ASManager. See section
4.7.1.

e Step 2 Configuring Input and Output functions
Define the input and output pins to be used by GV-1/O Box. See section 4.7.2.

Note: GV-ASManager supports up to 16 GV-1/0 Boxes. Over 16 box connections require a
license.

4.71 Connecting GV-I/0 Box

1. On the menu bar, click Setup > Devices. The Devices dialog box appears.

2. Under Device Group, define a group for the 1/0 Box to be added. Otherwise, use the
Default group.

Note: The devices (Controller, LPR, I/O Box and Camera) under the same Device Group will
be applied with the identical settings of Time Zones, Weekly Schedules, Access Groups,
Holidays, Door Groups and Parking Lots.

3. Right-click 10 Box > New IO Box.

& Devices [Controller 10 ports (4 free ports included), GV-Patrol: 0 ports]

oS- + - NOW =S W
Dewice Group _Defal.l
| Defauit | Device D Modsl
Nesw Device Group_1 il [ Centroller
&L LPR
P —— E—

+- 3% C Mew [(OBox

Figure 4-37
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4.

5.

6.

54

Type an ID number and Name for the I/O Box, select Type of the 1/0 Box and click OK.

Pleasze Enter [D &J

1D: 1

Name: IDBOX 1 ok
Type: |Gv-oBoX 8 - [rr—

Figure 4-38

Under Connection, select the communication mode between the I/0 Box and
GV-ASManager.

£] 10Box Setup ®

General Setup |10

General
Device Group : Default
Device Name IOBaox 1
|CBox 1D 1
GMT : + v |08 | o | DD w

[ Enatle Daylight Saving Setup

Connection
Metwork : Local DDNS =
Local DDNS Server IP : | ; ; : | Device Name :
Port : 10000
User : | |

Password : | |

Figure 4-39

e If selecting TCP / IP, type the IP address, port number and login credentials. You

can also click the Search button EJ to search for I/O Boxes detected in the same
LAN.

e If selecting Local DDNS, type the IP address of the LocalDDNS Service, the device
name to match that on the 1/0 Box’s Web interface registered from the LocalDDNS
Server, the port number and login credentials.

To verify if the connection settings are correct, click OK at this step and back to the main

screen. If the icon £ appears in the 10 Box view window, it indicates the connection

between the I1/0 Box and GV-ASManager has been established. If the icon Ed appears,
it indicates the connection failed. Then make sure the above connection setup is correctly

configured.



7. OPTIONAL settings in the General Setup tab:

4.7.2 Configuring Input and Output Functions

1.

. GMT: The current time at the host computer.

n Settings

* Enable Daylight Saving: Enable the Daylight Saving Time by selecting your time

zone. The system will automatically adjust for daylight saving time.

10Box Setup

Creneral Sehop [0

ut

g

x

2. On the left panes, select one input or output to be defined.

Input 4
M. 1D Marne [ Enatle
| Input 1
B o2 Lnput 2 Tnputbode : @No  (OHC
3 ?mﬁ : [ Latch Enable
1]
p Trigger Oupt None v
Cameral :
Hone -
Delayred mapshot: o Sec0-60)
Camerad :
None -
Delayed sapshot: 0 Secil~60)
Triggered Tlevice: (@) Contmller (CILPR
Device : Houe b
Action: o
Ciptput
T Omfput 1
H. D Maime
[ Enatle
1 Chtgut |
a Output 2 Cmtpat Mode : @y (N
3 Output 3 Trigger Mode -
4 Output & O Horml
|_u | Beciiass)
Delayed mapshat: i ec(0~a0)
Comera 2 ©
Wone - .
Delaved snapshot: 0 Sec(1~£0)
Cance
Figure 4-40

To define the input and output devices, click the 1/0 tab. This dialog box appears.
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[Input]
B Enable: Enable this Input function.
B Input Mode: Configure the input to NC (normally closed) or NO (normally open) mode.
B Latch Enable: Instead of constant output alarm in N/O and N/C, the option provides a
momentary alarm when triggered.
B Trigger Output: Select an output to trigger when the input is activated.
B Camera 1/ 2: Select cameras to take snapshots upon input trigger.
B Delayed snapshot: Type the number of seconds to delay capturing a snapshot after
input is triggered.
B Trigger Device: Specify the controller or LPR device to trigger a door or lane operation.
[Output]
B Enable: Enable this Output function.
B Output Mode: Configure the input to NC (normally closed) or NO (normally open) mode.
B Trigger Mode:
*  Normal Mode: Output continues to be triggered until the source of the output
condition is stopped.
* Toggle Mode: Output continues to be triggered until a new input trigger ends the
output.
*  Pulse Mode: Output is triggered for the amount of time specified in the Sec field.
B Camera 1/ 2: Select camera(s) to take snapshots upon output trigger.
B Delayed snapshot: Type the number of seconds to delay capturing a snapshot after
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Chapter 5 Video Integration

GeoVision IP devices, software and third-party IP cameras can be connected to
GV-ASManager over a network. Live videos can then be accessed and snapshots will be
captured when the events of access control, LPR and I/O devices occur.

GV-ASManager provides the following video features:
e Live view
e Video playback
¢  Monitor up to 16 cameras simultaneously

e Text Overlay

Note:

1. GeoVision IP devices and software include GV-DVR / NVR / VMS, GV-Al Guard,
GV-Recording Server, GV-Video Server, GV-Compact DVR and GV-IP Camera.

2. GV-ASManager is compatible with third-party IP devices using RTSP, ONVIF and PSIA
protocols.

3. GV fisheye dewarping is only supported when using MultiView, and only available on
Single View mode.

4. To add a camera from GV-DVR / NVR / VMS, GV-Al Guard, it is required to enable
Control Center Server (CCS) on these hosts.
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5.1 Mapping Cameras

Following the steps below to associate a camera with the door, floor, lane or input/output
device.

To add a camera:
1. On the menu bar, click Setup > Devices.

2. Select the desired Device Group, right-click Camera > New Camera.

& Dovices [Cortrollar 10 perts (4 Tree poits incheded) GY-Patrak 0 ports] P

o0« OO =R
D Group. Hew Device Group_3
Bt [Bencs T i

| [ Contraley
tg‘E’EE?-7—-—|

Trea Zanss Wodky Schodis  Acraa Grupd

Do Geues Pabioga Luts

Figure 5-1

3. Inthe Host Setting dialog box, select the type of the IP device and define its connection
information, including IP, login credentials, port(s) and number of cameras connected
with.

2 Host Setting *
Device Group : Default
Model: IP Camera

Host Name :

IP Address : [132.168.1.22 |
User: [admin |
Password : [sreenrns |
VS5 Fort [ 10000 |
Brand : | GeoVison_G-BL520D/BL5310_Se
Number of Cameras : [1 |

ASWeb Live Video Connect Type

Connect Type } ASMana_uer |
Pot
Defautt Cancel
Figure 5--2

Note: To connect IP devices through RTSP, ONVIF and PSIA protocols, select IP
Camera from the Model drop-down list, and then Protocol from the Brand drop-down
list to choose the type of protocol.
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4. Optionally, define how the live view of camera is streamed to GV-ASWeb.

B ASManager: Enabled by default. The live view is streamed from GV-ASManager to

GV-ASWeb.

B Motion-JPEG: The live view is streamed from the IP device to GV-ASWeb in JPEG

format.

B Web Socket or Web Socket Secure (Recommended): The live view is streamed
from the IP device to GV-ASWeb, through port 80 or 443 respectively.

5. Click OK and return to the main screen.

To associate a camera:

6. Double-click a Device, and select one Door, Floor, Lane or I/O for setup.

@ @ =

Device Group

ST =B 23

Default

Default
Mew Device Group_1
Mew Device Group_2

Mew Device Group_3

Device
=] [ Controller
i!_ Controller 1

L PR

se:-.;-:i Devices [Contraller: 10 ports (4 free ports included), GV-Patrol: O ports]

|- e L_amera

- g&] 10Box

Figure 5-3

7. Use the drop-down list to select a camera you just added. Take GV-AS Controller as an

example as below.

Camera Mapping

Camera 1: Camera 2
GV-BA2700-FD, Camera 1 - | P GY-BAZ700-FD, Camera 2 - TP
Delayed snapshot: 0 JSec{ﬂ‘Gﬂ} Delayed snapshot: 0 Sec{060)
Figure 5-4

8. Optionally, enable Delayed snapshot by defining the number of seconds to delay

capturing snapshots after an event is triggered. For example, if the camera is installed 10

meters away from a card reader and it takes 5 seconds for a user to walk pass the

camera after presenting the card, you can delay the snapshot for 5 seconds.
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Once set up, the camera will take snapshots when a card reader, LPR camera or I/O device
is triggered. You can access the snapshots from the corresponding Monitor window in
Thumbnails view.

Tip: You can associate two cameras of entrance and exit, respectively, with one door. Or
you can associate two cameras with a door with different view angles.
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5.2 Accessing a Live View

After mapping cameras to a door, floor, lane or I/O device, use one of the following methods
to access live view on the Live Video window:

e On the Controller / LPR /10 Boxes List window, click the desired door, floor, lane or input
[ output. Its associated live view will appear.

e On the Camera List window, click the desired camera. Its associated live view will
appear.

e On the Access / Alarm Monitor window, click the desired event. Its associated live view
will appear.

To access live views from multiple IP devices simultaneously, see 5.4 The Multi View
Window.
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5.2.1 Live Video Window

11T E—

|[1: Camera 1 "|:ﬁb FED|

Figure 5-5

No. | Name Function

) Switches between two cameras when you have mapped two
1 | Camera List
cameras to the selected door.

2 | Previous / Next Camera | Switched to the previous or the next camera.

3 | Best Fit Rescales the image to fit any resized window.
4 | Actual Size Displays the image in its original size.
5 | Zoom Zooms in or out the image.

Displays a thumbnail view (No. 7). When the image size is
6 | Thumbnail larger than the Live Video window, drag the box in the
thumbnail view to have a close look at the image.

7 | Thumbnail View See the description in No. 6.
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5.3 Accessing Captured Images

You can access the images captured after the access and alarm triggered event.

¢ On the Access Monitor or Alarm Monitor window, double-click the desired event to
display the captured image. Or, right-click the desired event and select Show Image to

display the image.

5.4 The MultiView Window

The MultiView window provides a live view of up to sixteen cameras on one window.

1. On the menu bar, click View > MultiView. The MultiView window appears.

2. Drag the desired camera from the Camera List window, and drop it to a grid on Multi

View.
Lo 030 e
_IZ: Camera 1 v“? B @ | MutiView - B

o

Figure 5-6
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No. | Name Function
1 | Layout Select the number of channels to display.
2 | Camera List Select the desired camera.

3 | Previous / Next Camera | Go to the previous or next camera view.

Select the installation site of the fisheye camera, and then
4 | Fisheye right-click the camera view to dewarp the circular source

image into single view.

Switch to a different Multi View. To add a Multi View:
1. In the drop-down list, type a name for the Multi View.

2. Click the Add Multi View button. The Multi View is
5 | Multi View created.

3. Drag the desired camera from the Camera List window to
the Multi View.

4. Repeat above steps to add more than one Multi View.

6 | Add Matrix Add a Matrix View.

7 | Remove Matrix Remove a Matrix View.

Note: When multiple monitors are set up in the system, you can drag and drop the Multi View
window to another computer monitor.
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5.5 Retrieving Recorded Videos

Recorded videos can be retrieved and played back from the hosts of GV-DVR / NVR / VMS,
GV-Al Guard and GV-Recording Server. For remote playback to work, you need to enable
the following functions on the hosts to allow remote access:

. For GV-DVR / NVR / VMS, GV-Al Guard, enable Remote ViewLog Service under
Control Center Server

o For GV-Recording Server, enable Remote ViewLog under Network

To play back a video:

. On the Access Monitor or Alarm Monitor window, click the desired event. If a recorded
video exits, the Playback window will be enabled. Click the Play button to play the video
clip.

b 4

Playback

|1:—1‘32.1E4°.-.ﬂ.8-FD32ﬂD vI

830/2011 17:26:01 623

Playback scroll Move to prev 1 min

Move to prev 5 min

S302011 17:26:01.623

Pause | Home | Forward
Play Stop Backward End Move to next 1 min

Move to next 5 min

Figure 5-7
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Right-click the window to have the following features:

Play Mode Includes these options:
¢ Frame by Frame: Plays back video frame by frame.

¢ Real Time: Plays back video on real time. This mode saves waiting
time for rendering, but drop frames to give the appearance of real-time
playback.

o Auto Play Next 5 Minutes: Plays back video up to 5 minutes.

e Audio: Turns on or off the video sound.

Render Includes these options:
¢ Deinterlace: Converts the interlaced video into non-interlaced video.

e Scaling: Smoothens mosaic squares when enlarging a playback
video.

o Deblocking: Removes the block-like artifacts from low-quality and
highly compressed video.

o Defog: Enhances image visibility.
o Stabilizer: Reduces camera shake.

o Text overlay’s camera name and time: Overlays camera name and
time onto the video.

¢ Text overlay’s POS/GV-Wiegand: Overlays POS or GV-Wiegand
Capture data onto the video.

e Full Screen: Switches to the full screen view.

Tools o Snapshot: Saves a video image.
e Save as AVI: Saves a video as avi format.

¢ Download: Downloads the video clip from a GeoVision IP device to
the local computer.
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5.6 Applying Text Overlay

Once the mapped cameras from GV-VMS are triggered, the event messages of Controller /
LPR /1/O can be overlaid on the camera view of GV-VMS. For details on mapping GV-IP
cameras, see 5.1 Mapping Cameras.

Note: The function is only supported by GV-VMS V16.10.3.0 or later.

To enable Text Overlay:
1. On the menu bar, click Setup > Devices and double-click a Device.
2. Select a Door, Floor, Lane or I/O for setup. Here we use GV-I/O Box as an example.

3. After selecting one Input or Output, in the Camera Mapping section, click the Text

Overlay icon ™ besides cameras.

Cameral:
| GYEYD2100152.168.0.20), Camera 1 ~| |2t
Delayed shapshat; 1] Sec(0~E0]
Camera 2 :
| GY-EVD2100(192.168.0.20), Camera 1 v |

Figure 5-8
4. Click OK to return to the Device List.

5. Click the Camera Text Overlay icon s

-] "lelﬁl
D [OBaox Type
1 0B ow 1 GY-I0BOX &

Figure 5-9
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6. Enter your own messages, or use the buttons on the text window to send out the

programmed information.

Text overay (For 10Box Log) Lﬂj

Eorosrfaos

——l
A %0

ok | | Canedl

Figure 5-10

Make sure the Text Overlay setting is also enabled in GV-VMS (Home > Toolbar >
Configure > Video process > Text Overlay Setting > Print ASManager Text on Screen).

Note: For how to text overlay a standalone LPR’s data on GV-VMS’s live view, see the

technical notice.
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n Anti-Passback

Chapter 6 Anti-Passback

The Anti-Passback is used to ensure one-card and one-way access into and then out of a
controlled area. This function prevents users from passing their cards back to a second
person to gain entry into the same controlled area. Depending on the number of controllers
and communication link, there are three types of Anti-Passback operations: Anti-Passback,
Local Anti-Passback and Global Anti-Passback, which will be explained more fully in the

upcoming sections.

Anti-Passback is performed only on one controller, while Local Anti-Passback and Global
Anti-Passback can be performed on multiple controllers. Anti-Passback is performed through
either RS-485 or TCP/IP connection, while Local Anti-Passback and Global Anti-Passback
are performed only through TCP/IP connection. The following table lists the supported
operations among GV-AS / GV-EV Controllers.

Model Anti-Passback Local Anti-Passback & Global
Anti-Passback
Yes (GV-ASBox or GV-ASNet
GV-AS100/110/120 Yes )
required)
GV-AS1010/ 1110
GV-AS210/410/ 810
Yes Yes
GV-AS2110/ 2120
GV-AS4110/8110
GV-CS1320 Yes Yes
GV-AS1520 Yes Yes
GV-AS1620 Yes Yes
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6.1 Anti-Passback

Anti-Passback is used on one controller only. For this application, select by Card — Local
or by User — Local at the Door tab of the Controller Setup dialog box.

B By Card - Local: Select this option to monitor the access into the controlled area by
cards. This option enables multiple cards to be used simultaneously by the same user.

B By User — Local: Select this option to monitor the access into the controlled area by
users. This option prevents the same card from using by multiple users.

Controller Setup ﬁ'
M Setings | General | Advanced |Other
Conéroller Setup

&) ooci | [ Urger Code : | 48 gl Fire Action - |Unchiange -

[¥] Door2

[C] Door3 Lock Resat Tims : Held Cpen Time : Lock Card Time:

4
[ E‘Oi G Sec(1~600) 1 Sec(0~3535) Entrance: 0 Sec{0~65535)
P
5 (Handicap Card) 10 {Handicap Card) Bd: ] Sec{l~65535)
Two-Person Ruls Interock
[ Entrance = [:]
Anti-Passback
@ MNone ") By Card - Local ("1 By Card - Gobal ) By User - Local
Figure 6-1

To reset Anti-Passback on GV-ASManager, right-click one Host or Controller on the
Controller view window (Figure 3-3) and select Reset Anti-Passback.

Note: The By User — Local option is only supported by GV-AS2 / 4 / 8 series controllers and
GV-AS1520 firmware V2.0 or later.
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6.2 Local Anti-Passback

Local Anti-Passback is used on multiple controllers which are associated with network
connections. Before you start, the following conditions must be true:

e The communication mode between GV-ASManager and the controller is Ethernet.

e LAN environment is applied.

This section explains how to combine three controllers to implement the Anti-Passback (APB)
function. Because Anti-Passback is performed across a network, each controller is assigned
a unique IP address. When three controllers are connected for Anti-Passback, an APB IP
address is used for interaction.

For example, Controller No. 1, No. 2 and No. 3 are combined in the order shown below. APB
IP is the IP address of the associated controller.

IP of Controller No. 1 is 192.168.0.11; APB IP of Controller No. 1 is IP of Controller No. 2.

IP of Controller No. 2 is 192.168.0.12; APB IP of Controller No. 2 is IP of Controller No. 3.

IP of Controller No. 3 is 192.168.0.13; APB IP of Controller No. 3 is IP of Controller No. 1.

Controller No. 1
IP:192.168.0.11
APB 1P:192.168.0.12

Controller No. 2
IP:192.168.0.12

APB 1P:192.168.0.13

Controller No. 3
IP:192.168.0.13
APB 1P:192.168.0.11
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To configure Anti-Passback for the three Controllers:
Step 1: Configuring Door Contacts
This step defines the door contact sensor for each door. When a door contact sensor is

triggered, GV-ASManager knows which door is open.

To configure door contact sensors, go to the Web interface of each controller and select
Input Configuration. In this example, Input 01 is set as Door Contact of Door 1, Input 02 is
set as Door Contact of Door 2 and etc.

L ] PO} - S
L GeoUision Input Configuration
Basic Setting Input Function
Netwark Configuration 01 AS2120_IN1 | NO v | Door 1 v | Door Contact
Other Configuration
02 AS2120_IN2 | NO v | Door 2 v | Door Contact v
Firmware Update
Security Configuration 03 AS2120_IN3 | NO v | Door 3 v | Door Contact v
Advanced Setting 04 AS2130_IN4 | NO v | Door 4 v | Door Contact
Figure 6-2-1

Step 2: Configuring APB IP Addresses

1. Access the Function Configuration page of the Controller No. 1’'s Web interface. In the
Series Function (APB & Fire) section, select Enable and enter Info IP that is the IP
address of Controller No. 2, e.g. 192.168.0.12.

Basic Setting DooriGate 4

Hetwork Configuration
= Function: Door Control -
Other Canfiguration
Firmware Update Authentication Mode: Authentication Schedule Mode

Security Configuration

Series Function(APE & Fire]
Advanced Setting
|| Enablemisable: Enable -
Parameter Configuration Partl Info IP: 142 168 o 172
F c ion Part2
Time Configuration Cancel

Figure 6-2-2

2. Access the Function Configuration page of the Controller No. 2’s Web interface. In the
Series Function (APB & Fire) section, select Enable and enter Info IP that is the IP
address of Controller No. 3, e.g. 192.168.0.13.

3. Access the Function Configuration page of the Controller No. 3’'s Web interface. In the
Series Function (APB & Fire) section, select Enable and enter Info IP that is the IP
address of Controller No. 1, e.g. 192.168.0.11.

4. In GV-ASManager, select Local Anti-Passback (Figure 6-1) to start the function.
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6.3 Global Anti-Passback

Global Anti-Passback can not only prevent the use of a card to gain successive entries, but

track the user around the site.

The plan below shows a typical site controlled by access control.

n Anti-Passback

Reader A Reader C
(Entry) (Entry)
O RECEPTION O FACTORY
Door A : Door B E Reader G
(Entry)
1 Reader B [T Reader D O
OUTSIDE (Exit) (Exit) Door D ;
] Reader H
Reader E SALES (Exit)
(Exit)
MEETING C ;
ROOM Door C
] Reader F
(Entry)
Figure 6-3

To configure the above site as example of Global Anti-Passback, you must complete the
following six steps:

o Step 1: Enabling Global Anti-Passback

Select By Card — Global at each Door tab (section 6.3.1).
o Step 2: Configuring Areas

Define the Entrance and Exit areas for each door (section 6.3.2).
o Step 3: Configuring Readers

Define the Entrance and Exit readers for each door (section 6.3.3).
o Step 4: Configuring Door Contacts

Define the door contact sensor for each door (section 6.3.4).
o Step 5: Monitoring Areas

How to monitor the areas for each door (section 6.3.5).
o Step 6: Locating Users

How to locate a user in the control area (section 6.3.6).
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6.3.1 Step 1: Enabling Global Anti-Passback

Select By Card — Global at each Door tab of the Controller Setup dialog box (Figure 6-1).
6.3.2 Step 2: Configuring Areas
This step is to define the Entrance and Exit areas for each door and name the areas properly.

e On the menu bar, click Setup > Areas. This dialog box appears. Then select a Door to
define its area by specifying Enter to and Exit from.

Area Settings -
@ | =] | Door:
e = [ Contraller 1
Door A goes from Reception to Outside
%beﬂl a.%rea Door B goes from Reception to Sales
RECE_DNU"' Dioor C goes from Sales to Meeting Foom
B8 Meeting Room B Door D goes from Sales to Factory
@ Sales
@Outside
@ Factary

Lane:
B E&ELPR1
Lane 1 goes to Global Area
Lane 3 goes to Global Area
E = LPR1200
B Lane 1 goes to Global Area
E & LPR3
Lane 1 goes to Global Area
Lane 2 goes to Global Area

Exit From: Enter To:
[Sa]es hd l | Factory -

Figure 6-4

Enter to is the area where a user enters by accessing the Entrance reader of the door. Exit
from is the area where the user is from. In this example, based on the plan of Figure 6-3, we
set up like this:

Door A: Enter to Reception; Exit from Outside

Door B: Enter to Sales; Exit from Reception

Door C: Enter to Meeting Room; Exit from Sales

Door D: Enter to Factory; Exit from Sales
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n Anti-Passback

This step is to define the Entrance and Exit readers for each door. The reader defining tells

GV-ASManager which reader controls the access across the area boundaries. When users

access unauthorized readers, the message Access Denied: APB (Wrong Area) will be

displayed and the door will remain locked. When users access the same reader successively,

the message Access Denied: APB (Double Entry) will be displayed and the door will

remain locked.

To define readers, go to the Web interface of controller. On the left menu, click Wiegand
Setting for Wiegand readers or Extended Reader for RS-485 / TCP/IP readers. In the
example below, based on the plan of Figure 6-3, Wiegand reader A (Entry) goes from

Outside to Reception, Wiegand reader B (Exit) goes from Reception to Outside and etc.

I Wiegand Function
Basic Setting Wiegand A DoowGate A Entry v
+ Network Setting
« Other Setting Wiegand B DoorGate A Exit  +
» Firmware Update Wiegand C DoorGate B Entry +
s Account Setting
Advance Setting Wiegand D Door/Gate B Exit (v
s Function Setting
« Parameter Setting Wiegand E DoorGate C Entry »
Time Settin
* 9 Wiegand F DoorGate C Exit  +
s |Input Setting
s Output Setting Wiegand G DoorGate D Entry v
+ Wiegand Setting
Extend Device Wiegand H DoorGate D Exit v
« Extend Reader
Figure 6-5
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6.3.4 Step 4: Configuring Door Contacts

This step is to define the door contact sensor for each door. When a door contact sensor is
triggered, GV-ASManager can tell which door is open.

To define door contact sensors, go to the Web interface of controller and select Input
Configuration. In this example, Input 01 is set as Door Contact of Door 1, Input 02 is set as
Door Contact of Door 2 and etc.

® i : :
L GeoUision Input Configuration
‘ . Input Function
Basic Setting P
Network Canfiguration 01 AS2120_IN1 ‘ NG ‘ ‘ B8 v ‘ RO
Other Configuration
: 02 AS2120_IN2 ‘ NO v ‘ ‘ Door 2 v ‘ Door Contact W
Firmware Update
Security Configuration 03 AS2120_IN3 ‘ NO ‘ ‘ Daor 3 v ‘ Door Contact v
Advanced Setting 04 AS2120_IN4 [ NO v ‘ ‘ Daor 4 v ‘ Door Contact ™
Figure 6-6

6.3.5 Step 5: Monitoring Areas

To monitor the area for each door, on the menu bar, select Monitoring > New Area Monitor.
When a card is swiped to enter an area, GV-ASManager can tell which user is granted
access to which area. In this example, the access from the card number 244-36572
belonging to the user lan Anston is granted to the meeting room.

Users Cards Vehicles
Location Status | =
TEST198-PC (@) ! | Card number User

Global Area 2= R H:17 =:10 ) 244-36574 [ Ian Anston
Factory B0 B:0 =:0
Meeting Room 0 @1 =0
Cutside B.o B0 =2:0
Reception 2= 8 (=:0
Sales B0 0 =0

Figure 6-7
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6.3.6 Step 6: Locating Users

To locate a user, on the menu bar, select Monitoring > New Locate People.

When the Entrance or Exit reader is triggered, GV-ASManager can tell if the user follow
Anti-Passback rules and then grant or deny access. In this example, based on the plan of
Figure 6-3, Christine Downes is granted access from Door A and now she is in the reception

area.
User Location User: Christine Downes
= TESTIRPC(12) ——————— & Message Door Direction  Local Time
Brendy Wiliams Global Area ) Acces: Granted Door A Out 9/15/2017 4:59:10 Phl
lan Anston Global Area i ] Access Granted Door A In 9/15/2017 5:00:09 P
Tom Hiddlestion Reception
Rachel Mil Global Area
David Wang Global Area
Scarett Johansson Global Area
Blake Lively N/AA
Chris Hemswaorth Global Area
Alexx Urda Global Area
Brad Macal Global Area
Christine Downes Reception
Joyce Change N/AA
Figure 6-8

Tip: To reset Anti-Passback in GV-ASManager or GV-ASRemote, right-click one Host or
Controller icon on the Controller view window (Figure 3-4) and select Reset Anti-Passback.
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Chapter 7 Patrol Tour

Patrol Tour can be created to require security staff to check in at the specified locations

during a certain time period.

7.1 Creating Patrol Tour

Create weekly Patrol Tours by specifying the doors where the security staff needs to check in
during the specified time period. If the security staff does not present their cards at the
specified door on time, an alert notification can be sent using e-mail or SMS message.

1. On the menu bar, click Setup > Patrol Tours. This dialog box appears.

Add Patrol Tour Add Patrol Point

- I’atnol Tour [El|
! | =
w o @| =B Q7 Q| %
. Fatrol Tour Controller Dioar Time o 2 4 & 8 L
z Patrol Touws 1 Sunday

Monday
Tuesday
Wednesday
Thursdap
Friday
Saturday

Figure 7-1

2. To create a new Patrol Tour, click the Add Patrol Tour button @ on the left toolbar.
The Group Patrol Tour option enables any patrol cards in the group presenting at the
patrol point to be counted as attendance. For Rolling Patrol Tours, see 7.2 Creating

Rolling Patrol Tour.
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3. Select a day in the timeline and click the Add Patrol Point button @ above the timeline.
This dialog box appears.

Add Patrol Point (Friday] M
Device Group: Default v
Controller: Controller 1 w
Door: Door 1 e

Time:

Buffer Period: _35 v| (05:30-06:30)
Extended Buffer Period; 30 ~| (0500-07.00)

Patrol Message: V D

(] w1t w

oK

Figure 7-2

4. To define the location and check-in time of the Patrol Point, select the Device Group,

Controller and Door that the security staff needs to patrol, and complete the following

settings:

Time: Select the time when the security staff should check in at the selected door by
presenting the card.

Buffer Period: Specify the Buffer Period in minutes, which will be added before and
after the check-in time specified above. Security staff checking in during the buffer
period will be considered on time. Using Figure 7-2 as an example, the security staff
needs to check in between 5:30am and 6:30am to be considered on time.

Extended Buffer Period: The Extended Buffer Period will be added before and after
the Buffer Period specified above. Security staff who checks in during the Extended
Buffer Time is considered late or early, and alert notifications can be set off if
enabled. Using Figure 7-2 as an example, check-ins between 4:50am - 5:30am will
be marked as Early, while check-ins between 6:30am — 7:10am are considered late.

Patrol Message: Click the ... button and type an alert message to be sent using
e-mail or SMS when the security staff is on time, early, late or absent.

Note: Security staff checking in outside the Extended Buffer Period will be marked as absent.

5. Click OK.
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6. To add more Patrol Points, repeat the steps 3~5. You can also drag a Patrol Point to

o

another day of week or click *+ to create a copy.

Below is an example of a completed Patrol Tour, where the dark green zone is when the
security staff needs to check in and the light green zone is the extended buffer period.

2 Patrol Tour [y

3 & | o | B 3 | e w=
mi Tour Continler Dom Time bo& 4 B B 0 12 4

EQRAEAZOEOROLEN T
pri ek et

Figure 7-3

7.2 Creating Rolling Patrol Tour

Rolling Patrol Tours are weekly schedules used to specify patrol points where the security
staff is required to check in repeatedly at the time interval set, e.g. every 10, 20 minutes or
every hour. If the security staff does not present the card at the specified door on time, an

alert notification can be sent using e-mail or SMS message.

1. On the Patrol Tour window, click the Add Patrol Tour button 9 > Add Rolling Patrol
Tour.
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2. Select a day in the timeline and click the Add Patrol Point button @ above the timeline.
This dialog box appears.

Add Patrol Point (Sunday) X
Device Group; Diefautt w
Controller: Cortroller 1 w
Doar: Door 1 w
Start Time: 1] 1l ~
End Time: 24 w0 ~
Interval Time: D minutels)
Alzrm Time: ‘:I minute(s)
Patrol Message: v
[ Apply Settings to All Days

Figure 7-4

3. To define the location and patrol time of the Patrol Point, select he Device Group,

Controller and Door that the security staff needs to patrol, and complete the following

settings:

Start Time: Specify the first time, within the day, when the security staff should
check in at the selected door by presenting the card.

B End Time: Specify the last time, within the day, when the security staff should check
in at the selected door by presenting the card.

B Interval Time: Specify the time interval in minutes, in which the security staff needs
to check in at the same door again after their last check-in time.

B Alarm Time: Specify the alarm time, counting down in minutes, in which to remind
the security staff to check in at the door selected. For example, if the Alarm Time is
set as 1 minute and the security staff needs to check in at 5:00, they will be alerted at
4:59. The Alarm Time must be smaller than the Interval Time.

B Patrol Message: Click the ... button and type an alert message to be sent using
e-mail or SMS when the security staff is on time, early, late or absent.

B Apply Settings to All Days: Select to apply the Patrol Point settings to all days of
the week.

4. Click OK.

5. To add more Patrol Points, repeat the step 2. You can also drag a Patrol Point to another

day of week or click

% to create a copy.
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7.3 Activating the Patrol Tour

1. After you have created the Patrol Tour, double-click the Patrol Tour. This dialog box

appears.

Patrol Tour Setup lﬁ

[7] Active
[ Offline Mode

Notffication
7] Pass | Eady [Tl Late ] Absence

Mapping

Card List:

Short Message Service

ok | | concel

Figure 7-5

2. Click Add = and select a card. You can add multiple cards if needed and the security
staff will be required to present one of the cards listed here.

Note: When the security staff presents the card, the controller may grant or deny door access
according to the settings of the card. For example, if the security staff is using a Patrol Card,
the door will remain locked and the security staff will check in without opening the door. See
4.3 Adding Cards to see how to add the cards.
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3. Double-click a card and select to notify by E-Mail and/or Short Message Service.

t apping
Card Lizt:
E-Mail
9 [026] 12345678 [IEMs
(2 [026] 23456789 To

CC:

BCC:

[ 5hort Meszage Service
Country Code: Mabile:

[ Apply l [ Cancel

Figure 7-6

4. To set up alert notifications, select the notification conditions to send alert.

| Active
| Offinie Mode
Neotinicatian
| Pass [ Eady

[ Absence

Figure 7-7

5. Optionally, click Offline Mode to be able to check in by the scheduled Patrol times
without an Internet connection through GV-Patrol mobile app.

6. Click Active to activate the Patrol Tour and click OK.

Note:
1. Once the Patrol Tour is activated, the Patrol Points cannot be modified again.

2. Once the Patrol Tour has been de-activated, the Patrol Tour Setup page will also
become unchangeable. Instead of re-configuring a new Patrol Tour from the beginning,

you can use the Copy Patrol Tour button to create a new patrol tour with the same
settings as the de-activated Patrol Tour.
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7.4 Monitoring Patrol Activities

To monitor Patrol activities, on the menu bar, click Monitoring > New Patrol Tour Monitor.

Next, click b to select the Patrol Tour you want to monitor. The current status of each
Patrol Point will be displayed. A red zone indicates Absence, an orange zone indicates Early

or Late, and a green zone indicates On Time.

i PatrD[Tnurli 4 bx
N ALES
13 14 1% 16 7 18 183 20 21 2 23 0 1 2 3 4 5 B 7 8 8 10 11 12 13 -
SmonChen(220477.. T (D) [(CEEC [ i '
ChHwipszeg O CHEEC [ () i
AbinChenfteetsosy) T [CHEC] [T [ Il
Figure 7-8
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7.5 Accessing Patrol Log

Patrol Tour

Using Patrol Log on GV-ASWeb, you can set search criteria to look up patrol records. For
how to log in GV-ASWeb, see 710.7 Connecting to GV-ASManager.

1.

On GV-ASWeb, click the Patrol Log icon. This window appears.

.?5 Patrol Log

Patrol

il «|| | E expand A1l =] Colapse Al ThisPage | oK
L -~
Zh — | | Name « Punch Time =~ Status | Ell | 2|
[
Tour: | Campus_East Side > 4 2, Campus_East Sde ~
Status: ¥ 4 [F]2013-08-01
Date Penod: | This Month ¥ 4 E) 12345678
: 5310
Start Data: = [3 1: controfier... 10 Absence
4 [2)234-565769 ( S Spike)
. 2
Hatome — [ 1: controler... 5 Spike 2210 Abzence
» [F]2012-08.02
= tard » [F]2013-08-03
card Number: e & [F]2013-08-04
= [Fz013-08-08
Card Code: v =
 [F]2013-08-06
Card Type: v
LS & [F]2013-08-07
Card Status: ¥ i [F2012-08-08
Privilege: ol  [F]2013-08-09
Access Group: = i+ C]2013-08-10 "
£ | -
Seareh i Page 1 of1 e Displaying | - 1 of 1
Figure 7-9

Under Filter in the left pane, define the search criteria. For example, you can use the
Status drop-down list to search for all patrol records listed as “Absence.”

Click the Search button to start the log search.

To export logs, see 10.6 Setting up Export Schedules for Lists and Logs for details. To

customize the columns of search results, see 10.4.4 Defining Columns for details.
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Chapter 8 Other Functions

8.1 Adding System Users

A system user is a person using GV-ASManager to monitor door controllers, enroll users or
program the system. Using this function, the system administrator can create new system
users with different access rights. Up to 1,000 user accounts can be created.

1. On the menu bar, click Tools > Operators. This dialog box appears.

Operator Settings .
& = 5
Qe ® B 0 |User1 |
. fS Guest
l__ﬁ User Email: | |
- Level: |User |
I:ﬁ Supervisor
LBy admin
Database Tool ASWeb... WMWeb TAWeb
ASManager ASRemote...
[JAccess Setup A
[JPerson Data
[]5vstem Settings
[IServer Start/Stop
Monitar
Live Video
Playback
[]Door Operations
[JLock Down
[J5top Alam w
Device Group | Read |Write | Execute |
Default [v v [v
EV4E I [ "
Mew Device Group_2 I [ [
[ Password emor checking
Allow password removal using ASProfile Restore

Figure 8-1
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Click the New button @ at the top left corner. The Add Account dialog box appears.

Type the user’s ID and Password. Re-enter the same password in the Password
Confirmation field.

Type an email address so that the user’s password can be sent to the email if forgotten.

Set the user’s authorization level to Supervisor or User. By default, users belonging to
the Supervisor level have full rights and permissions to system settings. Users belonging
to the User level are restricted from all system settings, and have only limited access to
certain functions.

Click OK to add the user.

Click any of the following tabs in the middle of the window: ASManager, Database Tool,
VMWeb, TAWeb ASRemote/ASNotify/Locakdown App/ASManager SDK, and
ASWeb/GV-Access/Web SDK/ASMobile/ASRemote Web/GV-Patrol. Select the
corresponding functions to grant access to the system user.

In the Device Group section, you can optionally select a device group and specify
whether the user account will be able to read, write and execute the functions assigned
under the device group. A device group may include controllers, cards, users, access
groups, time zones and weekly schedules. Up to 32 device groups can be created. You
can click the name of a device group to rename it.

m  Read: Privilege to view settings.

m  Write: Privilege to view and change settings. When Write is selected, Read will
automatically be selected.

m  Execute: Privilege to open door, close door and turn off alarm.

For example, if you select Device Group 4 and only select Write, the user will be able to
view and change only the settings of the controllers, cards, users, access groups, time
zones and weekly schedules assigned under Device Group 4.

Optionally select Password error checking to show remaining attempts and wait time for
login errors.

Optionally select Allow Password Removal using ASProfileRestore. You can erase all
user and supervisor accounts by running ASProfileRestore.exe from the software
installation folder.

To edit an existing user, select a user from the user list to display its properties. Or, click the

Search Account button (3] for a quick search. Only supervisors can edit the information of a

system user.
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8.2 Setting up Alert Notifications

When alert conditions occur, the system can automatically send SMS and e-mail alerts to one
or multiple recipients, as well as activating computer alarms.

8.2.1 Setting up SMS Server

Before you can send out SMS alerts, you should configure the SMS server.

1. On the menu bar, click Tools > SMS Server Settings. This dialog box appears.

Short Message Service Configuration g|
SH5 Server
|F &ddress: 127.0.01 Part; G386

[] Send more thah ore sms if content is too lang.

Login

Username: 1

Password: .
Default Mobile Phane
LCountry Code: M obile:

[¥]1. |886 0533234691

[¥]2 |aa6 (0939234897

[¥]a |so6 0939234659

I QK ] ’ Cancel
Figure 8-2

2. Type the IP address of the SMS server, its login username and password. Then assign
up to three mobile numbers, including country code, which SMS alerts should be sent to.
Click OK.

3. To enable the SMS connection, click Tools on the menu bar > Connect to SMS Server.

Note: For ASCII encoding (English language), SMS text messages are limited to 160
characters; for Unicode encoding (other languages), SMS text messages are limited to 70
characters. If you want to send longer text messages, select Send more than one sms if
content is too long. The long messages will be split up to 9 segments and go out as multiple
SMS messages.
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n Other Functions

Before you can send out e-mail alerts or send lost password to an email account, you need to

configure the e-mail server.

On the menu bar, click Tools > Email Server Settings. This dialog box appears.

1.
Mail Configuration
Sender
G ________ =) B v ’T
MName: |-:vc:~
E-Mail Address: |h"f‘"‘-‘ﬂtl@geovision.com.tw
Authentication; AUTH AUTO ~
Usemame: |I-1:H.'L'L' Wiy @geovision.com tw
Password: |""""
Mail Server
Host Name / Address: isnﬂp.oﬁice3€5.com
Secured Connection: STARTTLS ~
Port: I-'f" i |
Misc
Message Priority: MNone it
Test
Send to: | Test
Cancel
Figure 8-3
2.
own server information.
3. To set up your own mail server, configure the following options:
m  Name: Type the sender’s name.
m  E-Mail Address: Type the sender’s e-mail address.
|
m  Host Name/Address: Type the name of the mail server.
|

Select Google or Microsoft to link your email account, or select Others to enter your

Authentication: If your mail server requires authentication for sending e-mails,

select one type of authentication, and type the valid username and password.

Command Port: Keep the default port 25, or modify it to match that of the mail

server.
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m  SSL: Enable the Secure Sockets Layer (SSL) protocol to ensure the security and
privacy of Internet connection. When the option is enabled, the Command Port is
changed to 465.

m  Message Priority: Assign the message a priority so the recipient knows to either look
at it right away (high priority) or read it when time permits (low priority). A high priority
message has an exclamation point next to it. Low priority is indicated by a down
arrow.

m  Send to: Type a valid e-mail address and click the Test button to check if the server
setup is correctly configured.

8.2.3 Setting up Notifications

1. On the menu bar, click Tools > Notifications. This dialog box appears.

Netification Setting H

Herl Approach Eveni Tyoe
[ - Accana Log

Event Message Device Group Tiigger Gale focess Group  Speciic Alam..
Access Granted M Devica Gro... . Al Doara 8l Access Gro.. 0800 13:00

|1 Specic Alam Scheduie

|os00 g4l

Tnggar Approach
Alett Approach
Evert Type:
Access Log [Jirnvokee Siarm [[] Tngger Presst - Camera 1
i |
Evert Message: O
= Trgger Presel - Camera 2
[ Send E-Mai A )
B []5end SMS Aert [l Troger b0
Al Device Groups
i [
Tigger Gate [ Push Motication [15end Report
Al Doars [ Trigger Recordirg
e Sl
5 i Sec(1~300) ["1Run Applcation
Azcaas Group:
e e []Popup Meszags

Figure 8-4

2. Click Add 2 to add an Alert Approach.

3. Define Trigger Approach for under which Event Type, Event Message, Device Group,

Triggered Gate and/or Access Group, the notifications should be sent.

4. Optionally, select Alarm Schedule to send the notifications only during the specified time

period.
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Select Alert Approach for what alert or alarm should be triggered when the defined event
occurs.

You can set up more than one Alert Approach rule, and enable or disable the desired rule

anytime.

[Alert Approach]

Invoke Alarm: Enable a computer alarm when the defined event occurs.

Send E-Mail Alert: If you haven't set up the e-mail server, you will be prompted to set it
up when you click this option. Then the E-Mail setup dialog box appears. Enter the
recipient’s e-mail address and alert subject. You can enter your own content, or use the
buttons on the text window to send out the programmed information. For details, see C.
E-Mail and SMS Alert Symbols in Appendix.

Send SMS Alert: If you haven’t set up the SMS server, you will be prompted to set it up
when you click this option. Then the SMS setup dialog box appears. Ensure the preset
mobile number(s). Select Text Code Type. You can enter your own messages, or use the
buttons on the text window to send out the programmed information. For details, see C.
E-Mail and SMS Alert Symbols in Appendix.

Push Notification: Send push notifications to the GV-Access mobile app when the
defined event occurs. For details, see GV-Access Installation Guide.

Trigger Recording: Enable recording of DVR / NVR / VMS, Video Server or Compact
DVR when the defined event occurs. You can specify the recording time between 1 and
300 seconds. For the function to work, you must activate monitoring on the IP devices
ahead.

Popup Message: An associated live view will pop up for alert when the defined event
occurs. Specify the duration of live view remains on the screen between 1 and 300
seconds.

Trigger Preset: Direct the camera(s) to a preset point, if the camera supports the preset
function, when the defined event occurs.

Trigger 1/O: Enable an associated output when the defined event occurs.

Send Report: Enable to send the reports of lists and logs when the defined event occurs.
For this function to work, you must set up which list and/or log to be sent and how to send
on GV-ASWeb ahead. See 10.6 Setting up Export Schedule for Lists and Logs.

o For the Fire Status (Event Type: System Log > Event Message: Fire Status),
specify the time interval (under Send Report) between each fire alarm to avoid
receiving repeated reports.
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m  Run Application: Specify the Application Path and the designated application will run

when the defined event occurs. Typing a command under Application Parameter can
execute a function of that application.

Note: For text code type, select ASCII for English that is limited to 160 characters and select
Unicode for text of other languages that is limited to 70 characters.

8.3 Startup Settings

To run programs automatically upon Windows or GV-ASManager startup, on the menu bar,
click Tools > Options. This dialog box appears.

Options *

[/] Run &t Startup

[] Run ASManagerService as a Windows Sesvice
Controfler

[ ] Take a snapshot according to the tiggered enfrance or exit

A Statup

|| Remote Montor Serves
[ Web Server
[ GV-GeoFinger Server

[ ] Connect to 5MS Server

Web Server Public IP Address

Addreas | |

Port: |443 |

Carenl

Figure 8-5
m  Run at Startup: Run GV-ASManager at Windows startup.

Run ASManager Service as a Window Service: Under Service Mode, GV-ASManager

can start automatically after system startup and run in the background without logging
into a Windows user account.
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Take a snapshot according to the triggered entrance or exit: If you associate two
cameras to the entrance and exist of a door, respectively, GV-ASManager will take
snapshots of both entrance and exit regardless of which direction is triggered. When the
option is selected, GV-ASManager will only take a snapshot of the triggered entrance or
exit.

[At Startup]

Remote Monitor Server: Enable Remote Monitor Server upon GV-ASManager startup.
The Remote Monitor Server needs to be enabled to utilize GV-ASRemote.

Web Server: Enabled by default, start Web Server upon GV-ASManager startup. The
Web Server needs to be enabled to access GV-ASManager from GV-ASWeb and
GV-Access app.

GV-GeoFinger Server: Enabled by default, start GeoFinger Server upon
GV-ASManager startup. The GeoFinger Server needs to be enabled to enroll fingerprints
remotely through TCP/IP.

Connect to SMS Server: Enable SMS Server upon GV-ASManager startup. The SMS
Server needs to be enabled to receive alert notifications through SMS messages.
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8.4 Setting up GV-GF Fingerprint Readers

GV-ASManager can enroll users’ fingerprints using GV-GF1911 / GV-GF1921 | GV-GF1922
and upload the fingerprint data to the GV-GF Fingerprint Readers installed on the
controllers. To gain access, the user’s fingerprints must match the enrolled ones.

There are two ways to enroll fingerprints: locally and remotely.

For local fingerprint enroliment, a GV-GF1911 / 1921 / 1922 needs to be connected to
GV-ASManager, and the user needs to register his or her fingerprints at the site of
GV-ASManager.

For remote fingerprint enrollment, first enroll empty fingerprints for a user on
GV-ASManager. The user can then go to a connected GV-GF1921 / 1922 at a later time, and
register his or her fingerprints using an assigned card. This function is useful when the user is
not around GV-ASManager.

Note:
1. GV-GF1911/1912/1921 /1922 is only supported in GV-ASManager 4.2.1 or later.

2. For remote fingerprint enroliment through TCP/IP, a separate GV-GF1921 / 1922 is
required to enroll fingerprints. GV-GF1921 /1922 used for fingerprint enroliment cannot
be applied as a fingerprint reader at the same time.

3. The enrolled fingerprints will be saved on the fingerprint reader instead of on
GV-ASManager for remote fingerprint enroliment.

For details on how to enroll fingerprints and how to upload fingerprint data to GV-GF
Fingerprint Reader, see Chapter 3 Fingerprint Only Mode in GV-GF Fingerprint Reader

User’s Manual.
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8.5 Setting up GV-FR Face Recognition Readers

GV-ASManager can synchronize users’ faces enrolled from GV-FR2020 for access control.
The user data is uploaded from GV-ASManager to the assigned face recognition reader for
face enrollment. After enroliment, the user’s face must match the enrolled face to gain

access.

Note:
1. GV-FR2020 is only supported in GV-ASManager 4.4.2 or later.

2. The enrolled face images will be saved both on the face recognition reader and
GV-ASManager.

For details on how to integrate with GV-ASManager for face enroliment, see Chapter 4
Access Control Configurations and Chapter 5 User Management in GV-FR Face Recognition

Reader.
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8.6 Scanning Driver’s Licenses and Business Cards

GV-ASManager can work with SnapShell ID Scanner to let you acquire and edit the
personal data from driver’s licenses and business cards.

Note: This function only supports SnapShell ID Scanner with SDK driver version.

1. Consult the Scanner’s documentation to connect the Scanner with GV-ASManager.
On the menu bar, click Personnel > Users. The User List dialog box appears.

Click the New button. The User Setup dialog box appears.

> W DN

Click the Scan tab. This dialog box appears.

Lizer Setup

General | Home | Business | Liser Define | Featurms | Scon

Feld Value

Usar Samon Lim

First Mame Saman

Middie Mame

Last Nama Lim

o

Gerder Male |

Birthday 1f1f1900 |

Address{Home) ) |
|

Fiie Type
0 Drvver LiCense
Business Card

Extract |

Figure 8-6

5. Inthe File Type field, select Driver License or Business Card. Here we use the Driver

License as the example to demonstrate the following steps.
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6. Place a driver’s license on the Scanner and click Scan. The license image is displayed.

General | Home Huslnasstsel_ﬁellne; Scan |

| Field Yalue A
|
| [0 Name
| [ First Name
[ Last Mame
B
| I sender Femala
| [ Bartheay 1f1/1900
| [ Address
i [ Phone |
il Type
() Buginess Card
P ——
Extract
|
[ ok | [ comel
Figure 8-7

7. Click the Extract button to read the license data. The data is displayed in the Value

column.

8. To modify the data, click the desired Value column and type the next texts. Click
anywhere in the dialog box when you are finished with the modification.

| Goneeal | Home | Busniess | User Defing | Scan |

| Fead

I [ Maree

| [7] First Hame
| [¥] Last bame
| & 1o

i [ Gender

| [¥] Birthday

i [¥] Address

| LI Phone

E 100 100 100 oo
Female
02-01-77

123 NCGRTH STATE 5T

File: Typa
(%) Criver Licerise
(7 Business Card

Figure 8-8

9. Click the Update button. This driver’s license is saved to the GV-ASManager’s database.

10. Now you can click the Home tab to view the information of the driver’s license, or click the

Business tab to view the information of the business card if scanned.
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8.7 Defining Hot Keys

You can assign hot keys to quickly control doors, lanes and trigger output devices.

1. Onthe menu bar, click Tools > Hotkey Settings. This dialog box appears.

Device Hotkey x

Device | Hothey |
[=] &l DESKTOP-74A5KLR

-
— @ Lock Down

= [EI] Force Lock

— @] Force Unlock

— & Disable Docr Lock Operation

— [ Clear All Events

—H Default

l'E Eﬂ MNew Device Group_1

Device Hothey
Hotkey for the selected command:
F1 Clear
List of hothkeys: ~ Assign
Hotkey cumently used by:
Figure 8-9

2. Under Device, select a host, a controller, a door, a lane, or an output and select the
command, e.g. Unlock Door, you want to assign a hot key.

3. Select a hot key from the List of hotkeys drop-down list and click Assign.
4. Click OK.
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8.8 Using Remote Lock Down App

The Remote Lock Down App allows a security personnel to quickly lock down or force unlock
all the doors of multiple GV-ASManager systems connected to the app. Up to 255
GV-ASManager systems can be supported.

Note: Remote Lock Down App is only supported by GV-AS1010/1110/210/2110/ 2120/
410/4110/810/8110/ 1620 with GV-ASManager V4.2.3 or later.

The Remote Lock Down App can be downloaded from the GeoVision website. Go to the
Download Page of GV-ASManager. Select Utility in the drop-down list and click the

Download icon A of GV-LockDownApp.
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Running Remote Lock Down APP

1.
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On the menu bar of GV-ASManager, click Tools > Servers > Remote Monitor Server.

When the server is started, the icon = appears at the bottom-right of the main screen.

Run Remote Lock Down App. The LockDownApp window appears.

To connect to GV-ASManager, click the Add Host button =5, This dialog box appears.

Add Host @
Hostname: AsManager_Taipeiofice
Address: 192,168.0.25
Pork: 99a7
10 admin
Passward: senes
Ik ] [ Cancel
Figure 8-10

Type a Hostname to identify the GV-ASManager, and type its IP Address, Port, ID and
Password.

Click OK. The GV-ASManager and its controllers are now listed.
To add more GV-ASManager systems, repeat above steps.

To lock down the doors of all connected GV-ASManager, click the Lock Down button
BT The doors that are locked down are now highlighted in red.

g LockDownspp ;.@
A
v
Lock Dawn Force Urlock: Filter Add Hast..
=58 TEST198-PC
'@ Caontraller 1

Figure 8-11
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8. To force the doors of all connected GV-ASManager to unlock, click the Force Unlock

button ﬂ The unlocked doors are highlighted in green.

T e =T

"o | o [IE

Lock Diown Foies Urlock Fiter Add Host..

=) TEST180-PC
-8 Controller 1
[ Docrl
[ Door2
|—E|--@ Controller3
[ Daerl

Figure 8-12

9. To see doors that have not been locked down due to disconnection, click the Filter

button 4~ > Unlock. To see doors that have not been forced open due to
disconnection, select Lock.

=7 Luckl:l‘uwn.hpp |?m@
Lock Dawn Forze Urlock. s Unlnc.k #L.
o lock
:...r;g TEST133-PC :
Figure 8-13

If you want to cancel the lock down for a single GV-ASManager, on the GV-ASManager,
right-click the server / controller in the following Controller view window, and select Release

Door Operation.

16x16 w
Controller Status Alarm Forced Open  Duress ]
~ ) DESKTOP-T4ASKLR .
v &4 Default
= @ Controller 1

B 1: Do Unlock Door

Bl 2 Do Lock Down

E 3: Dot Force Unlock

] 4: Dot
Fi
h E 1: AS orce Lock

EEASZ I Release Door Cperation I

3: A5
Pl Clear All Events

B3] 4: AS:

&) 5 AS: Reset Anti-passback ’

Figure 8-14
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8.9 Defining New Card Formats

By default, GV-ASManager only recognizes access cards of certain bit formats that have
been pre-defined. To use cards with other data formats, you will need to define the card
format for GV-ASManager to recognize it.

1. Onthe menu bar, click Tools > Code Format Settings. The pre-defined card formats

are listed.
Customize Card Dialog
Customized Cerd List:
Card Name Card Bits Facility Bis Cardlo Bitz Parity Bitz
Wiegand26 26 8 16 2
HiD3z 3z 6 16 1]
Geodd k) 6 16 2
HID33 35 12 20 3
HIDa7 7 16 19 2
Geobd B4 ] 54 ]
Figure 8-15

2. To define a new card format, click the New button. This dialog box appears.

Customize Card Setting |5_—(|
Sekct Card Biks: w OF, Cancal
Card Narne:

Canel Bit Penly
R i
_5 =

a [ s

23

22

|

= |
13

2 FeEcude:
16

15

14

i

12 | Add

1

i

El

2

T

B

5

4

3

2 Card humize

1

o

Add -
]
Figure 8-16

3. Next to Select Card Bits, select the card bit.

4. For each number under Card Bit, define whether it is Parity, Facility Code or Card
Number by clicking the Add button. The exact steps to defining card format vary from
card format to card format.

5.  When you are done, click OK.
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8.10 Monitoring Emergency Exits with Input Sensors

If there are emergency exits on premises that must always remain closed, you can connect

the exits to the input sensors on GV-AS Controller and monitor them using the functions

below.

¢ Monitor the status of input devices on the Controller view window

e Assign up to two cameras to an input device to capture snapshots upon input trigger

Note that these functions are only supported by the following GV-AS Controllers.

Models Supported Firmware Number of Inputs Supported
GV-AS210/2110/ 2120 V1.3 or later 8
GV-AS410/4110/810/ 8110 V1.3 or later 16
GV-AS2120 V1.35 or later 16
To set up:

1. Onthe Web interface of controller, make sure the input is set to Normal Input. You can

modify the input name if needed.

Input Configuration

° Uisi
Ision:
Geo S 0 Input Function
A2310_IN1 - - i -
Basic Setting 01 ] o] Menrnal Inpat tch Diisakle

* Network Setting 02 A%B10_IN2 MO - Dioor 1 +  Exit Button -
¢ Other Setting 03 ASB10_IN3 NO o« Doz 2 v DoorContact v
* Firmware Update 04 A8810_IN4 NO - Door 2 v FxitButon v

* Account Setting
05 ASB10_INS NO - Dioor 3 * Door Contart ~

Advanced Setting
e Function Setting 06 ASB10_ING NO ~ Doord v EuitButon v
* Parameter Part1 07 ASB10_INT NO - Door 4 v DoorContact ™
* Parameter Part2 08 ASE10_INS NO - Door + EyitButton -
+ Parameter Part3 09 AS310_IND o - Door ® | owvemm—

¢ Parameter Partd
) A 10 ARBI0_IN1O0 NO - Docr 5 ~ it Bution -

* Time Setting
« | Input Setting 11 A3B10_IN11 NO - Deor & ~ DoorComtact =
¢ QOutput1-16 12 ABB10_IN12 NO ~ Door & v FExitButen v
Figure 8-17

2. In GV-ASManager, right-click the controller in the Controller view window and click

Settings.
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3. Click Input.

Controller Setup

hput
M Seftings
Controller Setup — AS2120_INT
| Doorl . e
7 Door? _] AS2120_IN1
| Door3 ] A52120_IN2
' ] A52120_IN3
Door 4 . .
0 sz Ded
7] AS2120_IN5 |C | Secil™&D)
[ 452120 N8 |
7] ASZ120_IN7 Camera 2 ;
"] AS2120_IN8 None
Delayed snapshot:
[0 |sectosn)
Figure 8-18

4. On the left pane, select input devices to monitor their status in the Controller view

window (Figure 8-19).

5.  On the right pane, use the drop-down list to assign up to two cameras to the input. You

can enable Delayed snapshot by typing the number of seconds to delay capturing a

snapshot after the input is triggered. For example, if the camera is installed 10 meters

away from the emergency exit and it takes 5 seconds for a user to walk pass the camera

after triggering the input, you can delay the snapshot for 5 seconds.

6. Click OK.

The inputs will now be listed in the Controller view window (left in Figure 8-19), and the input

status will change to “Active” when the emergency exit is opened, triggering the input. The

event will also be shown in the Event Monitor.
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Controller Status : % Event Monitor |
~ B RDTESTPC-PC f
- & A0 Y &8
[ 1:Doorl G Mads Message Door / Input
D 2: Door 2 Card Mode
@ 2:Doer3 Card Mode Input Status: Mormal Input 01
O 4:Door4 Card Mode Input Status: Active Input 01 |
[ 5: Door5 Card Mode Input Status: Mormal Input 01
[ 6 Doorb Card Mode &P Input Status: Active Input &1
[ 7:Door7 Card Mode ﬂ L
& =i Input Status: Mormal Input 01
1: AS810_INOL Active | P Reset IR
T RSEI0 e ﬂDnﬂr_-"Gate Unlock A
Figure 8-19
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8.11 Designing and Printing Access Card Template

You can design a card template for your access cards by adding text and images. The text
and images in the template can be linked to the users’ personal information (ex: user’s last
name) and photo in the user database.

1. On the menu bar, click Personnel > Users. The User List window appears.

2. Click the Design Card Template button on the toolbar. This dialog box appears.

[’ Untitled - Design Card Template EI@
File Edit Page Setup Component  Layout
O H & 8|0 HE @ T m
Ready MUk
Figure 8-20

3. Click the New button D to create a new template.

Tip: If you do not want to design a template from scratch, click File > Template Sample to
use the template sample.
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4. To set the orientation and margins of the card template, click Panel > Settings.

[t =)
Layout Grid size
- Width ]‘é—‘
 Portrait Height fﬁ—
Marginis — i
Left |u— Right ]1}—
Top ]} Bottom l[.‘i
oK | Cancel J
—
Figure 8-21

5. To add an image such as a background picture, user photo, or company logo, follow the

steps below.

a. Click the Image button and drag to define the size and location of the image.
b. Right-click the image > Properties. This dialog box appears.

Image Properties

Mame
Background color
* |mage path

" Data link

S0
[EcEsES __J
| -
F’h-:-lo __J
QK | Cancel I

Figure 8-22

Adjust the background color if needed.

of each user, select Data link.

Click OK.
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a. Click the Text button or the Barcode button , and drag to define the size
and location of the box.

b. Right-click the textbox or barcode, and select Properties. This dialog box appears.

f.

' N
Text Properties LJﬁ Barcode Properties @
Mame ]TEXT Mame
Background color || _J Background eolor |31FFFFFF
€ Statictex [Text Foregiound colar |#000000
' Data ik [First Name =l & Stalic text [BARCODE
bt 158908 L J " Data link |User J
Higrhatmed ILEﬂ ﬂ Encode type |C0d839 ﬂ
R ]TOD L] Barcode height 1 -
Spacing ID
Barcode width 1 -
[ Border .
Fort size 2 -
oK | Cancel K | Cancel
Text Properties Barcode Properties
Figure 8-23

Adjust the background color, font, alignment, spacing and border if needed.

To add fixed text, select Static text and type the text. To insert the user information

of each user, select Data link and select a field from the user profile (ex: Last

name).

For barcode, you may need to adjust the Encode type according to the type of
barcode you are using.

Click OK.

The following tools are available to help you align the images and text boxes:

Select the multiple items, click Layout and select one of these options: Align left,

Align right, Align top, Align bottom, Make same size.

Click the Show Grid button and Snap to Grid button . You can adjust the

size of the grid by clicking Panel and then select Settings.
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8. Click File and Save to save the template.

[ Unkitled - Design Card Templake == )

File Edit Page Setup Component  Lawout

DR E|4 =8 e & | mETm

[User]
[Department]
[Employes 1D

|Phone(Business))

geoson I

EARCODE

Ready [ INOM y

Figure 8-24

9. To preview the template with actual user information and photo, select one or more users
in the user list, right-click, select Print and select Print Preview and Setup.

10. To print the cards, select one or more users in the user list, right-click, select Print and
select Print Cards.

-
& User List

-

H=": - i 1
— s

Print Design Print Ternplate

o]

I3

o & [ c®

New Edit Delete Import  Export User Define Fields Setting

Search by [.NJ '] Filter View

User Employee ID Department Job Title ext Mobile Birthday
£ Waddams M
£ 8. Porter

£ Tom Smiylowski
S gun

By | New
Edit
Delete

Refresh

Import 2
Export 3

Print 3 Print Cards

Design Print Template Print Preview and Setup

User Define Fields Setting

Refresh

Figure 8-25

*
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Note: You can remotely print access cards through GV-ASWeb. Refer to Chapter 10
GV-ASWeb to see how GV-ASWeb works.

1. Right-click a user account, select Print Card > Print to remote printer.

| rl,:.._ﬁ User List

(3 New " Edit (&) Delete =l User Defined Figlds

User User Type Company Employee ID Job Title Division
1 HASSAN SARAH MAHAMUD  Mormal 0695 OPERATIONS A...
2 MOHAMED SAADA ABDUL... Normal 0686 SENIOR RELETI...
3 KHATIB REHEMA KASSIM Mormal 0630 RELATIONSHIP __.
4 MAKOHA BENARD KUNDU MNormal 0421 PLUMBER
5 ABDULLE FATHI DEKOIA! Marmal 0367 MARKETING OF...
6 NJUGUNA ANTOMNY L 0345 FINANCIAL REP...

BB ABDULLE FATHIDEKOW

7 DAJISSA FATUMA 0145 ADMINISTRATIY...
2 HUSSEIN ZAINABU P 4 Card Template Setup CREDIT ADMINIS...
9 TABULO JASMIN MBOTO Normal Download Card Image SENIOR RELATI...

10 NAZIR ANDLIP MOHAMED MNormal MANAGER TRE. .

Print to remote printer

Figure 8-26

2. If you would like to change the printing preferences for printing access cards on
GV-ASWeb, you must modify the printer default settings from your local computer.
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8.12 Utilizing Job Codes

Using the function keys on GV-AS1010, an employee with multiple types of jobs can specify
the start and the end of each type of job by entering different job codes on GV-AS1010.
Follow the steps below to set up.

1. On the menu bar, click Setup > Devices. The Devices dialog box appears.

2. Select a Controller and click the Job Code button E .

{gﬁ Devices [Controller: 10 ports (4 free ports included), GV-Patrol: 0 ports]
0= @O%Lﬁ:’lzzﬁlﬁﬂ
Device Group Default
Default Device D Model
New Device Group_1 = ﬁl Controller
O N T
- LPR
i -@ 10Box
- %% Camera
Figure 8-27
3. Select a checkbox, and type the Job Code and Description.
lob Code Settings @
D Job Code Diezcription
1 1000 Cleaning
2 1001 Front Desk
3 1002 Parking
O
O
5]
O
Figure 8-28
4. Click OK.

5. On the Web interface of GV-AS1010, set two function keys to Job Code (Start) and Job
Code (End).

Advanced Setting Function Key Configuration

Function Configuration

Function Function Authenticate
Parameter Configuration Key
Card Information F2 Work Time (End) v | M

Time Configuration

F3 Job code (Start) v | [
Input Configuration

Function Key Configuration Job code (End) v~ | [

Extended Device m Cancel

Figure 8-29

iyl
£
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Employee A has a 9:00 to 17:00 workday, but the workday consists of two job codes:

Cleaning from 9 am to noon and being a front desk receptionist from 1 pm to 5 pm.

TA shift settings Job Code Settings @
Name: Weekday 10 Job Code Dezcription
Start Time: a-:00 5] o1 1000 Cleaning
S o2 1001 Front Desk
End Time: 17:00 &
Figure 8-30

To differentiate the two jobs in the records, employee A enters different job codes on the
GV-AS1010 reader at the start and end of each job.

Time Operation on GV-AS1010 Explanation

9:00 F1 key > Swipe Card Work Time (Start)

9:00 F3 key > 1000 > Swipe Card Job Code (Start) for Cleaning
12:00 F4 key > 1000 > Swipe Card Job Code (End) for Cleaning
13:00 F3 key > 1001 > Swipe Card Job Code (Start) for Front Desk
17:00 F4 key > 1001 > Swipe Card Job Code (End) for Front Desk
17:00 F2 key > Swipe Card Work Time (End)

You can look up the records in TA Report of GV-TAWeb using Job Code and Job Code

Summary. See Chapter 11 GV-TAWeb for details.

{E] 7A Report
Report Template
@ &5 All Templates

_'| Payrall List

."5 Pavyroll Summary

£

Title

=5 Scheduls Templates
[&5 Employee Schedule
_| Unscheduled Employes
=5 Time Templates
[E] Daily Time Card
[ Employee Time Card
| Time Card List
\adh Average Hour Summary
\ah Exception Summary
= (5] Payrofl Templates

[ Employee Payroll

= =5 Jok Code Templates
[=] Jok Code
=__.-i Job Code Summary

Page 1of1

=i
ching reports by the fitle 2

Templais

L]

Mg data to display

Figure 8-31
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Job Code shows the punch-in and punch-out time of the different job codes.

=| 1ob Code =
H Save u Run E}Expor‘t =
Date Job Code Mame Division Department Job Title Employee 1D Punch In Time Punch Out Time
1 20160727 (W) [1000] Job Code - Clean a 0000010 08:00:28 & 12:05:52 &
2 201607727 (W) [1001] Job Code - Front Desk a 0000010 13:00:02 & 17:05:18 &

Displaying 1- 2 of 2

Page 1 of 1 .@‘
Figure 8-32
Job Code Summary shows the total work hours of different job codes.
=] Job Code Summary (=
H Save n Run EExpon %
Job Code Name Division Department Job Title Emplayee 1D Wiork Time
1 [1000] Job Code - Clean a 0000010 03:05:26
2 [1001] Job Code - Front Desk a 0000010 04:05:16
< >
Page 1 of 1 = Displaying 1- 2 of 2
Figure 8-33
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8.13 Defining Occupancy Limit

You can define the occupancy limit of an area to trigger a highlight on the screen of
GV-ASManager for alert when the specified number of users within the area has been
reached.

Note: The function is only supported by GV-AS210/2110/2120/410/4110/810/ 8110
firmware V2.41, GV-AS1620 firmware V1.05, GV-CS1320 firmware V3.10 and later versions
of these products.

To define the Area of a door:
1. Onthe menu bar, click Setup > Areas. The Area Settings dialog box appears.

2. Select a Door and define its belonging area by specifying Enter to and Exit From.
Enter to is the area where a user enters by accessing the Entrance reader of the door,
and Exit from is the area where the user is from.

To set up Occupancy Limit:

3. Set up the following functions. When the set thresholds are reached, the area will be
highlighted on the screen of GV-ASManager for alert.

m  Occupancy Limit (Cards): Specify the maximum number of users allowed to stay in
an area for alert.

m  Area Card Warning: Specify the number of users already entered for pre-alert.

B4 Area Settings >
=t =1
:E | - [+] Oceupancy Limit (Cards):
Area Occup... Area Card Waming
B Global Area
Area 1 3
%Eeveﬂor = {é efauft
= [] Controler 1

Bl Door 1 goes from Global Area to Area 7

Door 2 goes from Global Area to Global Area

Door 3 goes from Global Area to Global Area

Door 4 goes from Global Area to Global Area
*@ Mew Device Group_1

Figure 8-34

113



Q GeoUision:

To set up Door Contact:

For GV-ASManager to tell the location of a user, it is required to set up a door contact sensor
for the door to detect if it is open. To define the door contact sensor, go to the Web interface

of controller > Input Configuration.

Input Configuration

Input Function

01 AS2M20_IN1 | ] v‘ ‘ Door 1 v‘ ‘ Doar Contact v‘

Figure 8-35

To monitor an Area:

When the number of users entered has reached the pre-alert threshold (Area Card Warning),
the area will be highlighted in orange as below. In this case, the number for pre-alert is set to
2. When 2 users have entered the Area 1, the orange highlight will be displayed.

': |ﬂ Access Monitor 35 Area Monitor |
T
|| Location Status
@ DESKTOP-T4ASKLR (3) ———————————— =
Global Area | 1 =:0
|l Area B =:0
Elevator B B:o =0
Figure 8-36

When the number of users entered has reached the Occupancy Limit, the area will be
highlighted in red as below. In this case, the limit is to only allow 3 users to enter the Area 1.

3| Access Monitor [ Area Monitor |
Y
Location Status
DESKTOP-T4ASKIR (3) ———— =

Global Area E:0 B:0 =:0

a5 :3 TF:373 =0
Elevator B:0 B0 =0

Figure 8-37
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When users exit an area by accessing its Exit reader, the number of users in the area will
decrease accordingly and where users go will be indicated. In this case, 3 users exit from
Area 1 and enter to Global Area.

ﬂ Access Monitor @ Area Monitor |

Y

Location Status
————————— ¥ DESKTOP-T4ASKIR (3} ————————— =
Global Area B B:: =:0

Area 1 B:0 B:03 =:0
Elevator B:0 B:0 =:0

Figure 8-38

Note: In the following example, 0/3 indicates that the area has an occupancy limit of 3 users
and no one is in the area now.

4

EE— — —_—
Area 1 1 0 : 03 E:0

Figure 8-39
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Chapter 9 GV-ASRemote

The client software GV-ASRemote is designed to monitor multiple GV-ASManager systems
over a network. GV-ASRemote provides the following features:

e Remote monitoring
e Remote live view and playback
¢ Remote control: stop alarms and force the door to lock/unlock

e Remote access to Access Log and LPR Log

9.1 Installing GV-ASRemote

Visit the Download Page of GV-ASManager. Select Primary Applications, click the

Download icon & of GV-ASManager, follow on-screen instructions to complete the
installation.
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n GV-ASRemote

9.2 The GV-ASRemote Window

&% ASRemons - m} 4
o—— File Monitoring View Language Teols Window  Helg
O mrnzsEoeHE 00 _
Controllers 3 X || &ILPR Monttar |ﬂf ficcess Morizar | Ay Alarm Moriitor |EE] Event Monitor 4 b % | Live Video 3 X|
o m 2 2 | B
tisis | & F |8 BB 5] LPR Monitar [pen [z ] | ] 4ceme Mot S ||E [ | | |[iCamem § B R 2
| Controlier Status v B Y E | 7
v B Gv-a5210 " =
; s Meszage lan Door
B 1 Doar Cord
B 2 Doar2 Wb piate Recognized: Registersd Vehicle Lz Door
Bl 3 Docr3 Door
Bl % Docrs = Hecogn Jooe
B % Doord P late Recognized: Linregiste ek 0
Bl & Doord Card W Plate Recognized: Registersd Vshicle Lz oor
Bl 7 Door 7 Card @ Piate Recognized: Registerad Vehicle Lz par - |
Bl & Dooi 2 Card ol || Playback x|
1: ASZ10_INT 2 |
1 Came=n 1 {
2 AS210_IN2 |
3 ASZ10_IN3 v
< >
LPRs a X
Pt < & F |8 AE 7
Status »
\ I3 L4 3
| 0 13 Lists | Tdes | Thumbnails Lists | Til=s | Thumbnails
. 5 LRt
B 1 Lanet B fvent Marit & T8 | A Aterm Motz B R
A Zlane? = Cal = | E= &
) = g v ES
B 3 lane3 Ha &3
‘-51_' A Laned Message Doar Message Door
B 5 Lane 5
| 10Bax= X
e =& @B SES
| 1080x Statuz
13 TESTIS6-PC
6—-:.""”“ X
» A LPR1 A =
» B cemeral AL
B [ R Info |
i)
' Camera
- [@ czma
2 1: Camera | < 3 c 3 Camera Camera 1
-3 R e - —— : - 1 b
2% 1: Camera 1 | Lists | Tites | Thumbnails Lists | Tiles | Thumbnails |
—— ¢ < >
Ready 1172532015 2:21:03 PM
Figure 9-1
No. | Name Function

The Menu Bar includes the options of File (log in / out
GV-ASManager), Monitoring (display monitoring windows),
View (display the function windows) and Window (arrange
the display of different windows).

1 Menu Bar

> | Toolbar The Toolbar includes the options of various monitoring
windows and Web Browser (open GV-ASRemoteWeb).

The Windows Toolbar includes the options of Connect,
Disconnect, Auto Connect, Add Host, Remove Host,

3 | Windows Toolbar Settings and Resolution. You can change the size of icons
to 16 x 16, 24 x 24 or 32 x 32 from the drop-down list. For
details, see 9.2.2 Windows Toolbar.
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Controller / LPR / 1/O

Displays a list of connected controllers / LPR devices / /10

4
boxes View boxes and their current status.
5 | Camera List Displays a list of connected cameras.
. . Displays live views of one connected camera. For details,

6 Live View , . , . )
see the same operations in 5.2 Accessing Live View.
Plays back recorded events from a compatible GeoVision IP

7 Playback device. For details, see the same operations in 5.5
Retrieving Recorded Video.

8 MultiView DlsPIays live V|ew.s of connected came.re}s fron.1 multiple 1P
devices. For details, see 5.4 The MultiView Window.

9 Information Window Displays the information of doors, card readers and

monitored events.

9.2.1 Windows Toolbar

90 0000

| 1816 | & & |[B) & &
Figure 9-2
No. | Name Function
1 | Connect Starts the connection with GV-ASManager.
2 | Disconnect Ends the connection with GV-ASManager.
3 | Auto Connect Retries to build the connection with GV-ASManager.
4 | Add Host Adds a GV-ASManager host to the list.
5 | Remove Host Deletes a GV-ASManager host on the list.
6 | Settings Edits the settings of GV-ASManager hosts.
7 | Resolution Changes the size of icons to 16 x 16, 24 x 24 or 32 x 32.
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9.3 Connecting to GV-ASManager

Before GV-ASRemote can connect to a GV-ASManager system, the GV-ASManager must

allow remote access:

e Click Tools on the menu bar > Servers > Remote Monitor Server. \When the server is

started, the icon

|

appears at the bottom-right of the main screen.

To create a GV-ASManager host and enable connection:

1. On the toolbar, click the Add Host button. This dialog box appears.

Add Host

Hosthame:
Address:
Part:

10:
Pazzword:

Cantraller

gl Testl

Test
127.0.01
5387

1

1

3

Add...

Figure 9-3

2. Name the host, type the IP address of GV-ASManager’, modify the port number if

necessary, and type its login credentials.

3. Click Add. This dialog box appears.

Add Controller

0K

Figure 9-4

4. Type the ID of the controller associated with the GV-ASManager and click OK.

5. To add more controllers, repeat Steps 3-4.
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6. Click OK and return to the main screen. A host folder will be displayed on the Controller

View window as example below.

Controllers X
16 v
Controller Status Alarm
v ¥ TEST198-PC
* @ Controller 1
[J Front Door Card or Common Mode
) Back Door Card Mode
[] Manufacturing Door Card and PIN Code Mode
[ Emergency Door Releass Mode
Figure 9-5

If the icon 2 appears, it indicates the connection between GV-ASManager and

GV-ASRemote has been established.

If the icon = appears, it indicates the connection failed. Make sure GV-ASManager is

enabled for the Remote Monitor Server function.

Note: For the disconnection messages displayed on the Status column, see Appendix D.

Controller Status.
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9.4 GV-ASRemoteWeb

GV-ASRemoteWeb enables remote access to Access Log and LPR Log of multiple
GV-ASManager systems over a network.

1. To open GV-ASRemote, click the Web Browser button @ on the toolbar. This dialogue
box appears.

@r_u:exs Log S0 LenLog S Optioce~
i

LPR Log

T = View Medew | [
Host - Message Lane Local Time License Pats Hotlet Group:
Host: o .
Data size (sach hostk | 20 *
| Log
Messags: Parking &ccess Denig ™
Lans:
Arez;
Drection:  InfOut it
Stay tme from;
o
Parking Lot:
Hotlst Group:
Date Pariod: Today =
Start Date!

End Data:

= | vehide

Fuzzy Matdiing
Recognzed Pats:

License Pite;

Prge 1|of 1 [ Ha data to deply

Figure 9-6
2. Select a log you want to view on the top-right corner.

3. Select a connected host from Host and the number of logs from Data size to display in
the search results.

4. Set the search criteria. For example, you can use the Message drop-down list to search
the records that match the conditions of “Parking Access Denied”.

5. Click the Search button to start the log search.
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Chapter 10 GV-ASWeb

GV-ASWeb allows you to access data and settings of GV-ASManager over a network using a
Web browser. You can remotely watch live video, access logs, and configure system settings
using Web interfaces.

10.1 Connecting to GV-ASManager

Before GV-ASWeb can connect to one GV-ASManager, the GV-ASManager must be set to

allow remote access:

¢ On the menu bar, click Tools > Servers > Web Server. This dialog box appears.

GeoWebServer Setting Dialog X

I I
7 a1 v 443
HTTP Port ! HTTPS Port |
{ Takes effect after you restat WebServer. }

IP Filter
Rule From IP ToIP

Add Delete

Figure 10-1
To grant or deny access of certain IP addresses, click Add, and type the IP addresses.

Otherwise click OK to start the connection. When the server is started, the icon
appears at the bottom-right of the main screen.
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To start GV-ASWeb:

1. There are two ways to link to GV-ASWeb:

B cv-asweb

. Under the device list, right-click the host PC >ASWeb or ASWeb with SSL.

gﬂ ASManager

Dicable Door Lock Operation

Reset Anti-passback

File Monitoiing  Yiew Setup  Perzonnel  Language Tools Window Help
JdaFERcREE Al 2=0s0
| Cortrallers 2%
[1ads  ~]
Contraller Status Alarm Forced Open  Duress Tarnper Fire Alarm
~ B TESTI98-PC
v & Controller1 Unlock Daor
B 1 Doerl Card Mode Lock Down
B 2 Doorz Card Mode Earce Haloek
[ 2 Door3 Card Mode Eoiceloek

ASWeb [httpy//localhost/ ASINeb/)
ASWeb with S5L (httpsy//localhost/ASWeb,)

Figure 10-2

e« Open an Internet browser, and type the IP address of GV-ASManager to be

connected. This web page appears.

CeoWehSerer w

« c

@ 127.00.9:81

al

ASWeb

Accass & Sacurily

Management

2.  Optionally click https:/l for SSL encrypted connection.
3. Enter the login credentials. The GV-ASWeb page appears.

Q GeoUision

TAWeD VMWeb
Tims and Altandance Visitor Managamant
Managament

Figure 10-3

o]
-

L™

Visitor
Visilor Registration

Note: To change the Ul theme, click the icon on the top right of the login page (Figure

10-3) and select Dark or Light.
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10.2 Functions on GV-ASWeb

& ASWeb

x

e C @® 127.00.1:81/A5Web/ASWeb.srf

N/

~7

Device Group

Controller List

TOBOX List

s,

Camera List

]
H 1]
i

Area Settings
| . i
¥

Feature
Access

an

Patrol Tour

%

Map

Operator
Account

Notification
Setting

T/
Code Format
Settings

Dpﬁo-ns

i3]

Live Video

Card List

Vehide List

User List

Monitor

Figure 10-4

a¢
J!;Ecess Log
=

Dai.ly Access

A

Al;am'u Log

=i

=
o —

Event Log

I10Box Log

fial

&

User Action
Log

You can access the following functions by clicking icons on the Web interface or selecting

them from the menu ;5.—_-.;

on the bottom-left corner.

Name Details

Monitor Remotely monitor GV-ASManager. See 70.3
Monitoring GV-ASManager.

Live Video Remotely watch live view of a camera connected to

GV-ASManager. Note that live view will be displayed
with MJPEG codec and a frame rate of 5 fps.

Device Group
Controller List
LPR List

IO Box List
Camera List
Area Settings

5.1 Mapping Cameras

Remotely set up the mentioned functions, also
available on the host PC.

Also see:

Adding Controllers
13.2 Adding PC LPR
4.7 Adding I/O Boxes
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Feature Access

. 6.3.2 Configuring Areas

Patrol Tour . 14.3 Managing Face Recognition Access Data
Map * 7.1 Creating Patrol Tour
. 10.5 Creating Maps
Tip: You can right-click a door and select Accessible
Card or Accessible User to see the cards and users
that are granted access to the door.
Card List Remotely set up the mentioned functions, also
User List available on the host PC.
Vehicle List Also see:

* 4.3 Adding Cards
. 4.6 Adding Users

Note: Batch and Import/Export functions are not
supported in the Card List of GV-ASWeb.

Access Log, Daily Access,
Alarm Log, Event Log

10 Box Log, 10 Log

LPR Log, Patrol Log

System Log, User Action Log

Remotely access the mentioned logs, also available on
the host PC.

Also see:

. 10.4 Accessing Logs.

Operator Account
Short Message Service
Configuration

Mail Configuration
Notification Settings
Code Format Settings
Export Schedule
Options

Remotely access the mentioned functions, also

available on the host PC.

Also see:

* 8.1 Adding System Users

e 821 Setting up SMS Server

e 822 Setting up E-Mail Server

*  8.2.3 Setting up Notifications

e 8.9 Defining New Card Formats

. 10.6 Setting up Export Schedule for Lists and
Logs.

* 8.3 Startup Settings

Note: Any changes made on GV-ASWeb will be reflected in GV-ASManager.
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10.3 Monitoring GV-ASManager

You can use GV-ASWeb to remotely monitor controller status, control doors / lanes, areas,
and watch the following logs updating in real time: Access Log, Alarm Log, Event Log, LPR
Log and Patrol Log.

1.  On GV-ASWeb, select Monitor. The Monitor window appears.

2. To control doors / lanes, right-click the controller or LPR in the device list. The options
available are similar to those on GV-ASManager. For details, see 3.2.1 Controls on the
Window.

=] -
= Menitor

Device “«
Name Status Alarm
4 7] Controller

a @ Controller 1

Unlock Door
Door 1 Card Mode
Door 2 Card Mode Declie
Door 3 Card Mode Force Unlock
Door 4 Card Mode Force Lock

Disable Door Leck Operation

Clear All Events

Reconnect

Sync Controller

Settings...

Figure 10-5

3. Click Monitor in the upper-right corner to select logs and functions to display. Activities
will appear in real time without refreshing the page.

4s2] Monitor -loix
oo o«
Dewvice ) | Aceesslog ®| Alermleg Event Log * || PR Lng [#] Access Log »
Name Statua Alarm View Mode» [ O Frkovmukion W] Adsrmlog =
4 §) Goniroler Messs Daar  input Local Tim: [l st Log
e u ocal Time
4L, contraler ) ’ : Door F= Pairol Tour Monsar b
i DoariGate Unlock Controler 1-Da 1232015229 = i
8 Doar 1 Card Mode = 8
1- ZN2015 22 = r
] ooor 2 Force Unlook iode Doar Dpen Controler 1-Do... 1123201 g e | ©Box Log
& 3 Door!Gate Unlock Controler 1- Do N2N20152.29 =
5 Deer 3 Card Mode | = E
. DooriGate Lock Controfer 1-Do...  1/2ZA2015 229 /1 LFR Log
E) poor 4 Card Mode 2
boor Close Controfier 1-Do... NZM2015220 meeribumtas 2 Perkinghargar b
Force Unlock Remately Controler 1-Do.. 1232015229 -
Syztem Log

Local Anti-passback:
Global Anti-passback
Two-Person Rule {Entranc
Two-Person Rule (Exit):
Reader's Keypad (Entranc
Reader's Keypad (Exit):  [§13 New Map Monitor

|
0] userActon Log
7] Locate Peopie
|

Area Monitor

GaoFinger (Entranca) Mo
GeoFinger (Exit) Mo
] m v | Time Clock: Mo

Figure 10-6
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To see a pop-up map of the associated device upon an alarm event, click Options in the

upper-right corner > Map (Alarm). Up to 6 pop-up events can be shown at a time. For

details on how to set up the map, see 10.5 Creating Maps.

*Accesslog = *lamieg =| *Eventieg LPflog ® | Map Monitor *
[
T I o
Map  Satsiine " b Bentlay Tapel
&

B2 Map ( Alamu: 5/22/2016 1
2 Map { Alami: 5/22/2016 10:56:
85 Map [ Alar: 5/22/2016 10:58:58 PM §
®3 Map [ Alsom: 5/22/2016 10:50:03 PH )
@5 Map ( Alarm: 5/22/2016 10:59:08 PH )

=5 -

Access Denbed
Eest-1010- Door 1
5f22/2016 10:59:08 PM

Figure 10-7

Wondors veew
& Map o)

Tnformation =
G- AB O
Door
Name Door 1
1D: 1
S Attributes
P —
J.i:If:.Au\')pr.:?ﬂﬁ = Laocal alnti-lpassbank Na
= B Global Artl-paseshack: Mo
“ ||| Two-Person Ruie I
S Enfranca) o
= [Enirance]
La " Two-Person Aule (Exity No
= E| Rerders Keypad Yoz
— =% || [Entrance]
|| Readers Keypad (Exil} Yes
= B = eoFinger [Enfrance): Mo
reaFinger [Exit) Mo
ime Clack: ‘es (Using TA Functicn Hey)
£ Lule Check Out ;
Enfrance) fo
o [jute Check Out (Exlt) Ko
‘eleaze By Card Mo
sarlock Mo
bty | Lock Resal Tima & sec(s)
jF | pek Resat Time .
¥ Handicap Card) Gisecls)
teld Open Tims. 10 =ec(s)
= [eld Open Time RN
Handicap Cardy 10.5ecls)
ook Card Time sacl
Snirance] 0 secfs)
pek Card Time (Exity 0 =secis) =5
a =
("I & G
i = CChon T

To view the monitoring of event logs in the form of a map, which also supports 3D maps,

click Monitor > New Map Monitor. The following window appears.

Click to display the left tab,
where all events of the GV-
ASManager are displayed

DoorfGate LUnlodk

Click to display the right tab,
where events of the device
selected are displayed

GV-AS210 - Door 1
] g Hack

Wisng
| Sl Foowes Grarind
SIS 5B P
fe-imE

-

| Auto Rotate

ey Select a event to display its detailed
' information at the bottom

Figure 10-8
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10.4 Accessing Logs

You can access the logs of the connected GV-ASManager, including Access Log, Alarm Log,
Daily Access, Event Log, 10 Box Log, I/0 Log, LPR Log, Patrol Log, System Log, and User
Action Log. In addition, you can set search criteria to filter the records efficiently.

10.4.1 Defing Search Criteria

1. Select a log of interest. Here we use Access Log as an example.

2. Under Filter on the left pane, type or select the desired filtering criteria. For example, we
want to search the log for the records that match the conditions of “Access Granted”,
Card Number “120-38620", Gate A entrance of AS210, and dates from July 1% to July
31%, The resulting filter window may look like this.

{1l Access Lng =l

P ', Access Log

Miassage: | Access Grantxd
Door: | A5210 - Galed
Directian; | Tn

< Bz B =

@ a

| Card

Card Numider: | 120-28620 o

Seasch Cloar Pae 1 oft & No data to disgiay

Figure 10-9

3. Click the Search button to start the log search.

Note: The maximum date range for all logs is 3 months.

10.4.2 Log Window Icons

The icons in the Log window can display the detailed information of that category. Click the
icon to view the details.

Fss): Indicates the availability of the video image.
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In Access Log and Daily Access, you can right-click each search result to access more

information such as card information B8 or user information &8,

Note:

1. Enable Control Center Server and Remote ViewLog Service on GV-NVR / VMS or
GV-Al Guard hosts to allow remote access from GV-ASMangaer.

2. To allow non-IE users to view and play video from GV-NVR / VMS or GV-Al Guard via
GV-ASWeb, select Web Socket when adding the hosts to GV-ASManager. For the
option, see Step 4, 5.1 Mapping Cameras.

10.4.3 Exporting Logs

You can download the logs of the connected GV-ASManager to the local computer in four
formats: txt, html, xlIs, html (zip), and PDF. The Logs in html format and the snapshots
captured will be exported in a .zip file.

1. Use the Export drop-down list on the top-right corner and select the file format.

2. Use the next drop-down list to select This Page to save the current log page, or All to

save all logs.

3. Click OK to download the logs.
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10.4.4 Defining Columns

You can define the displayed columns of the search results for each type of log. The desired
column must be first enabled on GV-ASManager before it becomes searchable on
GV-ASWeb.

1. On the menu bar of GV-ASManager, click Tools > ASWeb Field. This dialog box
appears.

ASWeb Field Configuration X

Access Log |AIarang Event Log | Daily Access | Card 4 #

[J[Business] Jab Title ”
[ [Businesz] Department

[J[Business] Office

[J[Business] Phane

[J[Business] ext

[J[Business] Fax

[J[Business] web Page

[J[Business] E-Mail Address

[][Business] Motes
I:-ar Licenze Plate
[JUser Define 02
[JUser Define 03
[JUser Define 04
[JUszer Define 05
[JUser Define 08 ¥

I Ok H Cancel ]

Figure 10-10
2. Select the columns to enable and click OK.

3.  On GV-ASWeb, click on the arrow button next to an existing column and select

Columns.
’ Access ﬂ ‘El Cord Cods
: [ Card Type
& & [7] Card Status
«|Log Message ¥ Door Local 1| 7| Activation Date
[al
Message: | Access Granted v 4] Sort Ascending [] Deacfivation Date
Door: v %] SortDescending | [[] Privilege
Diraction: | In/Out e [, colunns , | [ Access Group
Date Period: | Today v [7] Disabie Lock Card / Allow Access durirg Lockdown Mode
Support GV_ASIDO
Start Date: 4 ~ O
[#] User
End Date: | v
[T First Hame
| Card |7 Middie Name
T | LastName
g = v [

Figure 10-11
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4. Select a column to display it in the search results.

For example, we added a user-defined column “Parking Space Number” to the Access Log.
The resulting window on GV-ASWeb may look like this:

Export;| TXT 'iThis Page | OK

| =] Log % Mes=age Card Number User I Parking Space Number

Message:  Duress Active ."

Door: | v

Figure 10-12
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10.5 Creating Maps

You can place the icons of connected controllers, LPR lanes, LPR cameras and 1/O devices
on the Google Maps or on a map you uploaded to GV-ASWeb. The map will help you quickly
pinpoint the location of an event or the devices you have installed.

1. On GV-ASWeb, click the Map icon E This window appears.

2 11ap
“
Device Map
4 =] Map
@Parking 3 Google map
@Parkinw Google map
[ Iggnffice Google map
&aparking -1 Google map
lQ}!'parking -2 Google map

4 =7 Controller
@ Controller 1
» [J cs1320-Brian
> [ as1010
EJ As1110
45LPR
b ELLPR Y
= LPRIZ00
» ELPR3
4 =] 10Box
» ] 10BoX-16
- 5] I0BOX -8
|_jCamera

(=]
) Add Map . Edit | Options -
" «
Map Satellite
= i &
i R TG T A,
_ v
MORTH
NASHINGTON MOMTANA DAKOTA
MINNESOTA
SOUTH WISCONSIN
OREGON \okH G SRR MIEH
WYOMING |
TOVA Chicage
NEBRASKA 2 9
ILLINGIS
NEVADA United States INDIANZ
UTAH o o
Frgnciscc COLORADOD KANSAS MIZSOURI
KENTL
CALIFORNIA o
EEREED OKEAHOMA TENNESSE
Los Angeles ARIZONA ARKANSAS A
San Diego NEW MEX|CO Dallas Migsigsip M
— [ B 1A
s - +
- N TEX A4S G
b .
\ LOUISIANA
o N ] -
= o \ Houston
Go gle < Map data ©2017 Goagle. INEGI | Terms of Use

Figure 10-13

step 6 if you do not want to upload your own map.

To upload your own map, click Add Map. This dialog box appears.

85 Add Map
@ Map I Area

Name:

Map:

Lipload

x

=

Cancel

Figure 10-14

10.11 Configuring Areas for Anti-Passback from the drop-down list.
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. Click the Add button =/ to locate the file of the map.
e  Click Upload. A pin is placed on the map.

4. Click Edit in the top-right corner. If you have uploaded your own map, click the pin to
open the map.

5. Drag the controller, LPR lane, LPR camera and I/O device icons from the left menu onto
the map according to their location.

6. Click Edit again when you are finished. You can click the icon of the controllers, LPR
lanes, LPR cameras or I/O devices to access their information.

% Map
“H kg r Mal IF
Device Misg
a imsp o @
s bl _tF Doodemap | & “*TA:H-PR 1y Camera 1
a SJCortroller \ SULPRA, Lane 4
il | iy I
# [T contrciier 1 '\iLPH!,Carmraz
[ ooar 1 Wal_1F l_ : - ‘r
Door AALPR 2, Eane 1 3
Bl 0oor2 Hal_IF - - ‘. LPA 1, Camera 3
[ Coer 2
L ooor &
{7 canrotisr 2 =
= ﬂ Controller 1, Door4
« SELPRA
_;‘-',-'.ane 1 Wal_IF 0 E" ;
e PRI Camera 4
JiLane 1 Mall _1F o G@
4 JCanern
sl
i rareral  Mal_{F
Shmamerad Mal_IF _—;kcon:roller 1, Doar 2
=z 2 i sc ~ f

Figure 10-15

Next, you can look up activities at a door or LPR lane by clicking the arrow button '/ in the
top-right corner. Select your search criteria and click Search.

=i
i i Map (EREG | Vow =
Tracking >
Type: Card e ]
User: Parker » |
Card Number: 2t
Date Panod: | This Month b
Star Dater
Time: -
End Date: i
TIme: i
[#] Roura Plnning by Google "'
Search a
Records | Infarmanon
Waangs DCvor Local The Camsra 1 Camamm 2 & Humzar lz6r
3 1: GV-AS210 - Deor 1 7/18/2013 11:43:13 AM (10 Items) =
Access Granted GV-ASID -Door 1 1 @:ﬁ 13119618 Parket 5
Access Gronted -0 R 123113618 Rarker
Access Granted -Dew r ER Tarker
Ancess Granted @ - Doar B Parksr
Accege Granted GV-A5210 - Door 1 i BB Parkar o
Page:  1iof2| bW & Daghying 1- 32 of 11

Figure 10-16
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¢ You can double-click an event to locate the associated door or LPR lane on the map.

¢ You can select Route Planning by Google to see the suggested route between the
access data of a card or a license plate in the order of access time.

o To view snapshots or play back recorded videos, click the snapshot or video button

On the Google maps, you can also see the directions from one controller / monitored area /
LPR cameras to another. The directions marked on the maps will also be displayed in LPR
log.

1. Right-click the icon of your starting location, and select Begin.

2. Add as many destinations as you wish by right-clicking the icon and selecting Through.

3. For your last destination, right-click the icon and select End.

? SalonCentric & | Map “Satelite |
R e

3.1, Lane 1

W W Woodland Ave
: | -
= &_PH 1, Camer

Yuki Sushi 1§

LPR 1, Camera 3
sacling St

=

X a Map data @2013 Google - Terms of Use Report 2 map error

1893-1905 Woodland Avenue, Santa Clara, CA 95050, USA To 415-725 Morth Winchester Boulevard, San Jose, C& 95128, LISA
0.1 mi

415-725 MNorth Winchester Boulevard, San Jose, CA 95128, USA To 415-725 Morth Winchester Boulevard, San Jose, CA 95128, USA
7t

415-725 Morth Winchester Boulevard, San Jose, CA 95128, USA To 2477 Homewood Drive, San Jose, CA 95128, LISA
0.1 mi

Figure 10-17

Note: For details on monitoring access status using the map created, see Step 4 and 5 in
10.3 Monitoring GV-ASManager.
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10.6 Setting up Export Schedule for Lists and Logs

You can set up a schedule to regularly export lists and logs, and send the report to specified
e-mail addresses or a folder on the GV-ASManager system.

Note: The lists available for export include User List, Card List and Vehicle List.

1. On GV-ASWeb, click Export Schedule. This dialog box appears.

= Export Schoduls

iadds 7 Etil ERemave I Refiash
b= ula Nama Report Typa Export Typa Operaior Az Fragquancy Start ima.
Aecezs Log New) ALcass Log HTML adanin Everye Day 000

Set Send Information

Freguency
Schisgule Mame: | Arcess Log [New)

Expaort Type _' None SLar tmes [ 210

® Every Day
Lt 2 | Every Wesk
) Every Morith

(-l

T Cantant:

e

BCC;

Subject:

Export To File

ExXport Path (Sarver Side):

Fie Name:

SerclExport Fepor

Figure 10-18

2. Click Add '« and select a list or log to be exported.

" Export Schedule =]
|\ add = |, = &2 Refiesh Logs
User List Report Type Export Type Operator Account Frequency Start time
Card List Ewvent Log POF # Every Week 14:30
Vehicke List LPR Log HTML{ZIP) 1 Every Month 20:00
LPR L HTML 1 E O 10:00
Access Log i ey
Access Log PDF X Every Day 00:00
Alarm Log
Alarm Log PDF # Every Day Do:00

Draily Access
Event Log
110 Log =
Frequency
LPR Log
Patrol Log

System Log

User Action Log

Figure 10-19
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3. On the left pane, set the filter criteria for the desired data to be exported, and click Save

to Export Schedule.

) Cand List =i
_,..;. & Card List
Filler e - {g Card Reader Eport = View Mods +
= card Gard Humaes Com Tipe Gord Status Azvation Oete  Deactver
m— =) || 0p0-00030 Homsl Ative
e . 2 0o0-00065 Mozl Active
000035 Memnai Achive ¥
Card Type: X ¢ 000.00123 Ml Axtive ASHA HASS
Card SEtus: b 5 0B0-00137 Moermal Active YUSUFU 0%
P = £ 00000135 Homs! A
o Cﬁx-;u: - 7 000.00148 Mozl Antive
o 00000147 MNomat Aetive RUKIA SAD
2 00000180 Mozl Antive WJGERS aF
SRR 0 00000241 Hcrat Achve MAGHARIA
Wame: Card List {Mew) 91 00000072 Momsl Actve
Sort By: None 2 0on-00204 Hommal Active
Dot Nove 43 00000233 MNoma! Behve
14 00000106 Pzl Ative 1032015 RasHiD s
< 2>
s A Page  tjaF3| b M| & Dispiaying 1 - 100 of 212

Figure 10-20

4. Under Set Send Information of the Export Schedule dialog box, select Export Type for
the file format, Frequency to export by day, week, month or a specific time.

5. To send the report through e-mail, type the E-mail of the recipient.

6. To send the report to a folder on the GV-ASManager system, specify the path and file
name under Export to File.

7. Click Save to apply.
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10.7 Accessing GV-ASWeb using Mobile Devices

You can access GV-ASWeb using the Web browser on your mobile device.

1. Open the Web browser on your mobile device and type the IP address of GV-ASManager

to be connected. This page appears.

Q GeoUision

ASWeb

| Access & Sec urity Management

Bl Visitor
& Visitor Registration

Figure 10-21
2. Click ASWeb and type login credentials. The Monitoring list is shown.

= Monitoring
- [Z]] Controller

- -’ééj Default

‘;é New Device Group_1

=f] LPR
E;H 10Box

Figure 10-22

137



Q GeoUision:

3. Expand the Controller, LPR or 10 Box list to see the status of doors, lanes or I/O boxes.
When alert conditions occur, the alert icons will light up in red.

Monitoring

Controller

" Q Default
> EE Controlier 1
Door 1
E Door 2
E Door 3
H Door 4

» g New Device Group_1
) LPR
+ [=]] 1oBox

Figure 10-23

4. To remotely control a device, tap on the device and select an action.

Controller 1

Unlock Door
Lock Down
Farce Unlock
Force Lock

- Disable Door Lock Operation

Clear All Evenis

Reconnect

Sync Controller

Information

Cancel

Figure 10-24
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5. To watch live view of a connected camera, tap the Menu button = > Live Video and

select the device.

Device:

Default

& Live Video

Camera:

= Live Video

Device

GVAVDSTO0(192 168 5 106

Camera

Camera 1

Figure 10-25

6. To look up the logs, tap the Menu button = and select one log.
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Chapter 11  GV-TAWeb for Workforce Schedule and Payroll

GV-TAWeb is a time and attendance management system that helps you assign work
schedule, keep track of employee attendance and calculate salary. You must first enable
GV-TAWeb function on GV-ASManager and then log in GV-TAWeb to access the following
functions:

TA Report: Look up workforce schedule, attendance records, and employee payroll.
® TA Shift: Set up different types of daily work schedules.

® TA Template: Arrange schedules of up to 45 days with daily schedules from TA Shift.
® TA Holiday: Designate which dates are holidays.

® TA Schedule: Assign work schedule to individual or a group of employees.

® TA User: Specify employee salary.

® Export Schedule: Set up a schedule to regularly export reports to specified e-mail
addresses or a folder on the GV-ASManager system. See 10.6 Setting up Export
Schedule for Lists and Logs.
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11.1 Connecting to GV-ASManager

To enable GV-TAWeb, the Time Clock option must be enabled on GV-ASManager and the
Web Server must be started to allow remote access.

Note: The Time Clock option is not available for GV-AS1010. To use GV-AS1010 with
GV-TAWeb, you must configure the built-in function keys on the Web interface of
GV-AS1010. See the Function Key Configuration section in Chapter 8 of GV-ASEV
Controller User Manual.

1. On the menu bar of GV-ASManager, click Setup > Devices. In the Devices dialog box,
double-click a Controller you want to track attendances, select a Door, click the Other
tab and enable Time Clock.

[T Centreller Setup
M Settngs Genera Advanced  Cther
Corvroller Setup
[ Deer 1 Reader's Keypad
F Door 2 - i
] Deer3 Enfrance 7] Ext
[ Doord
Input
Auto Check Out
[[] Envance (="
Timz and Atendencs Management
@ Time Clock
Figure 11-1

2. Onthe menu bar, click Tools > Servers > Web Server. The Geo Web Server Setting
dialog box (Figure 10-1) appears.

3. Click OK. When the server is started, the icon appears at the bottom-right of the
main screen.

141


https://dlcdn.geovision.com.tw/Manual/Access-Control/Controller/EN/GV-ASEV_Controller_User_Manual.pdf
https://dlcdn.geovision.com.tw/Manual/Access-Control/Controller/EN/GV-ASEV_Controller_User_Manual.pdf

Q GeoUision:

To start GV-TAWeb:

1. Open an Internet browser, and type the IP address of GV-ASManager to be connected.
This page appears.

@ CooWehSener ® +

<« G @ 12700091 w &

Q GeoUision

A
ASWeb TAWeL TSR =

LA R WIYVED YISO
Accase & Sacurily Tima and Aflandance WVisitor Managsmani Wigitor Ragistration
Menagement Managament

Figure 11-3
2. Click https:// for SSL encrypted connection, or TAWeb for regular connection.

3. Enter the login credentials. The GV-TAWeb page appears.

=

e_ )| @ /1921680130 TAW=ETAWE s O - & ” & TAweb . | |

TA Shift TA Report

)
= B
TA Template Export
schedule
BELd

TA Holiday

_mm |

Figure 11-4
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11.2 Setting up Workforce Schedule

To set up workforce schedule, first set up different types of daily work schedules using TA
Shift, and then you can arrange the different types of daily work schedules into a cycle using
TA Template. Next, specify the dates for holidays in TA Holiday. Lastly, TA Schedule
allows you to assign work schedules to an employee or a group of employees using daily
schedules in TA Shift or using long-term schedules from TA Template.

11.2.1 TA Shift: Setting up a Daily Schedule

1. Click the TA Shift icon. This dialog box appears.

4 TA Shift = (23]
(&) Add shift
Name Start Time End Time Break time start (1) Break time end (1)  Break time start (2) Break time end (2}
Page 1 of1 e No data to display
Figure 11-5

2. Click Add Shift to add a new daily shift schedule. This dialog box appears.

TA Shift Settings ¥
Name: Geo{grace time) Break Time (1)
Start Time: T L )
me 10:00 Start Time: 12:00
End Time: H 1] )
na time 15:00 End Time: 13:30 &
Advance Period: In: 02:00
Out: | 02:00 [T] Break Time (2)
Grace Period: Before: 01:00
Start Time:
After: 00:00
End Time:
Owertime Buffer Period: 00:30
The 2nd rate applied as overtime 01:00

hour exceeds:

Time Range
Today Mext day

0 2 4 6 8 10 12 14 16 18 20 22 0 2 4 & & 10 12 14 16 18 20 22 0 2
Lol bbb bbb bbb bl B bbb B b e b e b b e b b b b b e b bbb B b e b b b B b B e b e bl bl

T W

Save Cancel

Figure 11-6
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10.

144

Type a Name for the daily shift to help you identify it.
Select a Start Time and End Time to specify when the work shift starts and ends.

Specify an Advance Period to set the amount of time before and after the regular work
hours an employee can work. Employees arriving before the Advance Period will be
recorded as working during Not Scheduled time in TA Record.

Specify a Grace Period to set the amount of time in which employees can vary their
start and end times of the regular work hours.

Specify the Overtime Buffer Period and an employee has to work passed the overtime
buffer period to be counted toward overtime pay.

Select The 2™ rate applied as overtime hour exceeds if you want to specify the time
an employee has to work passed after the Overtime Buffer Period to be counted toward
the second overtime rate.

To specify when break time starts and ends, select Break Time and select the Start
Time and End Time. You can set a second break time if needed. Note that Break Time
will not be counted toward Work Hours.

The time range shows the start and end times of a shift schedule. Using the below
figures as an example, an employee working 2 hours passed the 19:00 pm regular end
time will receive overtime pay for 1.5 hours (19:30 ~ 21:00), while an employee working
20 minutes passed 19:00 will not receive overtime pay. The 2™ rate will be applied once
the employee has worked passed 20:00, which is 1 hour after the Overtime Buffer
Period.

2nd rate applied

Start Time End Time 20:00
8:00 - 10:00 10:00 19:00 19:00 - 21:00
Advance Period Regular Work Hours Advance Period
In Out
Break .
Time Overtlm(? Buffer
Period
9:00-10:00 12:00 - 13:30 18:00-19:00 19:00-19:30
Figure 11-7

Click Save to confirm the shift settings.



11.2.2 TA Template: Setting up a Schedule Template
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TA Template allows you to set a 1-45 day recurring schedule template composed of the daily
shift schedule created in TA Shift.

1.

2.

Click the TA Template icon. This dialog box appears.

TA Template - |1
&9 Add Template
Name Period With Holidays
Page| 1|of1 b Displaying 1 -1 of 1
Figure 11-8

Click Add Template. This dialog box appears.

TA Template Sartngs

Mams:
Parind:

\With Holdays: (]

Daccription:

Save Cancst |

Figure 11-9

Type a Name to identify the template.

In the Period field, type a number between 1 and 45 to indicate the number of days in

the schedule.

Select With Holidays to apply the holidays set up in TA Holiday.
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6. Inthe drop-down list below each day, select a daily shift schedule created in TA Shift.

A TA Template may look like this. In this example, the template is a 2-week work
schedule, because the Period is set to 14 days. The drop-down list under each day
indicates the daily work schedule selected for that day. A blank drop-down list means
that no work schedule is assigned for that day.

TA Template Settings X
MName: Front Desk-FT
Period: 14
With Holidays:
Day1l Day?2 Day3 Day4 Days Dayft Day?
morning ¥ morming ¥ afternoon ¥ special event | ¥ specid event | ¥ special event ¥ - ¥
Day8 Day9 Dayl10 Day11l Dayl2 Day13 Day14
morning ¥ morming v afternoon ¥ afternoon ¥ morning >, - - "
Descripton: Fart-time work schedule for front desk (2 weeks)

Sawe Cancel

Figure 11-10
7. Click Save.

11.2.3 TA Holidays: Setting Certain Dates as Holidays

1. Click the TA Holiday icon. This dialog box appears.

5] TA Holiday X

(@ Add Holiday @ Remove Holiday £7 Edit Holiday

January 2010 - December 2010
February 2010 March 2010 April 2010
M T W i

1 2 3

g 5 10
15 18 17
22 23 24

Figure 11-11
2. Select a date and click Add Holiday.
3. Type a name for the holiday.

4. Click OK and that day will be designated as a holiday if With Holidays is selected in TA
Template
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After creating daily shift schedules in TA Shift or arranging a schedule template in TA

Template, you can now assign the schedules you set up to an employee or an entire

department and select a start date.

Note: The employees listed in TA Schedule are the users in User List on GV-ASManager.

To assign employees to a group, open the employees’ user information in User List and

select the Business tab. In the Division field, type the division of the employee and all

employees with the same division name will be grouped into one division in GV-TAWeb.

Departments can be created under a division and offices can be created under a

department if needed.

1. Click the TA Schedule icon. This dialog box appears.

(2] TA schedule

“ duly 2014 =

T W T F
1 2 3 4
L] f 8 9 0 M

13 14 15 16 17 18

20 29 22 23 M 25

27 28 28 30 [3]

Today |
Company

4 gAl
£ Admin
SPFAE
S5HR
4 i RSD
I+ g HW Engineering
% SW Engineering
£ Upper Management

L3

5

12
19
28

Employee  O7/27 (Sun) 0728 (Mon)

Page 1 |of1

07128 (Tue)

D7/30 (Wed) = 07/31 (Thu)

0&/01 (Fri} 08/02 [Sat)

No dats to display

Figure 11-12
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To assign daily shift schedules day by day:

2.

o a &~

148

To assign daily schedules day-by-day, select an employee or a group of employees in
the Company section and click Assign Shift. You can also press Shift or Ctrl to select

multiple employees in a department. This dialog box appears.

Assign Shift ®
Shift: FAE Schedule b
Date: 2014/04/24 ]

Apply to...
(%) Group: FAE

{3 Only Selected Users

0K Cancel

Figure 11-13
Select a daily schedule and assign it to a date.
You can choose to apply the schedule to the entire group or only the selected users.
Repeat the steps for all the dates you want to schedule a shift.

Click OK. A TA schedule window may look like this. In this example, different daily
schedules created in TA Shift are assigned from Monday to Saturday to two employees.

= 0¥
o Assign Shift 5 Assign Template .@ Remove Schedule
Employee 01102 £ 5un) 0103 (hom) 01404 (Tl 01405 (ied) 0106 ( Thu 01407 (Fri1 01108 (Sat)
1 Angeline Tay - | Hight |
2 Grace Chong : [“Morning | :
Page 1 of1 = Displaying 1 - 2 of 2

Figure 11-14
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To assign a schedule template:

7. To assign a schedule template from TA Template, select an employee or a group of
employees and click Assign Template. This dialog box appears.

Assign Template 3
Template: - >
Template Day of Start Date: w
Start Date: 3
[] End Date: |

Schedule Overlapping Scheme

(®) Overwrite the original schedule

(") Keep the original schedule
Apply to...

(®) Group: Al

oK Cancel

Figure 11-15
8. Using the Template drop-down list, select a schedule template created in TA Template.

9. Select a day from the Template Day of Start Date drop-down list and the template will
start on that day.

[ Assign Template *
Template: FAE Schedule —
Template Day of Start Date: || w
Start Date: 1 FAE Schedule :

[ End Date: 2 FAE Schedule
. 31 FAE Schedule

Schedule Overlapping Scheme
4 1 FAE Schedule

(&) Overwrite the original schedl 5 . Fap Schedule
() Keep the original schedule g . -

To-
Apply to...

(%) Group: (Empty)

O Cancel

Figure 11-16

10. Select a Start Date to begin applying the template and the schedule will begin with the
day specified in Template Day of Start Date. Select an End Date to discontinue the
schedule if needed.
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11. In the Schedule Overlapping Scheme section, select Overwrite the original schedule
if you want to overwrite the original schedule in the case of an overlap.

12. Select Keep the original schedule and the template will not be assigned if there is an

existing schedule during the time period you specified.

13. Click OK. A TA schedule window may look like this. In this example, an FAE weekly
schedule created in TA Template are assigned to two employees.

S Assion Shitt g Assign Template -@Remove Schedule

Employee 01/09 (Sun) 0140 (Man) A1 (Tue) 0112 ied) 01M3 (Thu) 0114 (Fri) 0115 (Sat)
1 ShalynnLee - W FAESchedule | FAE Schedule [ FAE Schedule B FAE Schedule B FAE Schedule i - |
ERRLL LU LU ) FAE Schedule J FAE Schedule J§ FAE Schedule J FAE schedule i FAE Schedule i - |

Page 1 of1 & Displaying 1 -2 of 2

Figure 11-17

Hint: To set a weekly schedule with Saturday and Sunday as non-working days, set a 7-day
Period and designate two consecutive days as non-working days by not selecting a daily shift.

TA Template Settings % |
Marne: FAE schedule
Period: 7
with Holiclays: F
Dayl Day2 Day3 Day4 Day5 Dayb Day7
FAE Schedule v FAE Schedule v FAE Schedule v FAE Schedule v FAE Schedule v |- V- v

Figure 11-18

Then, in TA Schedule, match the first non-working day with a Saturday.

Assign Template Assign Template X
Template: FAE Schedule v Template: FAE Schedule v
Termplate Day of Start Date: || v Template Day of Start Date: 6:- v
Start Date: 1 : FAE Schedule Start Date: 2014/08/30

s D End Date: August 2014 - 9
D End Date: 2 FRE Srherle Schedule Dverlapping Sch Bl
31 FAE Schedule [
Schedule Overlapping Scheme ) .
4 FAE Schedule (& Cvarwrite the original sched
(&) Overwrite the original schedl s . Fag Schedule (O Keep the original scheduie
) Keep the original schedule IE‘ i I
- Apply to...
do-
Apply to... O Group: Al
Select the first non-working day Select a Saturday for Start Date

Figure 11-19
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11.3 TA User: Specifying Hourly Pay

You can specify the hourly pay for regular work hours and overtime work hours using TA

User.

1. Click the TA User icon. This dialog box appears.

&P TA User =1l
Company User Data
Searching the employea Marme:
a gban /| Regular Hourly Pay:
4 & Trading Overtime Hourly Pay:

£ Lydia Ching
£ Ng Koh Sheng || Overtime Hourly Pay (Second rate):
£\ Edmund Lau
£ Lance Yeo
£ Tony Tey
£ Vivien Lee _
£ Jeslin Poh k4

Figure 11-20
2. Select an employee from the list.
3. Type the Hourly Regular Pay and the Hourly Overtime Pay.

4. Type the Overtime Hourly Pay (Second rate) if you have set up the second overtime
period. See 11.2.1 TA Shift: Setting up a Daily Schedule.

5. Click Update to save the settings.

Note: The employees listed in TA User are the users in the User List. For how to create

users, see 4.6 Adding Users.
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11.4 TA Report: Looking Up Records

TA Report allows you to look up workforce schedules, attendance record, payroll and

summaries of each department’s data.

1.

2.

Click the TA Report icon. This dialog box appears.

{E] TA Report
Report Template
= ‘Il All Templates
=)} Schedule Templates
|-=| Employee Schedule
|:zz| Unscheduled Employee
== Time Templates
|:z5| Daity Time Card
|-==| Employee Time Card
[22Z| Time Card List
|22 Workforee Summary
i Average Hour Summary
wath Excception Summary
== Payroll Templates
|-==| Payroll List
[= Employee Payrol
wadh Payroll Summary
=l =} Job Code Templates
[zF] Job Code
[=5] Job Code Summary

b

Title

Page 1of1

L
&

Template

No data to display

On the left pane, the following data and graphs are available:

Figure 11-21

Note: Accessing Average Hour Summary, Exception Summary or Payroll Summary

requires Flash Player 10 or later.
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[Schedule Templates]

m  Employee Schedule: Shows the work schedule of an individual employee.

m  Unscheduled Employee: Shows the days when employees are not scheduled to

work.

[Time Templates]

m  Daily Time Card: Shows the work schedule and the actual punch in/out time of

employees in a department.
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Employee Time Card: Shows the work schedule and the actual punch in/out time
of an individual employee.

Time Card List: Searches for records within a department.

¢ Show Detailed Punch: Click to display the detailed information of every punch
time. For the option to work, With direction must be selected in the
Calculation field.

a

I=] Time Card List “
i sae [lRun BaExpor
Date Name Division | De.. | JobTite Employee ID Excegtion | Punch Message  Punch In Time Punch Qut Time  Period Time
4 270504 Ty Rachel Mil ADI 120000 m@ 1883 m@E
Access Granted  12:00.00 m 151331 @ 0613
Access Granted  18:14:45 [ il

Figure 11-22

To search for normal activities only, do not select any events. To search for
abnormal activities, select one or more events under the Filter section. The following
events are available.

» In Late: Punching in after the assigned start time.

* In Early: Punching in before the assigned start time.

» Out Late: Punching out after the assigned end time.

« Out Early: Punching out before the assigned end time.

» Over Hours: Working after the Overtime Buffer Period but before the Extended
Period.

* Unscheduled Absence: Absence during scheduled work day.

* Missed Punch: Punching in without punching out or punching out without
punching in.

* Not Scheduled: Working on days when there is no assigned shift for that day.

* Below the required working hours: Actual number of hours worked is below
the assigned work hours.

Workforce Summary: Shows each employee’s total work time and days within the
time period specified.

Average Hour Summary: Shows each department’s average work hours per
person during the time period specified and the percentage occupied in comparison
to other departments.

Exception Summary: Displays a department’s total counts of Exception Events
within the time period specified.
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[Payroll Templates]

m  Payroll List: Shows the hourly pay, total work hours and total pay of the
employees within a department during the time period specified.

m  Employee Payroll: Shows the hourly pay, total work hours and total pay of an
employee for each day of the time period specified.

m  Payroll Summary: Shows the average total pay of each department during the
time period specified and the percentage occupied within the company.

[Job Code Templates]

m  Job Code: Shows the employee’s punch in and punch out time of different job
codes during the time period specified.

m  Job Code Summary: Shows the employee’s total work time of different job codes
during the time period specified.

Using the Daily Time Card as an example, double-click Daily Time Card on the left
menu. This dialog box appears.

=| Daily Time Card (=] |
[ save Erun B Export -

Date Mame Diivision Department Office Job Title Employes ID Punch In Tims Punch Qut Time Punch Qut Time

< >
Page 1 of1

f

No data fo display

Report Settings ¥

Title: Daily Time Card Organization: --- Select --- » A
Date: 2015/11/16
Calculation: Without direction hd

Exception

A: In Late B: In Early C: Out Late D: Out Early

E: Over Hours F: Unscheduled Absence G: Missed Punch H: Not Scheduled
1: Below the required working hours

Description:

Figure 11-23

Select the Date and Organization to look up the employees’ scheduled shift and actual
attendance record.

You can use the Calculation drop-down list to further filter the search results.

®  Without Direction: Shows all attendance records.
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m  With Direction: Only shows attendance record registered from readers that have

been set as entry readers (IN readers).

m  With TA Function Key: Only shows attendance record registered using the
function keys of GV-AS1010.

Click the Run button toward the top. A dialog box similar to the one below appears.

Using the fifth person as an example, Paul punched in at 10:01 and punched out at

16:56, even though his scheduled work time is from 9:00 to 17:00. He is therefore listed

as A (In Late) and D (Out Early) in the Exception column. The number of hours he

worked is listed under the Work Time column.

=] Daily Time Card =
H Save u Run E}Export =
Name « Punch In Time Punch Qut Time Work Time Start Time End Time Duty Work Time Exception
oy e LU [a) v L) v T o e~ T —
2 Irving 18:00 & 18:00 & 00:47 17:35 19:00 01:20 A CH |
3  Iverson 17:52 18:18 00:18 17:35 19:00 01:20 ADH
4 Parker 10:01 [&] 16:56 [A] 06:55 0%:00 17:00 02:00 A D
I 5 Paul 10001 [T][&] 16:36 [T][&] 06:55 08:00 17:00 0&:00 AD I
§ Rick - - - = = = -
7 | Rondo 17:52 1816 00:19 17:35 15:00 01:20 A D H [ve|
< >
Page 1 0f1 .:,:' Mo data to display
Report Settings ¥
Title: Daily Time Card ‘Organization: Select v A
Date: 2015/11/16 A
Calculation: Without diraction b
Exception
A: In Late B: In Early C: Out Late D: Out Earhy
E: Over Hours F: Unscheduled Absence G: Missad Punch H: Mot Sche
1: Below the required working hours
W
Description:
< >

Figure 11-24

You can click the Access Log icon 4] to see complete attendance records or click the

TA Log icon LI to see attendance records excluding records that are not during the

scheduled work hours.
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8. To add/edit attendance records, click the TA Log icon [Tl. And click the Add or Edit
buttons. The manually added and edited records are highlighted in green.

TALog: 2017/05/04 (Thu) Black Widow
o Add
Local Time Meszage Doar Ceection  Camera 1  Camera 2
1 2017105/04 03-00-00 Access Granted AS10M0 - Doar 1 In
2| 20171D5/04 16:51:32 Access Denied: APB (Double Entry) AS1010 - Door 1 In Z
3 | 2017105/04 16:61:35 Access Denied: APB (Double Entry) AS1010 - Doar 1 In
4 2017M5/04 16:51-35 Time Artendence: Work Time Start AS1010 - Door 1 In
5 201705/04 16:52:00 Time Attendance: Work Time Start AS10M0 - Door 1 In
6 2017D5/04 16:52-04 Access Denied: APB (Double Entry) AS1010 - Doar 1 In
T | 2017/05/04 16:52:04 Time Attendance: Work Time Start AS1010 - Door 1 In
8 | 2017/05/04 17.06:40 Access Denied: APB (Double Entry) AS1010 - Door 1 In
9 | 2017ID5/04 17:06:40 Time Attendance: Work Time Start AS100 - Door 1 In
10 | 2017/05/04 17.07-11 Access Denied: APE (Double Entry) AS1010 - Door 1 In 5
11| 20171D5/04 17.07-11 Time Attandance: Work Time Start AS1010 - Doar 1 In
< >
Page 1iof1 = Dizplaying 1- 14 of 14

Figure 11-25

9. Click Save and a shortcut of the Daily Time Card for the specified department and date
will be created in the TA Report main page.

Q TA Report =] |E.2
Report Template ) Searching reports by the title... [
= ) Al Templates Title Template
= Schedule Templates — =
1 Daily Time Card =]

[=| Employee Schedule
[=] Unscheduled Employes
=i Time Templates
[=| Daily Time Card
[ Emplayee Time Card
[= Exception
ﬁ Lverage Hour Summary
| Exception Summeary
= ) Payroll Templates
[=] Payrall List
[ Emplayee Payroll

Doily Time Card

ﬁ Payroll Summary Pane 1 of1 S}" Displaying 1 -1 of 1

Figure 11-26
10. Click Export to export the data in excel (CSV), HTML or PDF format.

11. To select which data to display, click the arrow next to the column title and click

Column.
Name Punch In Time |¥| Punch Out Time Work Time Start Time
1 Lydia Ching 09:56 El A0 05:00
2  HNg Koh Sheng 09.57 iJ, Al 09:00
3  Edmund Lau 09:57 NG00
4 Lance Yeo 09:57 [ e b Name
5 Tony Tey 09:57 - ~ Punch In Time
6 Vivien Lee 08:57 18:37 03 Punch Qut Time
7 Jeslin Poh 09:56 1837 08 Work Time

Figure 11-27
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Note:
1. The Export function is only available after you have saved the report by clicking the
Save button.

2. Inthe Time Card List, you can select CSV (individual) or HTML (individual) to export
the user records individually as an excel file or HTML page.
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11.5 Creating Accounts to Manage GV-TAWeb

The administrator can create accounts with different privileges to manage GV-TAWeb.

1. On the menu bar, click Tools > Operators. The Account dialog box (Figure 8-1) appears.
Follow the instructions in 8.1 Adding System Users to create an account.

Click the TAWeb tab.

DN

Select the privileges you want to grant. The following options are available.
B Schedule Setup: Access TA Shift, TA Template and TA Schedule.
B Report viewing: Access TA Report.
B Payroll Setup: Access TA User.
B Modify Log: Able to modify and delete TA logs.
5. Click OK.
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Chapter 12 GV-VMWeb for Visitor Management

GV-VMWeb is a visitor management system for internal business use where the
administrator can create a visitor database and grant access to visitors over a LAN.
GV-VMWeb can also allow visitors to register their own visitor accounts and create visit
requests over the Internet using the Visitor service.

|

ASWab
Accass & Socuri
Managemard

connection (SSL)
k on [Contmue 1o this
d

Figure 12-1

12.1 Connecting to GV-ASManager

Before GV-VMWeb can connect to GV-ASManager, remote access must be enabled on
GV-ASManager as below:

1. Onthe menu bar, click Tools > Servers > Web Server. The Geo Web Server Setting
dialog box (Figure 10-1) appears.

2. Click OK to start the connection. When the server is started, the icon appears at the
bottom-right of the main screen.

To start GV-VMWeb:

1. Open an Internet browser, and type the IP address of GV-ASManager to be connected.
The login page (Figure 12-1) appears.

2. Click https:// for SSL encrypted connection, or VMWeb for regular connection.
3. Enter the login credentials. The GV-VMWeb page appears.
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12.2 The GV-VMWeb Window

e ] Uaggeg 12012,

Figure 12-2
No. | Name Function

Display live counts of Total, Unpermitted, Permitted, Checked-in,

1 Counter Banner ) o
Checked-out and Expired visit requests.
Access the following functions: Auto Permit (permitting visit
requests automatically when the requests are created), Visit
record of issue cards is deletable (able to delete visit records
under Demands for Visit (No 4, Figure 12-2)), Export Schedule

. (see 10.6 Setting up Export Schedule for Lists and Logs), Theme

2 | Options (changing the Ul color theme), Visitor Web (see 12.6 Visitor Self
Registration).
Note: After selecting Export Schedule > Add, the Export
Schedule will be minimized to the bottom-left side. Then click Save
to Export Schedule to start setting.

3 | All Visitors List all the visitors created.

4 Demands for Visit | List all the visit requests of today.

5 Search Search for visitors and visit records by defining criteria. See 12.5
Searching GV-VMWeb database.

6 Information Display the user information of a selected visitor.

7 Monitor List the visit records of a specified time period.
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12.3 Creating Accounts to Manage GV-VMWeb

The administrator can create multiple accounts with different privileges to manage each step
of granting access as shown below.

Create
visitor
profile

Specify time
& destination
of the visit

Verify and
grant
permission

Issue visitor
card

You can create a security staff account with privileges to create Visitor Data and Visit
Records, while another account with privileges to Verify visitors and Issue Card can be
assigned to a management staff. In this setup, the security staff can create visitor profiles and
visit requests for visitors, but the management staff needs to approve the visits and issue
cards, passcodes or QR codes to visitors before the visitors can be granted access.

Note: To create visitor cards, see 4.3 Adding Cards.

To create accounts:

1. On the menu bar of GV-ASManager, click Tools > Operators. The Account dialog box
(Figure 8-1) appears.

2. Follow the instructions in 8.1 Adding System Users to create an account.
3. Click the VMWeb tab.
4. Select the privileges you want to grant. The following options are available.
m Set Up Visitor Data: Create and edit visitor profiles.
m View Visit Record: Look up visit records in the past for each visitor.
m Edit Visit Record: Create, edit and export visit records.
B Permit Visit: Grant and edit visit permits.
B Issue Card: Assign cards, passcodes or QR codes to visitors.
B System Settings: Enable access to the GV-VMWeb setting options.
5. Click OK.
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12.4 Creating Visitor Profiles
GV-VMWeb allows you to create visitor profiles and grant different accesses to each visitor.

To create a visitor profile:

1. Inthe Visitor section, click the New button. This dialog box appears.

BB visitor Settings =
General | Hame Businass Leer Dafined Features

First Nama: Middle Hame: Last Nama:
DeEplay: o
o: Gender: Male Q@ Female
Bithday: 01/01/1900

cans: Hhoto: = EE
Card Numiber Card Code

Vehicles:

Licanse Plate Brand \ode|

K Can
Figure 12-3

2. In the General tab, type the visitor's name and click Browse close to Photo to upload a
photo of the visitor.

3. Inthe Home and Business tab, you can fill out other personal information about the
visitor, such as phone number and address.

4. Inthe User Defined tab, the customized field labels will be displayed. To see how to
customize the fields, see 4.6.2 Customizing a User Data Field.

5. Click OK.

Note:

1. The visitor profile created will be updated to the User List in GV-ASManager.

2. If you have a webcam installed, click the Webcam icon L to take a picture from the
webcam. The webcam function requires Flash Player 10 or later.
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12.5 Granting Visitor Access

After the visitor accounts are created, access permissions can be granted to visitors using the

Demands for Visit section (No. 4, Figure 12-2). In this section, you can specify the date and

time of a visit, assign an access card, a passcode or QR code to the visitor and view visit

records.

To create a visit request:

1.

o ~ DN

Select a visitor account in the All Visitors section (No. 3, Figure 12-2) and click the New
button in the Demands for Visit section (No. 4, Figure 12-2).

.- =i= [ Exporl~ Demands For Visit- [Wang Hank]
Visil Date Visil Time Siatus Drestination MNotes Wehicle
1| 11/09/2021 15:40 @ Check Qut
Page 1|of1 c
Figure 12-4

Select a Visit Date and Visit Time to note the time when the visitor will be visiting.
You can type a Destination and Note for your own reference.
Select the Permit checkbox and Update to grant access permission.

Under Approval, the account that permitted the access will automatically be recorded
after permission is granted.

To assign a visitor card, passcode or QR code:

6.

To assign a visitor card or passcode to the visitor, click the Card Number drop-down list.
This dialog box appears.

I Cang Nurmoar 2

Card Numbar Card Type Card Status Actvabon Dale

*
Pags 1ol 2 Ha data to cisplay
H Satting

Deactivation: All Day o,

Date: Time: - Card Number

Figure 12-5
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7. Click Add = and select Add a New Card or Add a New Passcode to create an
access card or a passcode for the visitor.

8. Alternatively, to create a QR code for the visitor, click L+ 1)

9. Use the Deactivation drop-down list to specify when the card will be deactivated.

Tip: If you have a GV-PCR310 Enroliment Reader installed, you can place the visitor card
on GV-PCR310 and click Card Reader & to quickly identify the card number.

Note:

1. For details on adding access cards and passcodes, see 4.3.1 Adding a Single Card and
4.3.3 Adding a Passcode, respectively.

2. The QR code function is only supported by GV-QR1352 readers and GV-FR Panel.

10. Click Update to continue editing the Demand for Visit entry.

To check out a visitor card:

11. The Check In time is when the Demand for Visit entry is created. After the visitor returns
the visitor card, a security staff can return to this visit record and select the Check Out
checkbox to record the check-out time of the visitor card on GV-VMWeb.

=+ New X [} Expori~ Demands For Visit-  [Amy- Adamas]
Vehicle Approval Permit Card Number Check in = Check Out
admin ®
bpt admin 050-04586 [# | 2021/11/23 16:08:24 5]
I Update I Cancel I
Figure 12-6
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12. Alternatively, you can choose to automatically check out the visitor card when the visitor

13. Click Update to save the settings and the data will be updated to GV-ASManager.

presents the card at the entrance / exit door. For this function to work, it is required to
enable the Auto Check Out options (On the Devices dialog box, select a controller /

LPR > a Door / Lane > Auto Check Out).

Controller Setup
M Settings General I &dvanced | Other
Contraller Setup
Daor 1 Dizable Keypad
[ Dowr2 i
] Door3 "] Entrance [ Exit
[] Doord
Input
Auto Check Out
I [T Entrance [ Exit I
- - .
Recognition Setting Card Freader lNone vJ
Recognition: lB_l,l mation detection -
: Barrier Contral: l Mane 'J
Matching Mode: l.t’-‘«ll Characters Match 7‘
) ) . Auto Check Out
Mation Detection by 1/0 Trigger: I — At Dhel: 0 I
[ vI Do not record unrecognized results
Figure 12-7

Note:

1.

2. To edit the vehicle settings, click the '

When using passcodes and QR codes for visitor access, the passcodes and QR codes

will automatically be deleted upon checking out or after 24 hours from its check-in time.

check-in time will be recorded on GV-VMWeb.

in the Vehicle field. When the visitor’s vehicle
enters the parking lot and the detected plate number matches the registered one, the

& New . J§ Delete E_rExpof' x Demands For Visit- [Alice]

\isit Date Visit Time Destination Notes
o6/14/2008 [ 10000

Update

ehicle

GEQEB o |1 wd

Approval Permit

Cancel

Card Number

Figure 12-8

165




Q GeoUision:

12.6 Searching GV-VMWeb Database

To search for visitors, type the visitor’s information in the Visitor section on the left and click
the Search button. The search results will be listed in the All Visitors section. In the Filter
section, you can filter the search of visit records by Card Number, Destination, Notes, User or

the person who approved the visit.

2L \sitors
= - ] Soem W cekte
84 search | i Informzton Ueer Garder Company Job Tilla Ditvieasn Denenmert Oifce
VEitor Al Vigitors
1| taunghandS22@omeil.com
User: tsunghan0322@am ™
Company: | [
Job Tre: ¥
Usar Arez: »
Organization: ehact o0
Usar Defined Field 01:
Page 1/af1 I | R Displaying 1 - 1 of 1
Fitor | @new 3 Deiete PoEspar- For Visit - il com]
= |Log Vist Date Viait Time: Destination Hates Wehick: Approval Fermi Card Mumber
Date Pariod: - | pOrneH 14 ]
Stk Date 2 0BMS2NE 17:00 RTYUDPOYH VGBS 1
End Date:
Card Number: o
Vehide: ~
Usar: i
Destination: i
Nates:
Approval:

12.7 Visitor Self Registration

Visitors can create visitor accounts over the Internet and request permission to access the

premises.

The administrator needs to first set up the mail server on GV-VMWeb. The visitor will be able
to register a visitor account, activate the account and create a visit request. The visit request
can trigger an e-mail notification to the administrator if set up, and automatically show up in
GV-VMWeb for the administrator to grant or deny access.

Activate
visitor
account

Register
a visitor
account

Grant
permission

Create a
visit request

Set up mail
server

Administrator Visitor Visitor Visitor Administrator
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12.7.1 Setting up Mail Server in GV-VMWeb

The mail server is used to send confirmation e-mails to visitors when they register visitor
accounts. The administrator must first set up the mail server in GV-VMWeb.

1.  Log in to GV-VMWeb.

2. At the upper-right corner, click Options > Visitor Web.

1

[[] Auto-Permit
[] wisit record of issue cards is delstable
[N

Export Schedule
B Themes Fol

(L) Visitor Web

Figure 12-10

3. Inthe Servers tab, set up the mail server by entering its address, login details and port.
For HTTP Server Address, type the IP address or the domain name of GV-ASManager.

(£ Visitor Web X
Servers Conﬁrmation E-Mazil || Password E-Mail QR Code E-Mail |
Mail Server Information
SMTP Server Address: vmail fetnet.net
Login Name: {@geovision.com.tw
Login Password: ssssnsse
Secured connection: None he
Port: 25
Web Server Information
HTTP Server Address: 192.168.5.71
Save | Cancel

Figure 12-11
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4. In the Confirmation E-Mail tab, fill out the information of the Sender and the Mail. After
registering a visitor account, a confirmation e-mail will be sent to the visitor and the
visitor must click the activation link to confirm the account.

5. Inthe Password E-Mail tab, fill out the information of the Sender and the Mail. The
visitor will be able to retrieve a forgotten password when clicking the “Forgot your
password?” link on the login page. An e-mail with the password will be sent to the visitor.

6. Inthe QR Code/ Passcode E-mail tab, fill out the information of the Sender and the
Mail. The visitor will be able to receive a QR code in the e-mail when the request for visit
is permitted. Access will be granted when the visitor scans the QR code on the

corresponding QR code reader.

Tip: To grant access through a QR code, register a visit on the Visitor Registration page
(see 12.7.2 Creating a Visitor Account & 12.7.3 Creating a Visit Request) and the visitor will
receive a QR code in the confirmation e-mail as a virtual visit card.
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12.7.2 Creating a Visitor Account

1. Open an Internet browser, and type the IP address of GV-ASManager to be connected.
The login page (Figure 12-1) appears.

2. Click https:// and then Visitor for SSL encrypted connection, or Visitor for regular
connection. The Visitor Login page appears.

Q GeoVision

ASWeb TAWeb VMWeb Visitor
Access & Security Time and Attendance Visitor Management Visitor Registration
Management Management

Figure 12-12

3. On the Visitor Login page, click Register a Visitor Account. This window appears.

Back to the login page

Register a Visitor Account

E-Mail Account: [ |

Password:
Re-type Password:

Ward Verification: Type the characters you see in the picturs below.

@ {_Tf‘ﬁif@ -

Figure 12-13
4. Type an e-mail address and a password for the visitor account.
5. Type the characters for word verification.

6. Click Submit. A confirmation e-mail will be sent to the specified e-mail address shortly.
Click the activation link in the e-mail to activate the visitor account.
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12.7.3 Creating a Visit Request

After the visitor account is activated, the visitor can now log into his or her account to create a

visit request.

1. Open an Internet browser, and type the IP address of GV-ASManager to be connected.

The login page (Figure 12-12) appears.

2. Click https:// and then Visitor for SSL encrypted connection, or Visitor for regular

connection. The Visitor Login page appears.

3. Type the visitor account and password, and click Login. This window appears.

comtus | a o hange | Visior Sefing Logoul

L Bda s B show OR Cade [ Send Mai

Wizl Dt Vialt Timg Visit Vahicks Numbet Hitas Pt ek in Chack Dl Chack I [Vahicia) Chaek DUl (Vekick)

Figure 12-14

4. Click the Visitor Setting button at the upper-left corner to complete the visitor profile.
See 12.3 Creating Visitor Profiles.

5. Click the Add Visit button + . This dialog box appears.

Add Visit
Vet Date: 0827/ 2018
Vit Tima: Lo
Vst Vehicle Number:  FD2598

Hotess Board Meatng

Figure 12-15
6. Specify the planned visit date, time and vehicle number if available.

7. Click Save.

The administrator will receive an e-mail notification if set up, and the visit request will also be
displayed on GV-VMWeb. The administrator can then double-click the visit request to grant
access and assign a visitor card passcode or QR code to the visitor.

) Mew K Delete E)E:-mn > Demands For Visit- [Alice]
Visit Diate Wisit Time Destination MNotes Wehicle Approval Permit Card Mumber
1 06142018 10:00 GEQEB Zs

Figure 12-16
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Note: For the administrator to receive e-mail notifications of visit requests, make sure to
enter his/her e-mail address when creating the admin account. See 712.2 Creating Accounts
to Manage GV-VMWeb.

Wecount *

QL8 s D admin

doh Guest

._|é} Lser Email: I I
& Level: |S|.|penrisor |
!E'---é; Supervisor

ASManager ASRemote. .
Database Tool ASWeb... WMWeb TAWeb

=

Figure 12-17
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Chapter 13 License Plate Recognition

The License Plate Recognition (LPR) functions allow a GV-LPR device to grant access when
detected license plate numbers match vehicles registered in the GV-ASManager database.

GV-ASManager supports connections with up to 255 devices, including:
e Edge GV-IP LPR Cameras
e GV-DSP LPR units
e PC-based LPR systems

Video Source + Plate Recognition

L=

g =

Edge GV-IP LPR Camera .
Settings & Database =
Video Source + Plate Recognition \}
?i - l ! a GV-1/O Box
» d |

Analog Camera GV-DSP LPR

Video Source + Plate Recognition GV- ASManager -
?'] . I N | Supports up to 255 GV-LPR devices i I

Analog Camera Gate & Light
== I? PC LPR
| S PC installed with
] e GV-DVR/NVR/VMS/AI Guard
GV-LPR Plugin
GV-IP LPR Camera e GV-USB Dongle
Figure 13-1
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Main Screen

£ ASManaper - [LPR Monizor]
S Fes Montemg  Wew Sshpo Fersareel  Language Took Window  Help

4 BFEHE ORR B0 Fadm e

Live Video

LPR List

Playback

Information
'Ii?-.efﬂw- !!u @ Window

@ szEnzeseEe

Camera List LPR Monitor

Figure 13-2

13.1 Installing PC LPR

A GV-NVR / VMS / Al Guard system can be turned into a PC-based LPR system simply by
installing the LPR Plugin from the GeoVision Website and connecting an LPR Dongle.

Refer to the_datasheet for the minimum system requirements, based on the type of LPR
engine (machine learning or deep learning), the software used, and the number of channels:

. GV-NVR/VMS V17 & V18 / Al Guard LPR (Machine Learning)
2. GV-NVR V17 & V18 /VMS / Al Guard LPR (Machine Learning) + 32CH 2MP Camera
Monitoring
3. GV-VMS V17 & V18 / Al Guard LPR (Machine Learning) + 64CH 2MP Camera
Monitoring
. GV-NVR/VMS V17 & V18 / Al Guard LPR (Deep Learning)
5. GV-NVR/VMS V17 & V18 / Al Guard LPR (Deep Learning) + 32CH 2MP Camera
Monitoring
6. GV-VMS V17 & V18/ Al Guard LPR (Deep Learning) + 64CH 2MP Camera Monitoring
7. GV-VMS V20 LPR (Deep Learning) + 64CH 2MP Camera Monitoring

Also refer to the_datasheet for compatibility between the software and GV-LPR Plugin.
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13.1.1 Installing LPR Plugin

1. Go to the Download Page of GV-LPR.

2. Select Primary Applications from the drop-down list, and

1
3. Click the Download icon “#* of GV-LPR Plugin.

Note: LPR Dongles can be used in conjunction with GV-VMS Software Licenses.

13.1.2 Inserting LPR Dongle

To see recognition results, the LPR Dongle needs to be inserted to the computer of GV-DVR
/I NVR /VMS / Al Guard. Both internal and external dongles are available. The dongle options
include 1, 2, 3, 4, 5, 6, 7, 8 channels.

The following types of USB Dongles are available:
e GV-LPR with GV-DVR /NVR / VMS / Al Guard (Black, Blue)
e GV-LPR with Video Capture Card (Black, Blue)

Note:

1. Each recognition camera counts as 1 channel. For example, if you set up 4 recognition
cameras for a single LPR lane, you will need a 4-ch LPR Dongle.

2. When multiple LPR Dongles are inserted, the dongle that supports the most number of
channels will be applied. The number of channels supported on each dongle will not be
combined.

3. Ifno LPR Dongle is inserted, license plates will be captured but the plate numbers will
not be recognized.
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13.1.3 Accessing Recognition Results in PC LPR

LPR Plugin comes with a tool that allows you to access the snapshots and recognized plate
numbers of the detected license plate. When installing LPR cameras for the first time, you
can use this tool to see the recognition results and make sure the cameras have been set up

correctly.

1. Open the folder of GV-DVR / NVR / VMS / Al Guard and run TestRecogPicView.exe.
The upper row is the live view of channels 1 to 4 and the lower row shows the snapshots
of any license plates detected. The recognized plate numbers and the height of the
captured license plate in pixels are displayed under the snapshots.

& TestRecagPicView E—

Stop Switch Page Close

Lzne 1 test Lane 2 test Lane 3 test Lane 4 test ]

GTB710 h: 48 GTB710 h: 48 GTE710 h: 48 GTB710 h: 48

Figure 13-3
2. To see the results from channels 5 to 8, click Switch Page to switch to page 2.

3. To manually force a PC LPR to detect license plates, click the Test buttons.
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13.2 Adding PC LPR

To add a PC LPR to GV-ASManager, follow the steps below:

e Step1 Enabling LPR Functions on a PC LPR

Enable the recognition cameras and/or the overview cameras on a PC LPR.
e Step2 AddingaPC LPR to GV-ASManager

Establish the communication between GV-ASManager and a PC LPR.
e Step 3 Configuring a Channel

Configure the recognition conditions of a camera channel.

Note: For optimal recognition results, the cameras used should be the ones designed for
license plate recognition, such as GeoVision’s LPR Camera Series.
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13.2.1 Step 1: Enabling LPR Functions in the PC LPR

To enable license recognition in GV-DVR LPR, click the Configure button > Video Analysis,
> License Plate Recognition to access the following LPR functions.

License Plate Recognition Enable LFR S

Camera Popup Setting Enable Cverview Camera Service
Cbject Index/Monitor Setting

Privacy Mask Setting

Advanced Motion Detection Setting

Scene Change Detection Setting Configure

‘Wideo Lowpass Filker Setting

Auta Start LPR Service
Auka Start Crverview Camera Service

Figure 13-4

To enable license recognition in GV-VMS LPR, click the Home button &2 > Toolbar =i >
Tools O > License Plate Recognition to access the following LPR functions.
& O &

Audio >

Live Object Index
Search Object Index

«" Enable LPR Service License Plate Recognition  #

* Enable Cverview Camera Service

v Aulc Start LPR Service

' Autc Start Overview Camera Service

Configure

TESTZTHI27.0.0.1) ?

Figure 13-5

m  Enable LPR Service: Enable recognition of license plates in the Recognition Camera.

m  Enable Overview Camera Service: Allow GV-ASManager to use the cameras
connected to GV-DVR/ NVR / VMS as overview cameras.

m  Auto Start LPR Service: Automatically start LPR Service upon system startup.

m  Auto Start Overview Camera Service: Automatically start Overview Camera Service
upon system startup.

m  Configure: Allow LPR data export. See 13.2.4 Exporting LPR Data.

177



Q GeoUision:

13.2.2 Step 2: Adding a PC LPR to GV-ASManager

1. On the menu bar, click Setup > Devices. The Devices dialog box appears.

2. Under Device Group, define a group for the LPR device to be added. Otherwise, use the

Default group.

Note: The devices (Controller, LPR, I/0O Box and Camera) under the same Device Group will
be applied with the identical settings of Time Zones, Weekly Schedules, Access Groups,
Holidays, Door Groups and Parking Lots.

3. Right-click LPR > New LPR.

'{;-:é Devices [Controller: 4 ports (4 free ports included), GV-Patrol: 0 ports]

| OCOQA T =B p

Device Group Default

Default Device D Madel
@[] Controller

+

ol NewieR

- 3 Camera

Figure 13-6
4. Type ID and Name of the LPR device, select PC LPR and click OK.

Please Enter D i
|0 2
Name: |LF'H 2 |
Hodet e =
Cancel
Figure 13-7
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5. Set up the following connection information.

=1 LPR Setup
General Setup [ane1 lane2 laned laned lane5 lane6 lane7 lane 8 lane3 Llane 10 Llane 11 Llane 12 lane 13 Llane 14 lane 15 Lane 16
General LPR Engine
Device Group : Disfaut M : The setting of Machine Leaming Engine.
3 ) - ]
Device ID: 2 Model: PCLPR D : The setting of Deep Leaming Engine.
Device Name : ||—F'R 2 |
Name Value
Connection Courtry Global
Version 6020
IP Address - <l A
| & o Gamera D LPD Confidence 3
tliar= | | 1 Camera 1 D Hardware Acceleration Enable
2 Camera 2 Max. rumber of logs perfolder 999
Password : | | 3 Camera 3 Max. number of lines perlog file 999
,7 4 Camera 4 Log: API Enable
Command Port : 3388 | 5 Camera 5 Log: Recognition Disable
Data Port - w11 E Camera f_': Log: Recognition upon 1/0ti.. Disable
7 Camera 7 Log: Video input Disable
Log Port : 5552 B Camera 8 Log: Result export Disable
9 Camera & Log: FPS Disable
Number of Cameras ; 32 i 10 Camera 10 Saving image: Unidentfizblei.. Disable
11 Camera 11 Saving image: ldentfiable ima...  Disable
12 Camera 12 Saving image: Min. free spac.. 20438
13 Camera 13 Saving image: Number of ima... 1000
14 Camera 14
15 Camers 15
16 Camera 18 W Diefault
Country
Figure 13-8

[Connection] Type the IP Address, User Name and Password of the PC LPR. You can
also click the Search button @ to search for PC LPR in the same LAN.

B Command Port: The default value is 3388.

B Data Port: The default value is 5611.

B Log Port: The default value is 5552.

B Number of Cameras: Select the number of cameras supported by the PC LPR.
[Camera Box] On the box, select a camera to modify its name.

[LPR Engine] Select the Country of the recognition engine. You can also modify the
log-related settings to change how and what information is stored for debug purposes.
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13.2.3 Step 3: Configuring a Channel

1.

To configure a channel, select a Lane tab. This dialog box appears.

LPR Setup

[ Maritar

Lane Name:

1. | Camea 1

General Setup | Lare 1

Recognition Camera:

lene3 lane4 Llane5 lare 6 Llane7 Llene8 Lane$ Llane 10 Lane 11

Lane 1

2. | None 4
Diverview Camera: Delayed snapshot:
1. |None ¥ |0 Szc{0™60)
2 Secl™60)
3. Sac(0~60)
4. Sec(0™60)
5. Sec(0™60)
8. Secl060)
Drive Direction: Incoming

Authentication Scheduls

Recogntion Setting
Recognition By motion cetection

Matching Mode: Al Characters Match

Senitivity

Awaye

Motion Detection by 110 Triager:

E]

Sync from DVR-LPR

o

Recagnition Fegion Setup

Camera 1

Recognition:

Lane 12

Card Reader None

Bamizr Centrol: MNane

[ futs Check Out

Do et record unrecogrized results

Trigger cutput by LPR event:

Name

Plate Recognized: Registerad Vehicle

Plate Recognized: Registerad Vehicle{imvalid...

| Plate Recognized: lnmgstered Vehicle

! Plate Recognized: Unegstered Vehiclelinval...
Parking Access Granted: Vehicle Added Mar:...
Parking Access Granted: Vehicle Added Mar...

<

Value

lare 13 Lane 14 Lane 15 Lare 16

Recognition Engine

D : The setiing of daen leaming engine

Namgz

oo

Max. character
Min. charactre

M Max. charmcer heignti...

M Min character heght(

M Erable Slant detection

M Max. Slart dstecton a...

M Min_ Slart detection a

I Detect 2 Ine license pl...
Detection number of ...

M Defautt plate backgrou...

M Invet plats backgroun. ..

M Plate Fiter
M Replace all 1wth 1
M Replace all & with zero
M Replace zem with ©
M License plate rule 1
I License piate rule 2
M License piate nile 3
W License plate rule 4

Max. licerse plate heig...
Min. license plate heig...
M Recognition loop num...

M Erable rotation detecti...
W Erable fast otation de...
M Max. retation detectaon...
M Min. rotation detection ... -

vaue
200
40

10

3

4

200

12
Enable
Disable
18

A0
Disable
1

Light
Enable
Enable
Disable
Diisable
Disable

V- The estling of machine leaming engne.

Cancel

Figure 13-9

2. Select Monitor to enable the following settings.

Note: To apply the current settings of the connected PC LPR, click Sync from DVR LPR

at the bottom-left side and skip to step 9.
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[Recognition Camera] Select up to four Recognition Cameras connected to the PC

LPR. Having more than 1 camera is useful when the width of the lane requires multiple

cameras. If multiple cameras recognize the same license plate at the same time, the data

will be recorded as 1 record.
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Note: The resolution of the recognition camera needs to be at least D1. Each recognition

camera counts as 1 channel. If you set up 4 recognition cameras for a single LPR lane, you

will need a 4-ch LPR license.

[Overview Camera] Select up to six Overview Cameras connected to the PC LPR to

capture the overall appearance of a vehicle. Under Delayed snhapshot, you can type the

number of seconds to delay the snapshot capturing after the license plate is recognized.

[Driver Direction] Select Incoming to designate the lane as the entrance of the parking

lot or select Outgoing to set the lane as the exit of the parking lot.

[Authentication Schedule] Optionally, set up the schedule for different access modes at

different time periods. By default, it is License Plate Mode that requires vehicles with

authorized plate numbers to be recognized for access granted.

License Plate Mode: Access can only be granted by license plate recognition for
time periods defined under this mode.

Card Mode: Access can only be granted by access cards for time periods defined
under this mode.

License Plate or Card Mode: Access can be granted by either license plate
recognition or access cards for time periods defined under this mode.

License Plate and Card Mode: Access requires both license plate recognition and
access cards for time periods defined under this mode.

Note: The license plate number recognition is required to load logs containing the

corresponding access card number under License Plate or Card Mode or License

Plate and Card Mode when using standalone LPR devices.

[Recognition Setting]

Recognition: Select to recognize license plates upon motion detection or 1/0
detection. For I/O detection, the PC LPR will only capture 1 license plate per I/O
trigger.

Matching Mode: Select All Characters Match to grant access when the
recognized license plate matches a registered license plate completely. When
Allow 1 mismatched character or Allow 2 mismatched characters is selected, 1
or 2 mismatched characters will be tolerated but not being the first and last
characters. For example, license plate ABC-123 will be considered matching with
AZC-223 when Allow 2 mismatched characters is selected.
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®  Motion Detection by I/O Trigger: When Always is selected, the PC LPR will
always recognize license plates upon motion detection. If an Input is selected, the
PC LPR will only recognize license plates when the assigned input is triggered.
Multiple license plates can be captured during an input trigger.

B Sensitivity: Adjust the sensitivity level of motion detection.
B Sensor: Select the input sensor for I/O detection.

B Delay after trigger: Delay recognition for the number of milliseconds specified
after 1/O trigger.

B Repeat Recognition: Repeat recognition until the number of seconds specified in
Time out. You can also set the PC LPR to Continue recognizing until a
registered vehicle is recognized.

[Recognition Region Setup] Define the recognition area for each camera if needed.

[Card Reader] Optionally, use the drop-down list to select a card reader where the user
is required to present a valid card when under Card Mode.

Note: For details on how to connect the PC LPR to a Wiegand Card Reader, click
here.

[Barrier Control] Use the drop-down list to select an output device to be a gate barrier.
The output device will be triggered when the recognized license plate matches a
registered license plate.

[Auto Check Out] Optionally, select this option to record the check-out time on
GV-VMWeb when the visitor’s vehicle exits the parking lot.

[Do not record unrecognized results] Enabled by default. Select to omit unrecognized
results.

[Trigger output by LPR event] Optionally, click the fields under Value to assign output
devices to trigger when the LPR events occur.

Click OK to apply the above settings and return to the main screen. If the icon i
appears in the LPR view window, it indicates the connection between the PC LPR and

GV-ASManager has been established. If the icon ) appears, it indicates the connection
failed. Then make sure the above connection setup is correctly configured.


https://s3.amazonaws.com/geovision_downloads/TechNotice/AccessControl/PC-LPR_Extended_Reader.pdf
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16416 w |

LPR. Status

- gﬁ TESTEE-A256A250

~ L LPR1

Jh 1:lane 1
A4 2 Lane 2
A4 Filane 3
44 4ilane 4
A Silane 5
A B Lane &
4 Tilane 7
Ah Bilaned

Figure 13-10

Under Recognition Engine, you can adjust the following settings of Recognition Engine
when necessary.

IMPORTANT: Aside from changing the Country of recognition engine, it is highly
recommended not to modify any parameters within Recognition Engine settings.

[LPR Engine] Settings for storing data/logs related to the LPR engine.

®  Max. number of logs per folder: The maximum number of log files within each folder,
from 200 ~ 999 (default = 999).

B Max. number of lines per log file: The maximum number of lines allowed within each
log file, from 200 ~ 999 (default = 999).

B Log: API: Enabled by default, records API-related logs.

B Log: Recognition: Disabled by default, records recognition-related logs.

Log: Recognition upon I/O trigger: Disabled by default, records logs related to
recognition triggered by I/O.

Log: Video input: Disabled by default, records video input-related logs.
Log: Result export: Disabled by default, records result export-related logs.

Log: FPS: Disabled by default, records FPS-related logs.

Saving image: Unidentifiable image: Enabled by default, saves images captured
containing unidentifiable license plates.

B Saving image: Identifiable image: Enabled by default, saves images captured
containing identifiable license plates.

B Saving image: Min. free space (MB): The minimum hard disk space that must be kept
for saving images, from 2048 ~ 9999 (default = 2048).

B Saving image: Number of images per folder: The number of images that can be
stored within a folder, from 1000 ~ 9999 (default = 1000).
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[Deep Learning] Settings for deep-learning LPR engine.

LPD Confidence: The value of license plate detection sensitivity, from 1 ~ 5, with 1
being the most sensitive (default = 3).

Hardware Acceleration: Enabled by default, utilizes GPU decoding for enhanced
performance and reduced CPU loading.

Max. / Min. license plate height (pixels): Set the maximum, from 12 ~ 999 (default =
200), or minimum, from 1 ~ 999 (default = 40), height of license plate images to activate
the recognition process. If the image height exceeds the maximum or is under the

minimum, the system will not start recognition.

Note: When the resolution of images sent to the system exceeds 2 MP, it is necessary to

change Min. license plate height (pixels). The setting rule is that the image height in pixels

must be greater than [image resolution x 20]. For example, set the Min. license plate
height (pixels) to 60 pixels for 3 MP and 80 pixels for 4 MP.

IT'-: Riscognition Engine

M - The setting of Machine Leaming Engine

D : The setting of Deep Leaming Engine,

Name Value

[Machine Learning] Settings for machine-learning LPR engine.
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Recognition loop number: Repeat recognition for the number of times specified, from
1 ~ 20 (default = 10).

Max. / Min. characters: Set the maximum, from 3 ~ 16, or minimum, from 2 ~ 16,
number of characters on the license plate to activate the recognition process. If the
number of characters exceeds the maximum or is under the minimum, the system will
not start the recognition. The default values of max. and min. are dependent on the
country of recognition engine.

Max. / Min. character height: You can set the maximum, from 12 ~ 999 (default = 120),
and minimum, from 1 ~ 999 (default = 16), height of characters on the license plate in
pixels to activate the recognition process.

Enable rotation detection: Enabled by default, License plates tilted horizontally can be
detected.

Enable fast rotation detection: Disabled by default, this option can increase the
recognition speed by 10 % but decrease the accuracy by 3%.
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Max. / Min. rotation detection angle: Set the maximum, from 10 ~ 90 (default = 10)
and minimum, from -90 ~ -1 (default = -10), tilt angle to be allowed to activate the

recognition process.

Enable Slant Detection: Enabled by default, License plates tilted vertically can be
detected.

Max. / Min. slant detection angle: Set the maximum, from 1 ~ 90 (default = 10) and
minimum, from -90 ~ -1 (default = -10), tilt angle to activate the recognition process.

Detect 2 line license plate: Disabled by default, recognize two rows of characters on
license plates. Note this option is only available on engine versions of V5000 or later.

Detection number of license plates: Set the maximum number of plates to be
recognized simultaneously, from 1 ~ 8 (default = 1).

Default plate background color: Light by default, to only recognize plates with white
characters on dark background, or select Dark to only recognize plates with dark
characters on white background. This function is only supported when Global or China
is selected for Country.

Invert plate background color: Enabled by default, to invert plate color when the
license plate cannot be recognized. This function is only supported when Global or
China is selected for Country.

Replace | with 1: Disabled by default, always identify the character “I” as “1” (one).

Replace zero with O: Disabled by default, always identify the character “0” as “O” (letter
0).

Replace Q with zero: Disabled by default, always identify the character “Q” as “0”
(zero). Note this option is only available on engine versions of V5000 or later.

License Plate Rule: None set by default, you can customize up to six plate number
formats and the recognized plates will be converted to similar characters to follow the
format. The format must use 4 and 9 characters and consists of “A” (Alphabets), “D”
(Numeric digits) and “X” (Any). For example, if you set up a format “AA-DDDD”, a license
plate detected as XY-123A will be converted to XY-1234. If the detected plate number
does not fit in the format, the rule won’t be applied.

Note:

1.

The total number of recognition cameras and overview cameras connected per GV-DVR
/' NVR / VMS cannot exceed 16 cameras.

The Overview Cameras need to be set to round-the-clock recording on GV-DVR / NVR /
VMS.

185



Q GeoUision:

3. To ensure optimal performance, the total number of Overview Cameras supported in a
GV-DVR/ NVR / VMS is limited based on the resolution of the overview cameras:

o Overview camera: D1 = maximum 16 overview cameras
o Overview camera: 1 MP = maximum 8 overview cameras
o Overview camera: 2 MP = maximum 4 overview cameras
e Overview camera: 3 MP = maximum 3 overview cameras
e Overview camera: 4 MP = maximum 2 overview cameras
e Overview camera: 5 MP = maximum 1 overview camera
4. To open a gate when the detected license plate is recognized as a registered vehicle:

A. Setup I/O devices on GV-DVR LPR / GV-VMS LPR (Configure button >
Accessories > 1/0 Device > I/0O Device Setup). Refer to 6.1 Setting up I/0
Devices in GV-DVR or GV-VMS User’'s Manual to see how to set the gate as the
output device.

B. Select the output device under Barrier Control.

13.2.4 Exporting LPR Data

You can export LPR data to other machines, such as a parking lot ticket machine. There are
two ways to export the data, through RS-232 connection or export into a file that can be
imported into a third-party program. The Export Setting also allows you to customize a
storage path to store captured license plates.

In GV-DVR LPR, click the Configure button > Video Analysis > License Plate Recognition
> Configure > Export Setting.

l—“—w T Enable LPR. Service

Enabie Overview Camera Jervice

Auto Skark LPR. Service

Auto Start Overview Camera Service

Configure Export Setking

License Plabe Recognition

Camera Popup Setting

bject Indes/Manitor Setting
Privacy Mask Setting

Advanced Motion Detection Setting
Sczne Chanae Detection Sefting
‘ideo Lowpass Filker Setting

Advanced Yideo Analysi  F
Accessories L~
AV Setting
Tools

Figure 13-11

In GV-VMS LPR, click the Home button kidl > Toolbar 4 > Tools [ > License Plate
Recognition > Configure > Export Setting.
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Export through RS-232

1. To connect the PC LPR system to a machine using RS-232 connection, click the Export
Through RS232 tab and select Enable Export through RS232.

Configure [ﬁ

RS232 Setup
Select Port COM 1 - Q@

Select Recognition ltermns to Export Recognition Time Export Format

V] Select All Bl -
Export ltem Length (Bytes) ¥ Year =
[¥] Recognized Plate 12 L'i' Manth
[¥] License Plate 12 '_"'E Day
[¥] Recognition Confidence 24 E’-' Hour -
] Messages 2
[¥] Lane 1
[ Drive Direction 1 Export Content Format
W
B UTG. Netcanippsnbic Export ltem Content
¥| Local Time Mot configurable @l ;

[¥] Lane Camera 2 ;' :jd preﬂx_ b
[¥] User name or license plate Mot configurable . eparatte L
[ Add suffix 3

ok | | cancel

Figure 13-12
2. Nextto Select Port, select the COM port that is used for connection.
3. Under Select Recognition Items to Export, select the LPR data you want to export.

4. Under Length (Bytes), you can click the number to specify the length of the data you

want to display.

5. Under Recognition Time Export Format, select how detailed you want the time

information to be.

6. Under Export Content Format, you can add text or symbols to the beginning or the end
of the LPR data. You can also separate each item with the text or symbol specified.

7. Click OK.
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Export into a File

1.

188

To export a TXT file to the machine, click the Export to File tab and select Enable File

Export.

-
Configure

(S

| Export through RS232 | Exportto File | Other

Path

DAGV-VMSILPR\Export

File Extension

bt

Export Content Format Setting

Select Export ltem

V| Add data to the end of the existing export file

File Mame Setting
@ Fixed File Name

LPR_EventLog

) User Define

Define File Name

Figure 13-13

Select a storage Path to store the exported file by clicking the ... button.

Under File Extension, you can change the default txt file extension if needed.

To select what items to export, click Select Export Item button.

Select Export Item
Select Recognition ltermsa to Expaort

[7] Gelect All

Recognition Tirme Export Farmat

X

|?’I3DI2D13 21:5917

Export [term
Recoagnized Flate
Licenze Plate
Flate Region
Fecognition Confidence
MMeszages

Lane

Drrive Direction
uTc

Local Tirme

Lane Camera

Flate Region Export Format

\width and Height

Figure 13-14

a. Select the items you want to export.
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Use the Recognition Time Export Format to select how you want to display the

Use the Plate Region Export Format drop-down list to specify how you want to
display the position of the license plate detected.

b.

recognition time.
C.
d. Click OK.

Under File Name Setting,

You can use a Fixed File Name.

To define your own file name, select User Define and click the Define File Name

button. Next, select the data you want listed in the file name.

File Name Setting

X

Recognition Time Export Format
Export lkem Sample Value Export lterr ~
Recoanized Plate GEO789 Year
License Plate GEOBES Month
Plats Region 160147 Day
Recognition Confidence 099098097096095094 Haur
Messages 21 kinute
Lane 2 Second s
Drive Direction a
TG 20130814035155390
Local Time 20130814115154380 Flate Region Expart Format
Lane Camera 1
Wwidth and Height A
Auiliary Information Setting
[¥] Add prefix
EVEMNT_
Separate items by
[ Add suffix
Preview EvEMT_GEOVEY_GECESS_160147_0899095097096095084_21_2_ 0 201308140351 59380_201308141151
QK | l Cancel

Figure 13-15

6. To add the new export data to the end of the existing export file, click Add data to the
end of the existing export file. If this option is not selected, the old data will be

overwritten.

7. Click OK.
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Customize a Storage Path for Captured License Plates

1.

190

Click the Other tab.

-
Configure

Export through RS232 | Exportio File | Other |

Path for image databasze

D:GV-YMS) Select |

Figure 13-16
Click Select to select a folder for storing captured license plates.

Click OK.
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13.3 Adding Standalone LPR

To add standalone LPR devices to GV-ASManager, follow the steps below.

e Step1 Enabling Connection with GV-ASManager

Enable connection with GV-ASManager, exemplified using GV-DSP LPR / GV-LPR1200.
e Step2 Adding a Standalone LPR to GV-ASManager

Establish the communication between a standalone LPR and GV-ASManager.
e Step 3 Configuring a Channel

Configure the recognition conditions of a camera channel.
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13.3.1 Step 1: Enabling Connection with GV-ASManager

To enable connection with GV-ASManager on GV-DSP LPR / GV-LPR1200, first make sure
a SD card is inserted to the standalone LPR and formatted. Next, go to the Web interface of
the standalone LPR and follow the steps below.

1. In the left menu under Events and Alerts, select Registry Database. This dialog box

appears.

Registry Database Setting
Registry Database

In this section you can set registry database and compared mode.

[¥] Enable Registry Database (SD storage is necessary)

Database Control by ‘Standalone

Registry Database Comparison |_Comp{ete (All Characters Match) v/
Apply |
Figure 13-17

2. Select Enable Registry Database.

3. Select AS Manager for Database Control to allow the vehicle database transmitted from

GV-ASManager and save on the memory card.
4. Use the Registry Database Comparison drop-down list to select one of these options:

B Complete (All Characters Match): License plates are only considered as

recognized when all characters are matched.

B Like (One Character Mismatch): Recognition results can tolerate 1 mismatched

character not being the first or the last character.

B Somewhat Like (Two Characters Mismatch): Recognition results can tolerate 2

mismatched characters not being the first and the last character.

5. Click Apply.

To set the Recognition Engine and recognition conditions, recognition sensitivity for example,
refer to the Detection Mode and Recognition Engine Settings in Chapter 4 of the GV-DSP
LPR User Manual, and Chapter 4 of the GV-IP LPR Camera User Manual.

To open a gate when the detected license plate is recognized as a registered vehicle, refer to
Output Setting in the GV-DSP LPR User Manual and the GV-IP LPR Camera User Manual to

see how to set the gate as the output device.
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13.3.2 Step 2: Adding Standalone LPR to GV-ASManager

1. On the menu bar, click Setup > Devices. The Devices dialog box appears.

2. Under Device Group, define a group for the controller to be added. Otherwise, use the

Default group.

Note: The devices (Controller, LPR, I/0O Box and Camera) under the same Device Group will

be applied with the identical settings of Time Zones, Weekly Schedules, Access Groups,

Holidays, Door Groups and Parking Lots.

3. Right-click LPR > New LPR.

'{;-:é Devices [Controller: 4 ports (4 free ports included), GV-Patrol: 0 ports]

0@ OCOQA T =B p
Device Group Default
Default Device D Madel

B ﬂ Controller

g New LPR

12

+

- 3 Camera

Figure 13-18

4. Type ID and Name of the LPR device, select Standalone LPR and click OK.

Plez .' I?-;

Standalone LFR

Figure 13-19

'| 0K
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5. Set up the following connection information.

=4 LPR Setup
General Setup  Lane 1

General
Device Group : Ciefault
Device Name : |GV-LPR2811-DL |

Connection
IP Address : |192.168.0.89 | &
User : |admir| |
Password : |uuuou |
Hitps Part : 443
VSS Port -
Number of Cameras : 1 ~

Figure 13-20

[Connection] Type the IP Address, User Name and Password of the standalone LPR
You can also click the Search button to search for standalone LPR in the same LAN.

B Https Port: The default value is 443.
B VSS Port: The default value is 10000.
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13.3.3 Step 3: Configuring a Channel

1.

2.

3.

To configure a channel, select the Lane 1 tab. This dialog box appears.

4| Monitor
Recognition Region Setup
Lane Name; Lane 1 |
Camem 1 |
Recogrition Camera; R - i
lecogniion: EoY =]

1. | Camera 1 3. | None ’_

= . @

Playback Camers | Mone | [T

Quevew s  Deyed st

1 iNDene = |0 Sec(0~60)

. Sec(™60)

3 Sec{i™60)

4 Sec(0™E0)

5 Sec(0me0)

[ Sec(0™60)

Drive Direction: Incoming -

Authentication Schedule "=
Card Reader: None .
L

Figure 13-21
Select Monitor to enable the following settings.

[Playback Camera] The playback camera needs to be from GV-DVR / NVR / VMS and
GV-DVR/NVR /VMS needs to be added to the camera list in GV-ASManager. When you
select an event in the monitoring window, GV-ASManager can play back the camera view
recorded at the time of the event. See 5.5 Retrieving Recording Video for details.

[Overview Camera] Select up to six Overview Cameras to capture the overall
appearance of a vehicle. The overview cameras must be from GV-DVR / NVR / VMS with
GV-LPR Plugin installed and the Enable Overview Camera Service function enabled
(see Figure 13-5).

[Drive Direction] Select Incoming to assign the lane as the entrance of the parking lot or
select Outgoing to set the lane as the exit of the parking lot.

[Authentication Schedule] Optionally, set up the schedule for different access modes at
different time periods. By default, it is License Plate Mode that requires vehicles with
authorized plate numbers to be recognized for access granted. See the same function in
13.2.3 Step 3: Configuring a Channel.

[Recognition Region Setup] Define the recognition area for the camera if needed.
[Card Reader] See the same function in 13.2.3 Step 3: Configuring a Channel.
Click OK.
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Recognition conditions, area, and associated output device can be set up on the Web

interface of the standalone LPR. Refer to the Recognition Engine Settings section in Chapter
4 of the GV-DSP LPR User Manual and Chapter 4 of the GV-IP LPR Camera User Manual.

Note:

1. The Playback Cameras need to be set to recording in GV-DVR / NVR / VMS in either
round-the-clock mode or upon motion detection.

2. The Overview Cameras need to be set to round-the-clock recording in GV-DVR / NVR /
VMS.

3. To ensure optimal performance, the total number of Overview Cameras supported in a
GV-DVR / NVR / VMS is limited based on the resolution of the cameras:

Overview camera
Overview camera
Overview camera
Overview camera
Overview camera

Overview camera

: D1 = maximum 16 overview cameras

: 1 MP = maximum 8 overview cameras
: 2 MP = maximum 4 overview cameras
: 3 MP = maximum 3 overview cameras
: 4 MP = maximum 2 overview cameras

: 5 MP = maximum 1 overview camera
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Once you have set up the PC LPR or standalone LPR, you will need to create a vehicle
database. The detected license plate numbers must match those of registered vehicles

before access can be granted.

1. There are two methods to add a vehicle:

When an unregistered vehicle is detected, the message Plate Recognized:
Unregistered Vehicle or Plate Not Recognized is displayed. Right-click the message

and select New / Edit Vehicle. The Adding a New Vehicle dialog box appears (Figure
13-22). Then follow Step 3 to complete other settings.

On the menu bar, click Personnel > Vehicles. This window appears.

=1 Wehitle List

ey

Search by | License Plate

&~ M- & '
—_— —_ e =
Import Hpioft User Define Fields Setting Refresh
v| Auto Selectl Filter Wigw

License Plate

User

Brand

Maodel Calar Ticket Wehicle 5ta..

{1

Activation Date

Deactivation

Total Vehicles:

Figure 13-22
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2. Click the New button on the toolbar. This dialog box appears.

Add a new vehicle

User:

License Plate:
Brand:

Model:

Color:

Ticket:

Wehicle Status:
Wehicle Type

[] Activation Date:
Time:

[ ] Deactivation Date:

Time:
[J Auto Inactive (Days):

Card Number:
Card Code:

Assign Access Groups:

A3

B ELE

4F

4k

Wiegand26

Vehicle User Defined Field 01: |

4]

Vehicle User Defined Field 04: J

4]

Vehicle User Defined Field 02: |

K3

Wehicle User Defined Field 05: ]

L]

Vehicle User Defined Field 03; |

&

“Wehicle User Defined Field 06: |

4]

Device Group

Access Group

|E2| Copyto User Define

Defautt

Default

=l| GV-LPR28B11-DL

| Lane 1 Z4-hour restricted

3. These settings are available:

Figure 13-23

B User: Click the Assign User button @ to assign the vehicle to a user.

B License Plate: Type the license plate number of the vehicle.

B Brand/Model / Color: Specify the brand, model and color of the vehicle if needed.
B Ticket: Type a note for your own reference.

B Vehicle Status: Set the vehicle status to be Active or Inactive. The Deactivation
Date, if enabled, will override the selection here.
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Vehicle Type: Set the vehicle type. If the vehicle belongs to a visitor for temporary
access, select Visitor.

Activation / Deactivation Date: Specify the date to activate or deactivate the
vehicle access.

Auto Inactive (Days): When the vehicle access has not been recognized for the
specified days, it will be deactivated.

Card Number: Type or select a card number. If you have the GV-PCR1251 / 1352
Enrollment Reader installed, click ™= to detect cards.
Card Code: Select the code format of the card.

Vehicle User Defined Field: For details, see 4.6.2 Customizing a Data Field.

Assign Access Group: Select Device Group and then click its Access Group
drop-down list to assign one predefined access group. For details, see 4.5 Adding
Access Groups.

Lane: The Lane box displays the associated lanes with Access Groups.

Tip: For first-time users of GV-ASManager, you can click the Copy to User Define button

and select 24-hour access for each Lane for test run.

Assigri Access Groups:

Device Group

Access Group

Defautt

User Define

= GV-LPR2811-DL

Lane 1

249-hour access

Figure 13-24
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To assign multiple vehicles to a user, on the menu bar, click Personnel > Users. Next to
Vehicle List, click the Add button to assign vehicles to the user.

User Setup [@]
Gieneral | Hane | Busingss | User Dsfre | Frgerpint | Son |
First Mame tiddle M arre: Last Mame:
[Merbre || Apelido
Dizplay Employes D
#palide Hombre | [orztezRer |E]
Caid Lt
(032 344359

Wehicle List Qe f

[(I5erd5ms

[ ata Group:
Hao Groups: |

Figure 13-25

You can also import and export vehicle data in mdb, xls or xIsx format. Refer to 4.3.4
Importing / Exporting Card Data for similar settings.

13.5 Monitoring LPR Activities

13.5.1 LPR View Window

The LPR view window displays the connection status of the connected LPRs. To open the
LPR Device View, click View > LPRs.

[ v

LPR Status
- gﬂ TESTEE-AZ564250
v LLLPR1
O LiLane 1
h 2 Lane 2
h diLane 3
h 4; Lane 4
h Silane 5
h 6: Lane &
A Tilane 7

Ay @ilane s

Figure 13-26
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Right-click a LPR to access the following options:
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Name Function

Reconnect Reconnect to the LPR device.

Sync LPR Sync the settings between the LPR device and GV-ASManager
immediately.

Settings Access the LPR setup dialog box.

Right-click a Lane to access the following options:

Name Function

Unlock Lane Open the gate barrier. To assign an output device to be the gate barrier for
the PC LPR, see [Barrier Control],13.2.3 Step 3: Configuring a Channel.
For standalone LPR, see the Output Settings section in Chapter 4 of the
GV-DSP LPR User Manual and GV-IP LPR Camera User Manual.

Recognize Force license plate recognition.

Settings Access the LPR settings.

13.5.2 Monitoring Windows

To monitor LPR activities, click Monitoring > New LPR Monitor.

) LPR Munitor =1
T Ea

H=szage

Lere Lecel Time Licerise Plate  Recog..

B Clot Rmcognized: Ureecistered Yahici
iLJ Flab= Recognized: Urregistered vehick
L Flate Recoanizsd: Urrecistersd Vehice
L Flate Recoanized: Urredistersd vehice
L Flats Racoanizad: Urredistersd Yahice
i Fats Rarognzad: Ureegistersd vahick
i Flate Rerognized: Ureegistered vehick:
i) Flata Reragnized: Uriegistered vahice
1 Plab= Re=cognized: Urrecistered Vehicke
L Plate Recognized: Urregistersd Vehick
L Flate Recoanizsd: Urrecistersd Vehice
L Flats Racoanizad: Urredistersd Yahice
i Plata Racogniad: Urregistered vahick
i Fats Rarognzad: Ureegistersd vahick
i Flata Reragnized: Urregistered vahice
L Plate Recognized: Unrecistered Vahicle:
iLJFlab= Recognized: Urregistered Vehicke
L Flate Recognizsd: Urrecistersd Vehice
Liplats Recoaniaed: Ureedlstersd vefice

Lists | Ties | Thumbnsis

HALTETE
AT
B
HAAEET
HANIEE

Figure 13-27

For details on the Monitoring Windows, see 3.3 Monitoring Windows.
For details on various LPR events, see “LPR” events, Appendix A
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13.6 Receiving Notifications for LPR Activities

When alarm conditions occur, the system can automatically activate a variety of notifications
to alert the operators: e-mail, SMS, trigger recording, push notification, popup message and

more.

To set up the natifications for LPR events, click Tools > Notifications. For details, see 8.2.3

Setting up Notifications.

13.7 Setting up Vehicle Hotlist

The vehicle hotlist is a list of stolen vehicles or vehicles of interest. When any vehicles on the
hotlist are recognized, the system can trigger various notifications to alert the operators.
There are two ways to add vehicles to the hotlist: manually add vehicles or import from an
external database. Up to 2-million vehicles can be added to the vehicle hotlist.

13.7.1 Setting up the Hotlist Database

To import from an external database, you need to complete the steps below first.

1. Run ASDBManager.exe from the GV-ASManager program folder at :\Access
Control\ASManager\.

202



License Plate Recognition

Select Settings from Source to ASManager Database > Set the mapping relations for

vehicle hotlist. This dialog box appears.

Set the mapping relations for vehicle hotlist.

]

Set the mapping relations for vehicle hotlist, ,".w_j.f]

Source Databaze [E weel v]
Select a source table ; | [Sheet1$)] w |

Field Mame Figld Type <-» | Field Mame Field Type

E| Licenze Plate i arChar < [Plate] WarChar

E| Group Mame rivfarChar <-»  [Group] WarChar

E| Memao i arChar <-»  [Memo] WarChar

< [

Immediate Yigw [0~100)
License Flate Group Mame tdema

| Ok | [ Cancel

Figure 13-28

Use the Source Database drop-down list to select an excel database or another type of

database.

Next to Select a source table, select the appropriate tab in the database.

Match the License Plate, Group Name and Memo to the appropriate fields.

Click OK to import.
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13.7.2 Adding License Plates to the Hotlist

On the menu bar of GV-ASManager, click Tools > Hotlist. This dialog box appears.

455 Yehidle Holist [

G Vehicle Hofist
TRl paRE [r—— - b 4

Kame Licanas Pzt Mams i
Hepwend

Defat

Zan Frarcisco

Vehicle

Aurto updiate of hothst will ot execute when hotist 15 apened.

Figure 13-29

If you have imported data from an external database using ASDBManager, you will see these
vehicles are listed under the Default group. You can also add license plates manually, import
existing license plates from the vehicle list or create keywords (for partial license plate
numbers).

Adding License Plates Manually
1. Under Group on the left pane, click Add 2 to create a group first if needed.

2. Under Vehicle Hotlist on the right pane, click Add 2, type a License Plate, and add a
Memo, for example, to note the stolen time and location.

Adding & New Wehicle

Licenze Plate: F1234567
M emo:

Stolen 20131247, Macdthur Blvd and San Pablo Ave.

Add

Figure 13-30
3. Click Add.
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Importing License Plates from Vehicle List

1. Toimport an existing license plate from the vehicle list, under Vehicle Hotlist on the right
pane, click the Import button . This dialog box appears.

= |mport license plates from vehicle list

Search by | License Plate vl | Auto select Fiter view Select
License Flate User Brand Iodel Color Ticket wehicle Sta...  Activation Date Deactivation Date  Access Group
L ADETES432 Crange Ackive 12/24/2013 2:53:00 PM

L AZ3456TE Black Ackive 12)24{2013 2:52:00 PM

0 345679 @ray Active 12}24/2013 2:53:00 PM

S ATES43129 Orange Active 12/24/2013 2:59:00 PM

Total Yehicles: 4

Figure 13-31

2. Select the vehicles you want to add, and click the Select button to add.

Setting Keywords for Partial Match

You can create keywords, which are partial license plate numbers.

1. Select Keyword under Group on the left pane, and click Add &) under Vehicle Hotlist
on the right pane.

Group ehicle Hotlist

© ©=h ole @ | License Piate =] ¢
Name License Plate Memo

[repwod ] “Ba4s"
Default

San Francisco

Figure 13-32
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2.  Under Add a New Keyword, type a partial license plate number to be Keyword.

Add a New Keyword
Keyword:

Mema:

ELE2E

Figure 13-33

3. Click Add. License plates that contain the keyword will be highlighted on the screen of
GV-ASManager.

When GV-ASManager recognizes a license plate that matches a license plate or a keyword
in the hotlist, the vehicle will be highlighted in red in the LPR Monitor window as shown below.

4 b X

), LPR Menitor |

T k@

Jefault
Plate Recognized: Registered Vehicle

B84406A L/2/2014 40305 PM

Figure 13-34

To trigger notifications when any vehicles on the hotlist are recognized, on the menu bar, click
Tools > Notifications to create an alert approach, and select Hotlist from Event Type. For

details, see 8.2.3 Setting up Notifications.
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13.8 Managing Parking Lots

With the parking lots management, you can regulate which vehicles have the permission to
enter the parking lot, parking space availability, parking duration allowed, anti-passback, and
parking spaces shared by more than one user.

Note: For the parking lot functions to work properly:
1. GV LPR device must remain connected to GV-ASManager.

2. The time of GV-ASManager and GV IP device must be synchronized to the same NTP
server.

3. The function is only supported by the following versions and devices:
o  GV-ASManager V4.3 or later
e  GV-DVR LPR with GV-LPR Plugin for GV-DVR / NVR V8.6.0.0 or later
e  GV-VMS LPR with GV-LPR Plugin for GV-VMS V15.10.0.0 or later
e GV-DSP LPR firmware V2.1 or later
e  GV-LPR1200 firmware V1.12 or later
e  GV-LPR2800-DL firmware V1.0 or later; GV-LPR2811-DL firmware V1.1 or later

13.8.1 Setting up a Parking Lot

1. On the menu bar, click Setup > Devices, and select a Device Group. The devices under
the Device Group will be applied with identical Parking Lots settings.

2. Select Parking Lots on the left of the Devices dialog box. The Parking Lot List dialog box
appears.

3. Click Add 2. The Please Enter ID dialog box appears.
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4. Type a Parking Lot ID and name the Parking Lot, and click OK. This dialog box appears.

W4 Parking Lot Setup - Default X
General Setup
Parking Lot 1D ; 1 | Parking Space Count: 100 |
Parking Lot Name : Parking Lot 1 Parking Lot Mode: Enable w
Max. Stay Time Allowed : 0 day(s) [ Access denied i overstayed
00:00 = Arti-Back Time: |ﬂ Secondis}
[] Anti-Passback By User
Shared space
Lane Setup
=3 Incoming B LPR1
=] Qutgoing e ‘!;J Lane 1
= = LPR2
L 14 Lane 1
< Add
o

Figure 13-35
5. Under General Setup, the following settings are available.
B Parking Lot Name: Rename the parking lot if needed.

B Parking Space Count: Define the total number of parking spaces available in the
parking lot. When the parking lot is full, entry to the parking lot will be denied unless
you manually open the gate from Parking Lot Monitor.

B Parking Lot Mode: By default, the Parking Lot Mode is enabled. When No
Incoming is selected, no vehicles can enter the parking lot but outgoing vehicles
will be allowed. When Disable is selected, no vehicles can enter and exit the
parking lot.

B Max. Stay Time Allowed: When enabled, vehicles that stay in the parking lot
beyond the maximum stay time will be highlighted as “Overstayed Vehicle” in
Parking Lot Monitor.

B Access Defined if Overstayed: Only works with GV-LPR Plugin V6.0.2 or later.
When enabled, unregistered vehicles that overstay in the parking lot are unable to
exit.
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Anti-Back Time: Specify the time interval in seconds the same license number is
prohibited from entering or exiting the parking lot.

Anti-Passback by User: Only allow one vehicle of a user entering the parking lot
when the user has more than one registered vehicle.

Share Space: Set up Share Space if multiple vehicles are sharing the same set of
parking spaces.

a. Under Share Group, click Add % to create a group.
Share space @

Share Group Group Setup

Qe

Share space count: 7 [0=10000)

tame

B1_Comparmd,
B1_CompanyB Vehicles

BZ2_ComparyC _
B2_ComparyD @@
B2 CompanyE Flate Wurnber
ABD9315
ADFE27E
ApL3E12
AMDO395
AMF3108
ARFS31A
BMD307E
RMDY7E0
EO45HPH

Figure 13-36
b. For Share space count, type the number of parking spaces shared by that
group.

c. Under Venhicles, click Add =2 to select the license plate numbers that share the
set of parking spaces.

In the figure above, company A has 7 allocated spaces in the parking lot that are
shared by 9 employees, each with a registered vehicle. The first 7 vehicles in the
list will be able to enter the parking lot, while the remaining 2 vehicles will be denied
access even if there are other empty spaces available in the parking lot.
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6. To assign an LPR lane as the entrance of the parking lot, select Incoming on the left
pane, select an LPR lane on the right pane, and click the Add button.

Lane Setup

bd INCOMminG

2 Uutgoing

K

Figure 13-37
7. For exit, select Outgoing, select another LPR lane, and click the Add button.
8. To set multiple incoming and outgoing lanes, follow the steps above.

9. Click OK.

To trigger notifications upon Parking Lot events, on the menu bar, click Tools > Notifications
to create an alert approach, and select Parking Lot events from Event Type. For details, see

8.2.3 Setting up Notifications.
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13.8.2 Monitoring Parking Lots

Using the Parking Lot Monitor, you can see a list of vehicles that have entered and exited the
parking lot, along with their snapshots and information. You can also manually add or remove
a vehicle, and manually open the parking gate.

® On the menu bar, click Monitoring > New Parking Monitor.

® Select a parking lot and click OK. This window appears.

Select a parking lot

Auto select Vehicles inside or entering the parking lot
Search license plate
El“"'lun El -I-:.--E--'
Q|
| Search |
Licenie Plete  Skatus ay Time Lozal Time Huat: Tirre L Flate Rumibe'; Pha  Bleirage o

B OEIATTH | Webicle Stayed T Dyl (3144 B0 1502409 J RA00015 15:0F | LARMLE LE0EANM Fiabe Fecognivesd: Reqirterad Ve

S EITANEA ehicle Stayed 2 Dt 073140 102015 150234 . 201002045 1802 2010015 Ddiis Abd Fiat: Fecagaized: Registered Yy

= MGG

Mebicle Sayvd §Daea) D315 o 11 Fcd 1 i B | R O [ Pl 13 T T | il ] 1 R FE LR 8 Plate Facogmied; Registerad vyl

% BI0ESC Webicle Stayed 2 Daish (IL25 A0S IH0EAT . 2A00dS 10z 2iLDA013 200002

Fiats Recognized: Registerzd Wy

wihigle Cronestayrd

11 Crai 3 00 48 SRS SR P 008 53013 A8 23237 A% Parting Bocess Granted; Marss

[l il '

License Plete  Smtus Stay Time Larz Le<al Time Hast Time T hizsrage *

& ZEB53 Wenicle Boted DE03353 Lane L 21372005 1E04:39 , 3RL0/20L5 Ak, 2rL0020L15 k20 Al Plete Recognized: Registered Ve

S50 Wemicle Boted DE02452 Lane 1 20102015 100435 . 2P0/ 3005 20D, 20 EILE B0s s And Plate Recognized: Registered Wi

S MIZUMARS, Mebucle Exted %0331 Lane 1 Z/1AF2005 LEOATE 2708005 10:04:,, 2FL0VEILS LNk L1 Add Plste Recognized; Regisbered Ve

o K448 Wehicle Bated DE02S3 Lane 1 21132015 100447 - 30205 0B PL0EILE B0L0T And Plate Recognized: Registered Vel o
N n #

I Parking spaces count: 107 100 I

I
History: Vehicles that have exited the parking lot Current vehicle count
and vehicles that have been denied access

Figure 13-38

Vehicles inside the parking lot are listed in the top half of the Parking Lot Monitor.
Vehicles that have exited the parking lot or have been denied access are listed under
History in the lower half of the window. You can also use the Search function to search
for license plates.
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® To add a vehicle to the vehicle list,

a. Right-click the top half of the Parking Lot Monitor.

b. To add a vehicle already inside the parking lot to the vehicle list, select Add. If a
vehicle is unable to enter the parking lot due to incorrect license plate recognition,
you can select Add and Open Gate to add to the vehicle list and open the gate for

the vehicle at the same time.

Mew/Edit Wehicle. .

0 BTTITEA

| ]

Wehicle Stayed 2 Dayis) 07:31:42  Lanel 210201

Madify Plate Mumber...
0 BT9E3EC  Wehicle Stayed 2 Day(s) 073133 lanel /10200 v
S0 BT9B4SC MWehicle Stayed 2Day(z 07:31:25  Llanel 2/10/201 Add and Open Gate
Remove

Laned | 2712015
Remove and Open Gate

= BT042TH | Mehicle Stayed 2 Day(s) 07:31:48 /1042015 10:02:09 | 21042015 10:02:] 2/1042015 2:02:0

Figure 13-39

c. Select the entrance lane, type the license plate number, and select the entrance date

and time.

i) &dd Parking Wehicle

Flate Humber |
Date: 212/2M5 E

Tirne: 5:29:09 P =

Figure 13-40

Note:

1. If the vehicle had to be manually added because its license plate is not in the

GV-ASManager database, make sure to click New/Edit Vehicle to add the vehicle to

the database, or else the vehicle will be unable to exit the parking lot.

2. Ifthe license plate is incorrectly recognized, you can click Modify Plate Number to edit

the plate number.
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a. Right-click the top half of the Parking Lot Monitor.

b. To remove a vehicle that is no longer inside the parking lot, right-click the vehicle in

the list, and select Remove. If a vehicle is unable to exit the parking lot due to

incorrect license plate recognition, select Remove and Open Gate.

c. Select the exit lane, and select the exit date and time.

You can click View on the menu bar, and select Info to see information and snapshots of the

selected vehicle.

Info

)

Vehicle Exited

User Photo:
License Plate:
Stay Time:
Lane:

Lecal Time:
Host Time:
UTC:
Message:
User:

Incoming Info.

K328002

00:03:52

Lane 1

2/10/2015 9:59:30 AM

2/10/2015 9:50:30 AM

2/10/2015 1:59:30 AM

Plate Recognized: Registered Vehide

Figure 13-41

Outgoing Info.

Lane 1

2/10/2015 10:03:22 AM

2/10/2015 10:03:22 AM

2/10/2015 2:03:22 AM

Plate Recognized: Registered Vehicle
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13.9 Calculating Average Speed

You can get a vehicle’s average speed between two set points on a road, measured by two

LPR devices at each point.

1. Onthe menu bar, click Setup > Devices. The Devices dialog box appears.

2. To setalane as the end lane, right-click a LPR device > Settings. The LPR Setup

dialog box appears.

3. Under Speed Calculation, configure the following settings.

Speed Caculation

Starting Lane: None -
Interval Distance ' m

Speed Limit km/h

m Starting Lane: Select the lane from where the travel starts.
m Interval Distance: Specify the distance in meter between the starting and end lanes.

m Speed Limit: Specify the speed limit in km/h.

13.10 LPR Functions on GV-ASWeb

Using GV-ASWeb, you can connect to GV-ASManager over a network and remotely access

the following LPR functions:

e LPR List: Add and delete an LPR device to and from GV-ASManager.
e Vehicle List: Add, delete, edit and search for vehicles.
e LPR Log: Search the records of license plates recognized and play back recordings.

e Parking Lot: Set up parking lots. See 13.8 Managing Parking Lots for details.

See 10.1 Connecting to GV-ASManager for how to log into GV-ASWeb.
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13.10.1 LPR List

You can use the LPR List to remotely add and delete an LPR device to and from
GV-ASManager.

On GV-ASWeb, click LPR List. This window appears.

| &= LPR List = =S

-
L]

SN LPR List

¥ & % mformation

Lane
c Mo items for display.

DSP_LPR

A"v" Lane 1

Page 1 of1 =

Figure 13-42

Click Add ‘= to add an LPR device. For details, see 13.2.2 Adding PC LPR to
GV-ASManager and 13.3.2 Adding Standalone LPR to GV-ASManager.

To set up individual channels, click Edit "“# and select a channel. For details, see
13.2.3 and 13.3.3 Configuring a Channel.

To delete an LPR, select an LPR and click Delete &'

Note: Any changes made on GV-ASWeb will be reflected in GV-ASManager.

215



Q GeoUision:

13.10.2 Vehicle List

Vehicle List allows you to remotely add, search, edit and delete vehicles.

1.  On GV-ASWeb, click Vehicle List.

2. Click New . This dialog box appears.

=2 Adding a New Yehicle = |[=] |
Yehicle A
User: Bolton M & | &
License Plate: 12345678 Photo: B8
Brand: b
Model: b
Colar: v
Ticket: b
wehicle Status: Artive hed
[] &ctivation Date: E ¥
[] Deactivation Date: E ¥
Data Group: Mo Groups b
Access Group: Defalilt ol
Lane Schedule
= E2LPR 1 (8 Lanes)
P 24-hour restricted
JjjLane 2 24-hour restricted
Jjjlane s 24-hour restricted
JjjLane 4 24-hour restricted
JjjLanes 24-hour restricted Z
Cik Cancel

Figure 13-43
3.  Fill out the required information. See 13.4 Adding Vehicles for details.
4. Click OK to save the settings.

5. To delete a vehicle, select the vehicle and click Delete @.

Note: Any changes made on GV-ASWeb will be reflected in GV-ASManager.
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Using LPR Log, you can look up a record, see snapshots of recognized license plates, track

the locations of vehicles and play back recorded videos.

Defining Search Criteria

You can narrow down the search results by setting search criteria such as LPR lanes, date,

parking lots, and license plates.

Under Filter on the left, set the search criteria and click the Search button. For example, we

want to search for the records that match the conditons of “Unregistered Vehicle”, license
plate number “FM-0505", and detected by LPR 1. The resulting filter window may look like

this.
= LPR Log -iofj=
E
£.° LPRLog
Filter Export = View Moge =
4 log Message Lane Lecal Time License Plate Recognized Plate
Message: | Flata Recognizad: Unr | €3 Piate Recogrized: Unregistersd Yeh. Lanel 26/2016 35217 AWM k335533 K335533

Lane:

fraz:
Direclion:

Stay tima from:
o

Parking Lot:

Hotlist Group:

Date Penod:
Start Date:

End Date:

The least court log:
St By
Diraction:

LPR1-Lanel e

v

Injont h

~

Ciate Range
a3for/2017 [ | D300
o507 |8 | 2358

« Group by licence plate

[] Erabie

[ ] registered vebidle first

<

<

Mo st 1o displsy

If Fuzzy Matching is selected, the letters below will be recognized as numbers:

Figure 13-44

B Letter B will become 8

B Letter O and D will become 0 (Zero)

B Letter S will become 5

Letter Z will become 2
Letter | will become 1

Letter G will become 6
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When a license plate number is typed in the Recognized Plate field, you can apply Fuzzy
Matching and the Matching Mode you set will be applied as well (e.g. Allow 1 mismatched
character). When a license plate number is typed in the License Plate field, only the license
plate that matches completely will be displayed in the search results.

Tip: When searching license plates,

1. You can include question marks in a license plate, for example OP9875, to represent any
character or number.

2. You can add an asterisk at the end of a partial license plate, for example OP98*, and any
plates that start with OP98 will be displayed.

The Search Results Window

Below is an example of the search results window.

=/ LPR Log = =]
migi LRL
¥ Export; TXT This Page oK
Meszage Recognized.. Licens.. Lane Local Time Plate Number's Photo Recogntion Camera Overview Cameral | Owervi. Owver.. User
|  Plate Recog... OIZNP DZNP LPR1-Lane1 212012 3. IA'

%EI
I Plate Recog... (ZNP DIZNP LPR1 -Lane 1 S212012 3.

3 Plate Recog... [M1Z2HP M2HP LPR1-Lans1 S2120M23..

4 Plate Recog... 0PDZ2E DPG2EE  LPR1 -Lans1  921/2012 3. “ e BE
5 Plate Recog... 0P335 IPI3E5  LPR1-Lane1 9212042 3. J NP~ 7 B B8 E
(4 4  Pege| 1|ofazs| b B |2 Dieplaying 1 - 30 of 12342

Figure 13-45

A snapshot of the recognized license plate will be displayed.

: Indicate the availability of the video image.

You can right-click each search result to access more information such as vehicle information

&, user information @3 or log information (for parking lot).

For how to export logs, see 70.6 Setting up Export Schedule for Lists and Logs for details.
For how to define the displayed columns of the search results window, see 10.4.4 Defining
Columns for details.
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Note: For remote playback to work on the PC LPR, you need to enable Remote ViewLog
Service on it.

Obtaining the Locations

If the license plates of vehicles that have entered and exited the monitored areas are

recognized in the connected LPR cameras, their driving routes can be displayed on the map.

To track the locations of those vehicles, click View Mode in the top-right corner and select

Map Mode. For details on pinning the locations of the LPR cameras on the map see 10.12

Creating Maps.

Export~ |View Mode~x | _

late

Lists

Lists with Snapshet(180 x 120)
Lists with Snapshet(320 x 240)

Lists with Snapshot(640 x 480)

Map Mode

Map Satellite

Go.‘gie -_

Export~ ‘iew Moder

- EHaER
o 9
35
& ~Ta
. Newj -
! . Taipei City
Taoyuan City perisy
37 “Dongyanshan
National Forest
“Recreation
Area i
G ' +

Map data 82017 Google  10km L1 Terma of Uss = Report 2 map error

Figure 13-46
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Chapter 14 Face Recognition

The Face Recognition function allows GV-Face Recognition Camera and GV-Al FR software
to connect to controllers, acting as extended readers, to grant access when the faces
recognized and their paired access data match the users registered in GV-ASManager’s

database.

0 + T |
I-_‘Fé

GV-Face Recognition GV-FWC E
Camera

GV-Controller o

o |
LT _p—— —-—
\ GV-ASManager

f—

GV-Al FR

Figure 14-1

e For integrating face recognition using GV-Face Recognition Camera, see 14.1 GV-Face

Recognition Camera.

¢ Forintegrating face recognition using GV-Al FR software, see 14.2 GV-Al FR.

Note:

1. Before integrating the face recognition feature, make sure you have a controller capable
of connecting to extended readers properly set. See 4.2 Adding Controllers.

2. GV-FR Panel (reader) also supports access control with face recognition. For details,
see GV-FR Panel User’s Manual.
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14.1 GV-Face Recognition Camera

When integrating GV-Face Recognition Cameras to GV-ASManager, a GV-FWC is required,
which receives and converts face recognition into access card data to be sent to the
controller upon recognition. To set up GV-Face Recognition Camera, follow the steps below:

e Step1 Configuring GV-FWC

Configure GV-FWC for communication. See 2.3 Accessing GV-FWC and 3.1 Configuring
for Communication on GV-FWC in GV-FWC Installation Guide.

e Step2 Connecting GV-Face Recognition Camera to GV-FWC

Connect GV-Face Recognition Camera to GV-FWC. See 3.2 Sending Face IDs from
Camera in GV-FWC Installation Guide.

e Step3 Connecting GV-FWC to GV-AS Controller

Connect GV-FWC to the controller. See 3.3 Receiving Access Card Data by Controller in
GV-FWC Installation Guide.

o Step4 Adding GV-Face Recognition Camera to GV-ASManager

Add GV-Face Recognition Camera to GV-ASManager. See 14.1.1 Adding GV-Face
Recognition Camera.

Note: To add users into the necessary databases for face-recognition-based access
management, see 14.3 Managing Face Recognition Access Data.
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14.1.1 Adding GV-Face Recognition Camera

In the Devices dialog box (Setup > Devices), double-click the controller that GV-FWC is

connected to and select a Door. The following window appears.

Controller Setup
M Settings General Advanced Other
Controller Setup
Door 1 Name: Door 1 Common Password : vene 4~8 digits(0~9)
[ Door2
[] Door3
[ Doors Estended Reader
Input
Entrance GV-VD8700 / GV-FD8700 ~ Exit GY-VDB700 / GV-FDE700 ~
IP: Q IP Q)
Fort : 80 Fort : 80
V55 Port : V55 Port :
MAC Address 0 o MAC Address o
Account Account
Password : Passward
Camera Mapping
Camera 1 Camera 2
Binding Extended Reader LAl Binding Extended Reader ~| |
Delayed snapshot: ] Sec(l~60) Delayed snapshot: 0 Sec(0~60)
Figure 14-2

1.  Under Extended Reader, select GV-VD8700 / FD8700-FR from Entrance or Exit

drop-down list, according to the access scenario.

2. Under the drop-down list used, type the connection information of the face recognition

camera, such as IP and login credentials.

3. Under Camera Mapping, select Binding Extended Reader from Camera 1 or Camera
2 drop-down list.

4. Click OK.

5. To create face recognition data and transfer it back to the camera, see 74.3 Managing

Face Recognition Access Data.

Note: For other Door settings, see 4.2.2 Step 2: Configuring Doors or Elevator Floors for

details.
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14.2 GV-AlIFR

GV-Al FR is video analytic software designed to provide face recognition for up to 8 camera
channels. To integrate GV-Al FR into GV-ASManager for face-recognition-based access
control, follow the steps below:

Note: The following procedures are only applied to GV-Al FR V1.2.0 or later.

1. In the Device List dialog box (Setup > Devices), double-click the controller that GV-Al
FR is to be connected to and select a Door. This dialog box appears.

Controller Setup X
M Sethings OJenerel  fdvanced  Dthex
Confrolier Setup S e —
] Narmns: [Doert Common Paseword : aase | 2-2 digitll-5)

Exended Feader

Entrance GT-ATFR w Ext Hone
P [132.1685.145 g IP:
Port: [0 Port:
T3 Port : g Port :
Sersal Humber - 4 5460041007 MAD Addeess: |-
Aeeomnt - [admin Account:
Pezswoond |_._.i-i. Pazswrord

L 2 & 56 7 8
Figure 14-3

2.  Under Extended Reader, select GV-Al FR from Entrance and Exit drop-down lists,
according to the access scenario.

Type the connection information of GV-Al FR, such as IP and login credentials.
For Camera, select the cameras of GV-Al FR used in the access scenario.

Click OK. GV-Al FR is connected to the controller and GV-ASManager.

o g &~ »

To create face data and transfer it back to GV-Al FR, see 14.3 Managing Face
Recognition Access Data.
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To verify the connection on GV-Al FR:

7. Onthe GV-FWC / Controller Setting page (Dashboard > Notify Settings > GV-FWC /
Controller), you should find an entry, for example, [ASManager] Door 1 (In), written
back from GV-ASManager to indicate which controller IP and door are connected to.

[ASManager] Door 1 (in} 16218 345460041000

Figure 14-4

8. Onthe Event Trigger page (Event Trigger > Notify Settings), you should also find an
entry of face recognition. No matter which types of FR events, recognized or unknown
faces, all will trigger GV-Al FR to send the access data to GV-ASManager.

[ASManager] Door 1 {In} Face Recognition

Figure 14-5

Note: You can map the cameras of GV-Al FR to the corresponding entrance or exit for live
view display. To add a camera, see 5.7 Mapping Cameras for details.
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14.3 Managing Face Recognition Access Data

Once GV-Face Recognition Camera / GV-Al FR is properly set, you need to create a user
database with the required face images and access data.

1. There are two methods of adding face recognition data:

o When an unregistered face recognition event occurs, the message Access Denied:
Invalid Card is displayed. Right-click the message and select Assign Image to a
New User to create a new user to the database.

e Onthe menu bar, click Personnel > Users. The User List window appears.
2. Click the New button on the toolbar. The User Setup dialog box appears.

3. Type a Display Name for the user, which is also the name of the Face ID in the
GV-Face Recognition Camera / GV-Al FR database.

4. To assign a card to the user, click Add = next to Cards.

5. To add a face photo of the user from the PC, which will be used for face recognition on
GV-Face Recognition Camera / GV-Al FR, click on the image column under GV-VD8700
| GV-FD8700-FR / GV-Al FR in the Features tab and select the access card number of
the user in the drop-down list next to the photo added.

User Setup x

General  Home  Busriess U'.'e(Drefne

Fingempent
IP Addreas Padt
GV-0013=205830 521 57 Search

Arii-duroas.
| |
Left hanc: Right hand:
Thumb Thumk:
| = |
| Forefinger: Forstnoer
| =

| Mz srger Middic finger

| =
Firg finger:
| =

Listie Firumess

Fing firger

[ R N IR EX B £N

Litle firger

GY-FR2020 GV-YDBET00 / GV-FDET00 / GV-FR Server

~
R m Jfezs: coz-16523 =l

ok | Cancsl

Figure 14-6

6. Click OK.
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After adding the users, click Setup > Feature Access and select the Door the GV-Face
Recognition Camera / GV-Al FR is connected to.

I Faaturs Acsess (W] >
Faztu Tyoa: @ -

] Certroter 1 Uner Fomren [ — Gk o U Cn
g j"\:" ‘l B Apekcin Noeshire CVAWDERO0 / GWFOE.  DI21E82) ®. o B 2%
=[] v ASTID B abar #®
T8 oser B Laber %
[ -[2% x
W aoe %

From the right column, select the users to be added to the database of GV-Face
Recognition Camera / GV-Al FR and click Add. Once the users are successfully
uploaded to GV-Face Recognition Camera / GV-Al FR, a green tick & is displayed
next to the user data.

IMPORTANT: For GV-AIl FR, all of its camera channels, to which separate Doors may be

connected to, share the same face database, therefore whenever a User is uploaded to or

removed from any of its channels, the same changes will be made to all of its other channels

simultaneously. To prevent confusion, you must upload and remove face data using a

designed door.

Note:

1.

If you are unable to upload User data in Step 7 due to an unstable network, you can
optionally reupload the same data while replacing the current database of GV-Face
Recognition Camera / GV-Al FR by right-clicking the Door it is connected to and select
Sync GV-VD8700 / GV-FD8700-FR or Sync GV-Al FR, see 3.2.1 Controls on the
Window.

For detailed instructions on how to add or batch enroll face photos to GV-ASManager to
be uploaded to GV-Face Recognition Cameras / GV-Al FR, see How to Enroll GV-FR
Device Faces with GV-ASManager.

For additional User settings, see 4.6 Adding Users.
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Note: For GV-ASManager to receive unknown face recognition events, make sure the
GV-Face Recognition Camera is set to send unknown events:

1. Access the Event Manager page (System Settings > Events and Alert > Event
Manager).

2. Inthe Settings tab, enable HTTP Event, select Yes under Send events when faces
are unknown and click Apply.

Settings Http Event GV-FWC

Send face events to

I Http Event @ Enable Disable I

GV-FWC © Enable Disable

Send events when faces in the selected group(s) detected

Authorized
Unauthorized
New Group

Send events when faces are unknown

Q Yes
No

Figure 14-8

3. Inthe Http Event tab, select POST as Http Method, select JSON as Post Content
Type and type the IP address and Port of the connected GV-FWC in the form of
“http://<IP of GV-FWC>:<HTTP Event Port of GV-FWC>" (for example:
http://192.168.4.9:8080) under URL

Settings Http Event GV-FWC

Http Method

POST *

Post Content Type

Form (multipart/form-data)
I © JSON (application/json) I

URL

http://192.168.4.9:8080

Figure 14-9

4. Under Face Recognition Data, click to add the parameters Note2, Group,
Snapshot, Name, MAC and Note1, exactly as illustrated by Figure 14-9.
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Face Recognition Data

Parameter Namea

Parameter Name

Parameter Name

Parameter Name

Parameter Name

Parameter Name

MNote2
Group
Snapshot
MName
AT

Notel

Face Data

Face Data

Face Data

Face Data

Face Data

Face Cata

Noted

Group Mame

Face Snapshot
Name

MAC Addrecs

hotel

Figure 14-10

5. Optionally click Test for testing the connection.

6. Click Apply.

228
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Chapter 15 GV-Access Mobile App

GV-Access app allows you to access up to 5 GV-ASManager systems through iOS or
Android devices. You can watch camera live view, check door status, unlock doors and open

an LPR gate.

For details on the mobile app, visit our website.
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Chapter 16 GV-ASNotify

GV-ASNotify is an application designed to watch live video and communicate with visitors at
the access control site, as well as unlocking doors remotely. For the application to work, the
GV-IP Camera supporting two-way audio or the GV-CS1320 controller connected to
GV-ASManager is required.

If the GV-CS1320 controller is applied, snapshots, messages, alarms can be triggered to
alert the operators when the bell button (touch pad) on GV-CS1320 is activated.

16.1 Installing GV-ASNotify

To download and install GV-ASNofify, go to the Download Page of GV-ASManager and click

4+
the Download icon ™ of GV-ASNotify.

Note: If you do not have Microsoft DirectX End-User Runtimes (November 2008) installed,
download and install from here.
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B cv-asNotify

16.2 Connecting to GV-ASManager

Before GV-ASNotify connects to GV-ASManager, you must enable GV-ASManager to allow
remote access:

e On the menu bar of GV-ASManager, click Tools > Servers > Remote Monitor Server.

When the server is started, the icon = appears at the bottom-right of the main screen.

1. Run GV-ASNotify.exe.
2. To connect to GV-ASManager, click the Add Host button. This dialog box appears.

,3 Add Host S |
Hostname: ASManager-PC2
Address: 192.168.2. 162
Port: 9987
o admin
Password: LTITTS
I Ok | | Cancel
h J
Figure 16-1

3. Type the connection information of GV-ASManager, such as IP and login credentials.

4. Click OK. GV-ASManager is added to the host list.

r'|_'|_|

Unleck

¥ s
O

Add Host Opticns

-8 TESTI98-PC
- [ Controlier
{ A Contrallerl
i1l [ Doorl
(i Controller1

Camera
- Controller

-1m 212

Figure 16-2
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16.3 Utilizing GV-ASNotify

1. Inthe host list, select a camera or GV-CS1320 connected to GV-ASManager to access its

live view.
v

@&

Add Host  Options

1| @y
@:

Sp;;ker

=15 TEST196-PC

L‘—J@ Controller

i g @ Controller 1
=.[ Coorl

: ,@ Controllzr 1
|_—_'|§ Carmera
L—JE Controllar 1
F— Cameral
- 212

;F- Cameral

"r. Controller 1, Carreral

-8 DVR-FE420/FE421(192.168,2.21

= EsE )

Figure 16-3

2. To speak to the access control site, click the Mic button.

3. To listen to audio from the access control site, click the Speaker button.

Note: To use the two-way audio function:

« The device must be GV-CS1320 or GV-IP Camera with two-way audio functions.

« GV-ASManager must be connected to GV-CS1320 or GV-IP Camera directly. Audio is not
supported when GV-ASManager is connected to the camera through other hosts, such as

GV-DVR/NVR/VMS.
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GV-CS1320 Functions

B cv-asNotify

The snapshots and event messages will appear on the right of the GV-ASNotify window
when the bell button on GV-CS1320 is activated.

Use the Speaker and Mic buttons to communicate with visitors, or use the Unlock button

to grant access.

After handling the event, mark the notification as “Processed” by selecting the event and

then clicking the Processed button. Events marked as Processed are grayed out.

. 14 Asmotify

=) @

Add Host  Options

@
]

pr;_-a_ker

= [z

=158 TEST198-PC
S-[] Contraller
% Controller 1

Doorl

E Controller 1

El [oorl
El [oor2
@ Doar 3
@ Doar 4
B Doors
B Coors
E| Door 7
".[] Doors

[E [! Camera

L Controller 1, Camera 1

[

Proc-essed Uﬁ-lock

== =

Bell Button Active
Doorl, Caontrollerl
13172015 2:30: 19 PR

Bell Button Active

Figure 16-4

To trigger computer alarms or popup messages for alert when GV-ASNotify is minimized

in the Windows taskbar, click Options to enable the related settings.

&+ Options

[} At Popup Window

] Inwoke Alamm

Buzzer

Duration in seconds

et

oK

Figure 16-5
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Chapter 17 Database Settings

Before you can run GV-ASManager, it is required to create a database or to upgrade your old
database to fit the latest version of GV-ASManager. You can select either a Microsoft Office
Access or Microsoft SQL Server to be the database of GV-ASManager.

If a database already exits, you can use Source Database function to convert various
database formats into GV-ASManager’'s Microsoft Access or SQL Server formats.

Note: GV-ASManager has a size limit of 2 GB for its database. To get additional data
allowance, you can install and create the Microsoft SQL Server.

17.1 Starting the Database Tools

To start the Database Tools, run ASDBManager.exe from the program folder to access it.

[#p Database Tools W%

Please Select Database Tools :
Which tool do you use for database? @1
ASManager Database and Path Setting -
Setup, upgrade, deletion, backup, recoveny and file path.

Settings from Source to ASManager Database :

Set the connection of Source Database, the mapping relations of the tables
betweem Source and ASManager database, the auto-update request, and the
manual update request.

Redogin Exit

Figure 17-1
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17.2 Creating a Database

Database Settings

You can select either Microsoft Office Access or Microsoft SQL Server as the database of

GV-ASManager.

1. On the Database Tools dialog box (Figure 17-1), click ASManager Database and Path
Setting > Setup MDB / MSSQL Database for ASManager. This dialog box appears.

Setup Database Connection

Database Type

() Microsoft Office Access Database

(@) Microsoft SOL Server

Install New SQL Server Express [

Database Options

[JKeep Days

S0L Database Setting

Data Source:
Authentication

() Windows Authentication

(@ S0L Server Authentication
Login

Password

[“Expand Data Size

dayls)

Test connection

X

Database

ASConfig Name |ASConfig

ASLog Name .ASLog

ASLPR Name |ASLPR

ASPatrol Name ASParrol

TestDatabase
oK Cancel
Figure 17-2

2. To use Access as the database, select Microsoft Office Access Database > OK. The

database is created in the local computer.

3. To use the SQL Server as the database, select Microsoft SQL Server.

a. Under SQL Database Setting, type IP address or domain name of the SQL Server

in the Data Source field, and select its authentication way.
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d.

e.

Optionally select Expand Data Size to increase the maximum number of log files
stored on the SQL Server.

Under Database, name the databases for Configuration, Log, LPR and Patrol files
that will be created on the SQL Server separately.

Click Test Connection to test the connection to the SQL Server.

Click OK. The databases are created in the SQL Server.

4. Define Keep Days for how long to keep log data. The log data passed the Keep Days will

be deleted from the database.

Note: To install Microsoft SQL Server for the first time, select Install New SQL Server

Express. To use this function, connect your server to the Internet.

17.3 Other Database Settings

You can upgrade, delete, back up, restore, and compact the database of GV-ASManager.

Select ASManager Database Setting on the Database Tools dialog box (Figure 17-1) to

have the following functions.

Icon

Function

[Upgrade to the latest database version] Upgrade the database to the latest
version.

[Delete ASManager Database] Remove the database from the local computer
or the Microsoft SQL Server.

gli [Backup Database] Specify the backup storage path and select the types of

"9 ]|]I|]3| files you want to back up: Configurations, Logs, Photos and Account Profiles.
You can also set up a Schedule to automatically back up the database.

s ] [Recovery Database] Restore the files you backed up previously to the current

computer or import them to another computer.

[Compact Database] Compact and reduce the size of the database. You can
also set up a Schedule to automatically compact the database.
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[File Path Setting]

B Daily Auto Backup: Specify a path to automatically save another copy of

log and image data. The function is performed at 24:00 A.M every day. The
default path is at C:\Access ControNASManager\ASBackup

B Export to File: For third-party integration. Access data is exported to a
specified storage path. Every access record will create a file and up to 5000
files can be exported.

B Photo: The path to save user profile photos. The default path is at
C:\Access Control\ASManager\Photo

B Folder Path: The path to save images captured by the cameras. When
Recycle is enabled, the oldest images will be deleted when the free hard
disk space falls below a specified Threshold. If recycling is enabled, avoid
using the same folder path for images captured and for Daily Auto
Backup.

B System Other Settings: For third-party integration. The path to store the
files for syncing with third-party database.

B Base Path Setting: Replace all the root paths of Daily Auto Backup, Export
to file, Photo, Folder Path to a specified one.

Note: The log data backed up by Daily Auto Backup will not be affected by the Keep Days
function (Figure 17-2).
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17.4 Mapping Source Database

The Source Database function can convert OLE DB, Active Directory database and excel
files into GV-ASManager (Microsoft Access or SQL Server) database. Click the Setting from
Source to ASManager Database button on the Database Tools dialog box (Figure 17-1).
This dialog box appears.

[y
"J_d Cptions
[ Setting Set Connection :
L
Input/Modify the infarmation for source database connection.
lpdate

Set Mapping :
Set the mapping relations for user data.

Set Mapping :
Set the mapping relations for cards.

; {Unset’)

i"‘ = Set Mapping ;
' B -!.i Map the comesponding fields for vehicle data.
= G

{Unget )

: Set Mapping :
Map the vehicle hotlist fields between the GY-ASManager
database and the source database.
{ Unset )

Input/Modify the Auto-update time setting.

[7] Stop when emors occur during execution,

Source Database: MSDASQ_LE.

Figure 17-3
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Under the Setting Menu:
[Set Connection] Configures the connection to an active directory or an OLEDB provider.

[Set Mapping] Maps the user, cards, vehicle or hotlist fields between the GV-ASManager
database and the source database.

[Input/Modify the auto-update time setting] Specify a time to update the database
automatically.

Under the Update Menu:

[Update User Data manually] Update the user data manually.
[Update Card Data manually] Update the card data manually.
[Update Vehicle Data Manually] Update the vehicle data manually.
[Update Vehicle Hotlist Manually] Update the vehicle hotlist manually.
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17.4.1 Converting Data from the Active Directory Database

If you are using the latest version of GV-ASManager, see this_technical notice for instructions

on how to sync data from Windows Active Directory.

1. Click the Set Connection button on the Options dialog box (Figure 17-3). The Source
Database dialog box appears.

2. Select Active Directory. This dialog box appears.

stet up a connection to active directory 5]
[ Server
Server name: IW 9z.168.220.128 Port: 383
~Account Bind type
User Hame: Admiristrator (" Bind as cunently logged on user
Password: ~ |esssssss % Bind with credentials
1~ Distinguished name [DM] or naming context:
Connect to the following node:
& Delault Hoot Node
" This Node
Test Connection
Figure 17-4

3. Ifyou log in the local computer with the authorized username and password from the
source database server, select Bind as currently logged on user and type the IP
address or domain name of the server. If not, select Bind with credentials, type the IP
address or domain name of the server and its login username and password.

4. Ensure the Port number matches that of the source database server.

5. Select Default Root Node to connect to the root node of the source database.
Otherwise, select This Node and specify the node path.

6. Click Test Connection to connect to the source database server.

7. Click the Update Cardholder Data manually button in the Options dialog box (Figure
17-3) to convert the cardholder data from the source database to the GV-ASManager

database immediately.

8. Click the Update Card Data manually button in the Options dialog box (Figure 17-3) to
convert the card data from the source database to the GV-ASManager database
immediately.

9. To update the database automatically later, click the Input/Modify the Auto-update
time setting button in the Options dialog box (Figure 17-3) and specify the time in

minutes.
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Database Settings

17.4.2 Converting Data from the OLE Database

To convert data from the OLE database, you need to go through these instructions:
e  Step 1: Connect an OLE Database

e  Step 2: Map the User Data

e  Step 3: Map the Card / Vehicle Data

e  Step 4: Convert the Data from the Source Database

Step1: Connect an OLE Database:

1. Click the Set Connection button on the Options dialog box (Figure 17-3). The Source
Database dialog box appears.

2. Select Other Database. This dialog box appears.
Y

Provider | Connection | Advanced | &1 |

Select the data you want to connect to:

OLE DB Froviders)

ticrozoft Jet 4.0 OLE DE Provider

Micrazaft OLE DB Prowider for Indexing Service
Microzoft OLE DB Provider for ODBC Drivers
Microzoft OLE DB Provider for Oracle
Micrazott OLE DB Provider far SUL Server
Microzoft OLE DB Simple Provider

5D ataShape

(OLE DB Provider for Microzoft Directory Services

0K | Cancel | Help |

Figure 17-5

241



Q GeoUision:

3. Select the OLE DB provider that you wish to connect to, and click OK. The connection
dialog box appears. The dialog box varies depending on the OLE DB provider you
choose. Here we select Microsoft OLE DB Provider for SQL Server as example.

B Data Link Properties x|

Provider Cennection |Advanced| &l I

Specify the following to connect to SOL Server data:
1. Select or enter a zerver name:

DYLANMSOLERPRESS j Refresh |

2. Enter information to log on to the server:
€ Use Windows NT Integrated security

¢ se a specific user name and password:

Usger name; Ifae

Paszward: |ou
" Blark password W Allow zaving passward

3. (% Select the database on the server:

I.&dventure‘u\-"orks j
= pAttach a database file as a database name:
IAdventureWnrks
Wsing the filename:
Ok | Cancel | Help
Figure 17-6

4. Type the IP address or domain name of the source database server, select its login
authentication method, and select a specific database on the server. Click Test
Connection to connect to the source database server.
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Step 2: Map the User Data:

Database Settings

1. Click the Set the mapping relations for user button in the Options dialog box (Figure

17-3). This window appears.

&' Mapping Setting

=10l x|

L-\:_' Add a table from your database corresponding to the card holder table. and then set the mapping relations of their
fields.
~3|
Table Mame HumanResources. [Emploves] |

HumanResources. [Employes]

i~ Mapping Relations
Field Name | Field Type | | + |_Mapping Fields I | | | -
+ Mame nvarChar <= @ ContactlD =] FirstName % MiddleMame % LastMame
%] First Name niarChar > &
. %] Last Mame niarChar z=> &
The fields of the S oo —
GV-ASManager =S machar | <=> B Click this button
% (s nvarChar «== & E| EmploveelD .
database gemer Hool = @ to map the fields b
Birthday DateTime ===
% EmployeelD nvarChar <=3 @ between tWO
Home Phane n¥archar == = 1
%] Home Fax niarChar z=> & dlﬁe rent
%] Mabile Phone niarChar =3 @ databases
%] Home ZipCode niarChar «=> &
Home Address nvarChar «== &
¥ I Dekte | E=1 Home F-mai rvarChar == [ =

Select a+
source table

 Immediate Yiew

field of the source database.

Click the Add button to select a related table on the source database.

the B8 button in the Name field. This dialog box appears.

Set the mapping fields ﬂ
@ 3 Destination Fisld INamel
“ Select the source fields for mapping.
r~ Fields M apping Fields

Field Name | Field Type B Field Name | Field Type I

=] EmployeelD Integer § ContactD Integer

:__—TJ Mational DMumber W arwChar

= LoginD YaraChar

‘_t—TJ tanagerD Integer Add - |

=] Title WarwChar Cancel |

=] BirthD ate DETimeStamp

:=_;_| b aritalStatus ‘wChar ¢ Delete |

:__—TJ Gender WChar UP |

:=_;_| HireD ate DEBETimeStamp

(5] alariedFlag Boolean - DOWN |

=] YacationHours Smalllnt

=] SickLeaveHours Smalllnt Syt el

=| CurrentFlag Boolean it

Figure 17-8

—|1 i] =[0~100) T Auto Calumn *idth
Mame | FirstNamel LastNamel Send SMSl SMSl 1D | Gender | Bithday | EmployeelD | Home Phone | Home Fax | Mobile Phone | Home ZipCode | Home Ad =
Zhengw Mu 25
TeniLee,Dulfy 12
Jogsef H Goldberg 11
Gail & Erickson 3 N i "
Kendal C Kol 2 This section displays
D avid M Eradley E 3
Thisnny B, Her: 5 the mapping results:.
Garrett,RY oung 32
Jian Shuowfang 33 -
4| | 3
Clear | Save | Cancel I
Figure 17-7

Click the & buttons to map each field of GV-ASManager database to a corresponding

In the following steps, we demonstrate how to map the Name filed as example. Click
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In the left pane of the mapping field dialog box, select the field(s) of the source database
corresponding to the Name field of the GV-ASManager database. Then click Add. In this
example (Figure 17-8), the Contact ID field of the source database corresponds to the
Name filed of the GV-ASManager database.

If the field of the source database, without having the data entered, is linked to an index
or another table, click the Set Foreign Key button. This dialog box appears.

Setting of foreign key x|
Irformation
Foreign Key Table: Prinan Kay Tahie:
|Hun|cr|F| esaurces. [Emplopee] I Person [Conlacl] j
Foreign Fey Fieid = Prinany K.ay Field:
[EeniaziD [ComaciD =l
&0 Prnary Key Fields——————————————— —Mepping Fields
Field Hama I Fiald Tyoe - Fizld Mama | Fisld Typa |
CantactlD Intzger = FirstHame VarwThar
E MamzStyle Eoalzan 3 MiddleMamz VarwThar
B it Ya'wTha A | =] LastHame WarwCThar
B sulis Ya'wTha f—
) Emaiaddiess YawTha
E| EmaiFromation Inteqer
[=1 Frone Va/Char Bl | up
[E] PazswordHash WarLhar — W
[E] Pazswords alt WarLhar —_—
E AdditenalCortacinfe  LongtatsCha o
:T T St Foisgn Key
Figure 17-9

When the foreign key dialog box is open, the linked Primary Key Table and Primary

Key Field should be displayed if the connection of the Foreign Key Table and Primary
Key Table has been created. Otherwise, use the drop-down lists to select the Primary
Key Table and Field.

In the left pane of the foreign key dialog box, select the field(s) of the Primary Key Table
corresponding to the field of the Foreign Key Table. In this example (Figure 17-9), the
Contact ID field of “Human Resource (Employee)” Foreign Key Table is linked to the
First Name, Middle Name and Last Name fields of “Person (Contact)” Primary Key
Table.

Click OK. In the Mapping Setting window, you can see the mapping results. In the
example (Figure 17-9), the Name field of the GV-ASManager database is mapped to the
Contact ID field of the source database which includes First Name, Middle Name and

Last Name (which are linked from the Primary Key Table).



Database Settings

Note: To map the Photo field,

1.

2.

Click the B button and select the corresponding Source Field.
Photo Path (3w
Source Field
| [Phiata] - Abzolute Path @ Relative Path
Phota Path
C:AFAE =
| ] | | Canhcel |
Figure 17-10
Select Absolute Path if the source field contains complete storage paths of the photos.
A B C D E F G H | |
1 |Cardholde Mame Firstharme LastName SendShMS SMEMess 1D Gender  Birthday Photo
2
3 1 Abel Carte Abel Carter FALSE TRUE  1983/11/200 ChFAaB\abeljpg
4 2 Edhwin'Wa Edwin Wang FALSE TRUE 1980/12/1) CA\FAE \edwin.jpg
5 4 Jesse Bol Jesse Bolton FALSE TRUE 1979118 CAFAE esse.jpg
G 5 Jackie Lan Jackie Lawson FALSE TRUE 1975/6/300 CAFAE jackie jpg
Figure 17-11
Select Relative Path and appoint a folder if all photos are stored under the same folder
and the source field only contains the relative path under the appointed folder.
A, B C ] E F G H | J
1 |Cardholde Name Firsttame LastName SendsSh= SkE3kess 1D Gender  Birthday Fhota
2
3 1 Abel Carte Abel Canter FALSE TRUE = 198311/200akeljpy
4 & Echwin WWa Edwin Wiang FALSE TRLE 1980121 Jedwin.jpg
5 4 Jezze Bal Jesze Balton FALSE TELUE 1979/116)jessejpg
h 5 Jackie Lay Jackie Lawsan FALSE TEUE 1975/6/300jackie jpg

Figure 17-12
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Step 3: Map the Card / Vehicle Data:

1.

2.
3.

Click the Set the mapping relations for cards / vehicles button in the Options dialog
box (Figure 17-3). This window appears.

% 5et the mapping relations for cardss - =i X
Using field mapping to establish relation between fields from the Card and Source. EE
Select a source table
- » Select a
Field Name Feld Type <>  Ficld Name Field Type source table
E Cardholder Integer L
E Card Mumber n%arChar g
E Code Type Integer -2 -
E Activation Date DateTime Gz
E Deactivation Date DateTime -z
E Deactivate (Yes/MNo) Boal fo
E Fin Code narChar Gz
E Access Groups narChar <=3
E Card Status (0: Nomal, 1: Disable) Integer =
\
The fields of the GV- The fields of the
ASManager database source database

Figure 17-13
Select a related table on the source database.

Click the Field Name column on the right pane to map each field of the GV-ASManager
database and the source database.

Step 4: Convert the Data from the Source Database:

1.

246

Click the Update Cardholder Data manually button in the Options dialog box (Figure
17-3) to convert the cardholder data from the source database to the GV-ASManager

database immediately.

Click the Update Card Data manually button in the Options dialog box (Figure 17-3) to
convert the card data from the source database to the GV-ASManager database

immediately.

To update the database automatically later, click the Input/Modify the Auto-update
time setting button in the Options dialog box (Figure 17-3) and specify the update time.



Database Settings

17.4.3 Converting Data from an Excel File

To convert data from an excel file, follow the steps below:

1. Click the Set Connection button on the Options dialog box (Figure 17-3). The Source
Database dialog box appears.
2. Select Other Database, select Excel File, and click OK.

Source Database L&J

 l—

Pleaze =elect the source database. @1@
Hr—

Source Database

71 Active Directony

@ Other Database | Excel File -

[ ok | [ Cancel ||

Figure 17-14

3. Locate the storage path of the excel file.
Follow the instructions in Step 2: Map the User Data and Step 3: Map the Card / Vehicle
Data and in the previous section to match the columns of the excel files with the fields in
GV-ASManager.
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Chapter 18 Firmware Upgrade

For more information on how to upgrade your GV-AS Controllers, click here.
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m Troubleshooting

Chapter 19 Troubleshooting

Q1: GV-ASManager cannot connect to GV-AS / GV-EV Controller over the
Internet.

There are several causes for this problem such as IP address conflict, incorrect connection
settings and network failure. The following solution is to assign a fixed IP to GV-ASManager
and GV-AS / GV-EV Controller respectively. This way can determine if the problem is caused
by the faulty devices or incorrect network settings.

1. Disconnect the hub or switch, which connects GV-ASManager and GV-AS / GV-EV
Controller, from the network.

2. Onthe GV-ASManager system, specify a fixed IP address that is NOT used by another
device, e.g. 192.168.0.154.

Internet Protocol (TCF/IP) Properties

General

“YYou can get [P setings sssigned autornatically it youn network supports
this capability. Othenwse, pou reed to ask your nebwork. administrateor for
the approprizte [P setings,

() Obtzin an IP addess autcemaically

[132 183 0 154 |

Subriet mazk: | 255 2852486, 0

Default gateway

(3 Uz the folowing DNS server addresses:
FEreferred DMS sarver:

gltenge DNS server

Figure 19-1
3. Reset GV-AS / GV-EV Controller to factory defaults.
a. Plug GV-ASKeypad to GV-AS / GV-EV Controller.
b. Remove the jumper cap from the 2-pin Default jumper.
c. Press the Reset button.
d. Replace the jumper cap back to the 2-pin Default jumper.

e. To reset the Ethernet Module, press and hold the Default EN button for 6 seconds.
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4. Open the browser and enter the default IP of GV-AS / GV-EV Controller:
http://192.168.0.100

Network Configuration

Q GeoUision:

Machine Name

Basic Setting Machine Name Centroller 1
¢ MNetwork Setting DHCP Client:
*  QOther Setting
+ Firmware Update ) Enable

+ Account Setting
Advance Setting @ Disable

+  Function Setting

IP Address: 192 ) 188 || 0 || 100
* Parameter Setting
. . Subnet Mask: 55| 288 >2 | 0
+ Time Setting
+ Input Setting Default Gateway: 192 | 1es [0 | 1
+  Dutput Setting Domain Name Server: 192 ) %5 1 . 1

Figure 19-2

5. Inthe IP address field, specify an IP address that is NOT used by another device, e.g.
192.168.0.XXX.

6. On the GV-ASManager system, enter the following settings:
Controller ID: 1
Network: TCP/IP
IP: 192.168.0.XXX
Port: 4000
User: admin / user-defined ID
Password: admin / user-defined password

Crypto key: 12345678

Controller Setup E|
General SELE | ok 1| Gat= 2| Gete 3| oo d
General
Cantraller Marme : Controlisr_T aipai
Caontroller |0
Irtztock : [CDoore - Doorg
]oor: - DooiD
@ o GMT - w08 hd o -
+X-N QU =8 § g [7]Enabile Daylight Saving Satug
Dewvice Gmup Defaut Diala Group: Data Groun 4 v
Defaut Device 1] Model
Mew Device Grup_1 = {7 Controller Connactian
Bl Controller 1 [ ||
ball i sime ) Netwark: ToRAR ,,l
Pleace Enter ID x —
IP: 132.162.0.100
Name: Llzer:
=1
PasEwInd ©
Med: GV-AS21x -
o Cancel Crypto Hey :

Figure 19-3
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7. The connection between GV-ASManager and the controller should be established, and

the connection icon <= should appear. If disconnection happens after you connect the
hub or switch to the network, then it should be other network problems. Please contact

your network administrator.

Q2: The connection established between GV-ASManager and GV-AS / GV-EV
Controller is interrupted.

This may be due to IP address conflict. Follow these steps to troubleshoot the problem:

1. Disconnect the hub or switch, which connects to GV-ASManager and GV-AS / GV-EV
Controller, from the network.

2. Run Windows Command Prompt. Take Classic Windows Start Menu for example, click
Start, select Accessories and click Command Prompt.

3. Type arp —d and press Enter.

oo IC:AWINDOWS\system32\cmd.exe

Microsoft Windows XP [Version 5.1.266801
{C>» Copyright 1985-2801 Microsoft Corp.

C:~Documents and Settings“joycelarp —d_

Figure 19-4

4. Specify a fixed IP address that is NOT used by another device, to the GV-ASManager
system. See Figure 17-1.

5. Open the browser and enter the assigned IP address of the controller. The Network
Configuration page appears. See Figure 19-2.

6. Inthe IP address field, give the controller an IP address that is NOT used by another
device, e.g. 192.168.0.XXX.

7. On the GV-ASManager system, enter the following settings. See Figure 19-3.
Controller ID: 1
Network: TCP/IP
IP: 192.168.0.XXX
Port: 4000

User: admin
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Password: admin
Crypto key: 12345678
8. The connection between GV-ASManager and GV-AS / GV-EV Controller should be

established, and the connection icon <~ should appear. If disconnection happens after
you connect the hub or switch to the network, then it should be other network problems.

Please contact your network administrator.

Q3: GV-ASManager cannot receive card messages but the reader accepts
cards when the connection between GV-ASManager and GV-AS / GV-EV
Controller is well established.

It may be due to memory failure in the controller. Reset both the controller module and the
Ethernet module to factory default settings. Refer to Step 3 in Question 1.

Q4: GV-ASManager cannot retrieve the video from GV-DVR for playback.

1. Make sure the Remote ViewLog Service on Control Center Server is enabled on
GV-DVR.

2. Make sure the time on GV-ASManager and GV-DVR is consistent.

3. Make sure the event file you want to play back has been created completely on GV-DVR.
For example, the assigned time length of every recorded event on GV-DVR is 5 minutes.
The desired event of 5 minutes must have been displayed on the ViewLog Event List, so
you can access the event file for playback.

Q5: After | add a card by presenting to the reader, the message “Access Denied
Invalid Card” still appears

(For details on adding a card, see Step 1 in 4.3.1 Adding a Single Card.)

It may be the card format is not compatible with the controller. For GV-AS100, GV-AS110 and
GV-AS120, ensure the format is 26~64 bits. Otherwise, send us the related information of
your card format so that we can customize the format for you.
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Q6: GV-ASManager cannot receive card messages from GV-Reader connected
to GV-AS / GV-EV Controller through RS-485 interface.

1. Make sure GV-Reader is correctly wiring to the controller and Switch 4 on GV-Reader is
set to OFF.

2. Make sure the correct GV-Reader ID is set on the controller.

Q7: | can’t change the Advanced Settings on the Web interface of GV-AS /
GV-EV Controller. The “Submit” button is missing.

To modify the Advanced Settings, make sure the Web Setting Switch on the controllers is
set to ON. For the location of the Web Setting Switch, refer to the Web Setting Switch section
of each controller or GV-ASNet / GV-ASBox.

Q8: After installing GV-ASManager, the message “d3dx9_40.dll cannot be
found” appears.

Make sure DirectX End-User Runtimes is installed and restart the computer afterwards. To
install DirectX End-User Runtimes, visit Microsoft's website.

Q9: What ports should | open to enable external network access with
GV-ASManager?

Devices Ports

Controller 4000 (data and command transmission)

4000 (data and command transmission); 10000 (video transmission)

To enable push notifications of ‘door bell activated’ events, certain
ports are required to be opened in GV-ASManager’s server:

GV-CS1320 e For GV-ASManager V5.3.0 and earlier, open Port 2195 (for iOS)
and 443 (for Android)

e For GV-ASManager V5.3.1 and later, open Port 443 (for iOS and

Android)
PC-LPR 3388, 5611, 5552
Standalone LPR 443, 10000 (video transmission)
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Q10: How can | find more help?

Visit our website at http://www.geovision.com.tw

Write to us at support@geovision.com.tw
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Appendix

A. Event Notifications

e “Alarm” events

Appendix

Type

Description

Force Open

Door <name> is forcibly open.

Duress

Duress function is triggered.
See “Duress” in 1.2 Concepts.

Tamper

Tamper Inputs are triggered.

For hardware settings, see Connecting Input Devices
in GV-AS / GV-EV Controller User’s Manual.

For software settings, see 4.2.2 Configuring Doors or
Elevator Floors.

Fire Alarm

Fire Inputs are triggered.

For hardware settings, see Connecting Input Devices
in GV-AS / EV Controller User’s Manual.

For software settings, see 4.2.2 Configuring Doors
and Elevator Floors. .

Held Open

Door <name> is held open over the specified time.
See 4.2.2 Configuring Doors and Elevator Floors.

Access Denied

The access is rejected.

e “Access” events

Type

Description

Access Granted

The access is granted because the access card is
approved.

Access Granted: Card Entry

The access is granted because the door contact
sensor is triggered and the Anti-Passback function is
also enabled.

Access Denied: Invalid Card

The access is rejected because an unknown card is
presented.

Access Denied: Card Suspended

The access is rejected because Card <Status> is
inactive.

Access Denied: Wrong PIN

The access is rejected because the PIN number
entered is wrong.

Access Denied: Card Expired

The access is rejected because <Deactivation Date>
is expired.
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Access Denied:

Invalid schedule

The access is rejected because the user access is
not on the programmed schedule.

Access Denied:

Wrong Door

The access is rejected because the user has access
to the wrong door.

Access Denied
Entry)

: APB (Double

The access is rejected because the Anti-Passback
rule is violated. Card <Number> is recorded twice.

Access Denied:

APB (No Entry)

The access is rejected because the Anti-Passback
rule is violated. Card <Number> is recorded as exit,
without entry, to a secure area.

Access Denied:

APB (No Exit)

The access is rejected because the Anti-Passback
rule is violated. Card <Number> is recorded as entry,
without exit, to a secure area.

Access Denied:

Unknown Card

The access is rejected because the card format is not
compatible.

Access Denied:

Invalid Start Date

The access is rejected because Card <Number> is
not enabled.

Access Denied: Previous Door Still

Open (Interlock)

The access is rejected because the Interlock function
is violated. The entry door is left unlocked/open.

See “Interlock” at Step 5in 4.2.1 Step 1: Configuring
a Controller.

“Event” events

Type

Description

Force Open

Door <name> is forcibly open.

Duress

Duress function is triggered.
See “Duress” in 1.2 Concepts.

Tamper

Tamper Inputs are triggered.

For hardware settings, see Connecting Input Devices
in GV-AS / GV-EV Controller User’s Manual.

For software settings, see 4.2.2 Configuring Doors or
Elevator Floors.

Fire Alarm

Fire Inputs are triggered.

For hardware settings, see Connecting Input Devices
in GV-AS / GV-EV Controller User’s Manual.

For software settings, see 4.2.2 Configuring Doors or
Elevator Floors.

Held Open

Door <name> is held open over the specified time.
See 4.2.2 Configuring Doors or Elevator Floors.

Access Denied

The access is rejected.
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Alarm Restored

Alarm sounds are cleared.

Forced Open-Restored

Force Open alarm is cleared.

Duress Restored

Duress alarm is cleared.

Tamper Restored

Tamper alarm is cleared.

Fire Alarm Restored

Fire alarm is cleared.

Held Open Restored

Held Open alarm is cleared.

Restored Alarm Failed

Fail to clear alarm sounds.

Clear Forced Open Event Failed

Fail to clear Force Open alarm.

Clear Duress Event Failed

Fail to clear Duress alarm.

Clear Tamper Event Failed-No
Event Present

Fail to clear Tamper alarm.

Clear Fire Alarm Event Failed-No
Event Present

Fail to clear Fire alarm.

Clear Held Open Event Failed

Fail to clear Held Open alarm.

Clear Access Denied Failed

Fail to clear Access Denied alarm.

Clear Tamper Event Failed-1/O
Still Unclear

Fail to clear Tamper alarm because Tamper Inputs
remain triggering.

Clear Fire Event Failed-1/O Still
Unclear

Fail to clear Fire alarm because Fire Inputs remain
triggering.

Door Open Door <name> is open.
Door Close Door <name> is close.
Door Unlock Door <name> is unlocked.
Door Lock Door <name> is locked.

Two Person Rule-Active

Two-person A/B rule is active when Card <number>
is presented.

Two Person Rule-Confirm

Two-person A/B rule is confirmed when Card
<name> is presented after the other AB card.

Two Person Rule-Inactive

Two-person A/B rule is violated when Card <name>
is presented successively or the other AB Card isn’t
presented within 20 seconds.

Keypad Code Confirm

On the Card or Common mode, the password
entered is correct.

Wrong Keypad Code

On the Card or Common mode, the password
entered is wrong.

Door Bell Activated

The doorbell of Door <name> is activated.

Release Mode

Door <name> is on the Release Mode.
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See 4.2.2 Step 2: Configuring the Doors or Elevator
Floors.

Card or Common Mode

Door <name> is on the Card or Common Mode.

See 4.2.2 Step 2: Configuring the Doors or Elevator
Floors.

Card and PIN Code Mode

Door <name> is on the Card and PIN Code mode.

See 4.2.2 Step 2: Configuring the Doors or Elevator
Floors.

Card Mode

Door <name> is on the Card mode.

See 4.2.2 Step 2: Configuring the Doors or Elevator
Floors.

Fire Unlock Mode

Door <name> is unlocked after Fire Inputs are
triggered.

See “Fire Action” in 4.2.2 Step 2: Configuring the
Doors or Elevator Floors.

Fire Lock Mode

Door <name> is locked after Fire Inputs are
triggered.

See “Fire Action” in 4.2.2 Step 2: Configuring the
Doors or Elevator Floors.

Force Unlock Remotely

Door <name> is unlocked remotely from the control
of GV-ASManager or GV-ASRemote server.

Force Lock Remotely

Door <name> is locked remotely from the control of
GV-ASManager or GV-ASRemote server.

Disable Remote Door Lock
Operation

The event of “Force Unlock Remotely” or “Force Lock
Remotely” is cleared.

Force Unlock Locally

Door <name> is unlocked on the site of Door
Controller.

Force Lock Locally

Door <name> is locked on the site of Door Controller.

Disable Local Door Lock
Operation

The event of “Force Unlock Locally” or “Force Lock
Locally” is cleared.

Reset

Door Controller <name> is reset.
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¢ “LPR” events

Type Description

Plate Recognized: Registered Access for a registered vehicle granted according to
Vehicle the Authentication Schedule

Plate Recognized: Registered Access for a registered vehicle denied according to
Vehicle (Invalid Schedule) the Authentication Schedule

Plate Recognized: Registered Access denied for a registered vehicle due to
Vehicle (Vehicle plate and card unmatched access card, during LPR and Card Mode
number do not match)

Plate Recognized: Unregistered Access granted for a visitor vehicle

Vehicle

Plate Recognized: Unregistered Access denied for a visitor vehicle as according to the
Vehicle (Invalid Schedule) Authentication Schedule

Parking Access Granted: Vehicle | Access of a vehicle to parking lot granted by
Added Manually manually typing its license plate

Parking Access Granted: Vehicle | Access of a vehicle to parking lot granted and gate
Added Manually and Gate Opened | opened by manually typing its license plate

Parking Access Granted: Vehicle | Access of a vehicle to parking lot granted and its

Removed Manually license plate is removed manually

Parking Access Granted: Vehicle | Access of a vehicle to parking lot granted, gate
Removed Manually and Gate opened and its license plate is removed manually
Opened

Parking Access Denied: Gate Access to parking lot denied and gate does not open
Disabled

Access to parking lot denied due to reaching its

Parking Access Denied: Full maximum vehicle capacity

Access to parking lot denied due to the vehicle has

Parking Access Denied: Re-entry | /504y entered with no exit record

Parking Access Denied: No entry | Access to parking lot denied due to the vehicle has

record no enter record
Parking Access Denied: Share Access to parking lot denied due to reaching its
Space Full maximum public parking capacity
Access to parking lot denied due to disconnecting
Parking Request Failed between PC LPR (with GV-LPR Plugin) and
GV-ASManager
Access denied due to failed authentication of either
Authentication Not Completed the license plate or access card under LPR and card
mode
Plate Not Recognized Access denied for unrecognizable license plate
SD Card Write Failed SD card of GV-LPR1200 failed to write data

SD card of GV-LPR1200 reached its maximum

SD Card Full storage capacity
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B. E-Mail and SMS Alert Symbols

Icon Description
8 %M (Message): include related alert message.
. %m (Device Group): include the name of triggered

- device group.

Al %T (Controller): include the name of triggered
controller.

I %D (Door): include the name of triggered door.

(0] %L (Local Time): include local time.

D %U (UTC): include UTC time.

B %S (Snapshot): include snapshot.

+ %Q (Direction): include the direction of triggered LPR
lane.

e %N (Card Number): include card number.

m %H (User Name): include user name.

20 %G (Gender): include user’s gender.

m %E (Employee ID): include employee ID.

= %Y (Company): include company name.

& %K (Division): include division name.

= %P (Department): include department name.

o %F (Office): include office name.

%C (Photo): include user’s photo.
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Status

Description

Disconnected (Login Failed)

The username, password or crypto key (3DES)

entered is wrong.

Disconnected (Duplicate Connection)

Another GV-ASManager is connecting with the

controller.

Disconnected (Hardware Error)

The Controller ID entered is wrong. Or controller

errors occur.

D. Supported ML Engines of PC LPR

The latest GV-DVR LPR / GV-VMS LPR only supports the following versions of Machine
Learning (ML) recognition engines:

No. | Country Engine Version | No. | Country Engine Version
1 Argentina 6.0.2.0 20 Israel 3.1.2.2
2 Australia 4211 21 Italy 6.0.2.1
3 Austria 6.0.2.0 22 Mexico 4556
4 Belgium 6.0.2.0 23 Morocco 6.0.2.7
5 Brazil 6.0.2.0 23 Netherlands 6.0.2.0
6 Bulgaria 6.0.2.0 24 New Zealand 6.0.2.0
7 Canada 6.0.2.0 25 Norway 6.0.2.0
8 Chile 3.2.0.9 26 Poland 6.0.2.0
9 China 4213 27 Portugal 6.0.2.6
10 Columbia 4215 28 Qatar 3.1.2.2
11 Croatia 6.0.2.0 29 Russia 6.0.2.0
12 Czech 6.0.2.0 30 Slovakia 6.0.2.0
13 France 6.0.2.0 31 South Africa 6.0.0.9
14 Germany 6.0.2.4 32 Spain 6.0.2.0
15 Global 6.0.2.0 33 Taiwan 4559
16 Hong Kong 6.0.1.2 34 UK 6.0.2.0
17 Hungary 6.0.2.0 35 USA 4214
18 India 4211 36 Vietnam 4211
19 Ireland 6.0.2.0
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Q GeoUision:

E. Supported Number of Connections

The following is the maximum number of applications and devices that a GV-ASManager
system can establish connections with.

Application / Device Number of Connections to a GV-ASManager
GV-ASRemote Unlimited

GV-ASNotify Unlimited

GV-ASWeb 128 connections

GV-Access app 128 apps

GV-1/0 Box 16 sets of GV-1/O Boxes
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